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Implemented Stacked View in TXLF Editor with source segment directly above target segment in a
spanned row

Improved active segment: no background color, highlighted outline color based on segment status
Implemented option to place cursor at start or end of segment for Next Segment action

Improved Bilingual Export in Quick Tools, allows export of TXLF files into Wordfast Classic format files and
import of translation back to TXLF with Bilingual Import

Improved performance for typing speed and segment-to-segment transitions inside segments

Improved split or merge of segments with new status icons: split, merge, and merged across paragraph
segments

Implemented copy source options in Preferences to copy tags and terms when segment has no TM match
for file leverage and analysis

Added Cleanup Passcode for TM server TMs to provide administrator access

Added new Unedited MT segments and All Except Duplicate segments table filter options

Added option for DOCX or DOC file format during Bilingual Export

Fixed issue with term highlight for certain segments with tags

Fixed issue with tag removal from source during edit

Fixed issue with missing terminology highlight on words next to paragraph tag

Fixed issue where editor displays blank space

Fixed issue with Undo adding space after an accented letter

Fixed issue where Undo or Redo action does not mark segment as modified

Fixed issue where term selection is lost with Next Term shortcut

Fixed issue where merge does not work on previously split segment

Fixed issue with translation disappearing from segments when applying formatting

Fixed issue when source segment edit leaves blank segment in source

Fixed issue when term highlight remains after using Cut shortcut to remove a term

Fixed issue with speed performance while opening Live Preview

Fixed issue where font size increases in Live Preview when empty segment gets leveraged
Fixed issue with index out-of-bounds error during Save File As Translation action

Fixed issue with remembering last used location for Save File As Translated action

Fixed issue with generating report after running Analysis

Fixed issue when VSD filter unable to open files for translation

Fixed issue with rendering active segments in TXLF Editor while scrolling

Fixed issue with SDLXLIFF filter showing empty target segments instead of translated content

Fixed issue where surface devices not scaling properly



Fixed issue with language-specific font, specified in Preferences, not used in target column
Fixed issue with Adaptive Transcheck report ignoring options for specific terms
Fixed issue with Autosuggestion handling accented characters present at the end of a word

TXLF Editor columns hidden when windows display settings are set to 125%

Enabling Show Whitespace Characters makes the cursor jump to different location when deleting tags



1. About this Guide

Conventions

CONVENTIONS
Typographical

The following table explains the typographical conventions used in this guide.

Bold User interface controls, commands, and keywords in body text.
italic Represents an input field where user input is expected.

<...> Generic parameters that must be replaced by specific code or text.
[...] Generic parameters that are replaced by dynamic text.
CONVENTIONS

lcons

The following table explains the icon conventions used in this guide.

Note:
@ This icon designates a note or helpful suggestion or reference relating to the surrounding text.
Best Practice:
v This icon designates a suggestion for best practice relating to the surrounding text.
Alert:
A This icon designates a warning or alert relating to the surrounding text. In this situation, the user

should exercise caution to avoid an undesirable result.



Wordfast Pro is the latest standalone, multi-platform TM tool designed to address the needs of translators,
language service providers, and multi-national companies. It offers a complete translation environment that stores
your translated content for reuse on future projects, thereby maximizing efficiency, increasing overall consistency
and reducing translation costs.

¢ Cross-platform compatibility — Browser-based tool runs natively on Windows, Mac, and Linux

e Target-only Live Preview — After translation, provides preview to proofread a target-only version with
layout and formatting

e Segment filtering — Filters segments based on terms, regular expressions, match scores, notes, and
other attributes

¢ Configure multi-lingual translation projects — Supports translation into multiple target languages and
can send as a single package or separate packages, based on language pairs

e Export and import translation packages — Allows configuration and export of translation packages for
fast, seamless translation management

¢ Format flexibility — Supports virtually any file format, including MS Office, Adobe InDesign, FrameMaker,
PDF, HTML, XML, SDL Trados Xliff, MemoQ Xliff, and more

¢ Chain files — Allows combination of multiple files into a single file to improve the consistency of repeated
segments and facilitate file management

¢ Unlimited TM and glossary access — Accesses an unlimited number of TMs and glossaries
simultaneously and prioritizes as primary or secondary



3. Get Started

This section provides basic information to get started with Wordfast Pro, a stand-alone desktop application you

install on and access with your local computer.

System Requirements

Supported Operating Systems Microsoft Windows 7+, OSX 10.10+, and Linux 64-bit

Java JRE If not present, Wordfast Pro automatically installs Java JRE during
the application installation process

License and Registration Activation of the full Wordfast Pro installation requires a license and
registration

Minimum System Memory 2GB RAM
Minimum Screen Resolution 1366 x 768 pixels
Installation

To install Wordfast Pro:

1. Download the Wordfast Pro Windows Installer Package from http://www.wordfast.com/.

2. In your Downloads folder, double-click the .msi file to open the Wordfast Pro Setup Wizard and complete all
steps to align with your desired configuration, then click Finish.

Wordfast Pro opens in Demo mode, so still requires activation. Refer to Activation.
Activation of Wordfast Pro requires a license and online or offline registration. An unlicensed version

of Wordfast Pro working in Demo mode is limited.

e You can only create bilingual projects.
e You can only store up to 500 translation units (TUs) in a Translation Memory. To remove this
restriction, purchase a license and activate the licensed application.

Activation
You can activate Wordfast Pro with one of two methods: manually or online. Both require an activation key.

To activate Wordfast Pro:
1. Open Wordfast Pro.

2. On the Help tab, click License Management.

= Wordfast Pro ~ Project Files Project TM Project Terminology Reports Reference Files Help
Options

L < @

Feedback Wordfast Pro License About Help
Update Management Wordfast Pro


http://www.wordfast.com/

3. On the License Manager dialog, click Online Registration or Manual Registration.

4. Follow online or manual registration directions.

Option Description
Online Registration Enter the Activation Key and click OK.
Manual Registration 1. Enter the Activation Key and click Generate.

2. Copy this text into an email and send it to the
email address provided.

3. Copy the license file in the return email to the
local disk where you installed Wordfast Pro.

4. On the License Manager dialog and Manual
Registration tab, click browse and select the
license file.

5. Select the license file and click OK.

5. Restart Wordfast Pro.

The Wordfast Pro activation process is complete.

To resolve any license issues, log in to Wordfast Pro and select Support > Hotline.

You can install, reinstall, view your current license information, and view WordFast Pro updates on the Help tab.

Wordfast Pro automatically monitors for updates. If an update is available, you receive notification
right after you open the application.

License Management View the current license and keep track of the days remaining to license expiration.

WordFast Pro Update Use to update your application or Hunspell spelling dictionary.

After you have installed and activated Wordfast Pro on your computer, it is ready to use.
To start Wordfast Pro:

1. Double-click the Wordfast icon on the desktop or from the Start menu to open Wordfast Pro.



Wordfast Pro opens to the Projects view.

[ws] Wordfast Pro — O *
= Wordfast Pro ~ RS

Project Package Tools Options
R = 1= R R e i E b4 e = N =

Create Open Close Add Modify Remove Recalculate Import Import SDL Export Quick Preferences
Project Project Project Project Project Project Progress Package Package Package Tools

Projects Location Source Language w ||| Target Language ~ || Date Created % Complete 0 T =
Projectl C:\Users\  English German 2016/11/30 22:07:19.. ] 17%

Project2 C:\Usersy  English Spanish 2017/03/15 11:42:49.. 0%

Project3 C:\Usersy  English German 2017/03/21 15:37:59... 1%

Project4 C:\Users|  English {United States) Portuguese (Brazil) 2017/04/02 11:04:44... N/A

Projects C:\Users\  English Spanish 2017/04/06 10:08:03... N/A

Projecté C:\Users|  English German 2017/04/06 22:24:38. N/A

2. (Optional) Select another view if you have already created a project and are ready to begin translation or
review.

Explore the User Interface

Wordfast Pro allows users to coordinate and automate the translation and review process through an intuitive,
stand-alone user interface.

@ To change to a different view, select one from the Wordfast Pro drop-down menu.

EXPLORE THE USER INTERFACE

Project List View

The Project List view gives you access to a list of your projects. Double-click a project to open the Current
Projects view and access files within the project.



WFP Menu

[ Werdfast|Pro - Project List

Action Button Action Bar Project List

— O X

= woramatro - proec JR| ) P

Options
: S P m O
9 L L ] L
Fesdback Wordfast Pro License About Help
Update Management Wordfast Pro
Projecis Location Source * ||| Targel Language = || Date Created = Last Saved |3 Complete ﬁ 1 =

Adaptive.. C:\Users\Do..  English

Project 2 C:\Users\W__  English
Project 1 C:\Users\W...  English

Item

German (Germany)  2018/02/19..  2018/03/05... | (IS
French (Canada)

*
German (Germany)  2018/01/25..  2018/02/06.. [NEOOCGEN
German {Germany)  2018/01/25.. 2018/02/06.. NELSE)

Action

WFP Menu

Access user views and user preferences

Action Button

Perform a specific task

Action Bar

Access all action buttons associated with a specific tab

Project List

Access files associated with a specific project

EXPLORE THE USER INTERFACE

Current Project View

The Current Project view is for projects that contain multiple files. Double-click a file from the list of TXLF files
ready for translation to open the TXLF Editor view and access source and target segments.



WFP Menu Action Button
Menu Tab Action Bar Collapsed ltems

=R AL B Project Files ‘mm Terminology Reports ReferenceFiles Help A X

Files
BB B [ Tk
_J - ‘
(+] (+] = [ ————
Add Add Translate ~hain Open Source
Files  Folders File Files File
. WordCt Creation Date Last Saved Translation..Complete £} T =

~ W ENUS...
*

Sa.. | 188e— C:\Users\lziels.. 2017/10/20 1.. 2017/10/20... 94.59%

Sa.. | 188 C:\Users\lziels.. 2017/10/20 1... 2017/10/20... 94.59%

Sa.. | 188 C:\Users\lziels.. 2017/10/20 1... 2017/10/20... —#94.59%

Language File List Project

Pair i Fiter Progress Bar File

Progress Bar

Item Action
WFP Menu Access the Current Project or TXLF Editor views and user preferences
Menu Tab Access the various tools of the application
Action Button Perform a specific task
Action Bar Access all action buttons associated with a specific tab
Collapsed Items View all available items not visible in the currently sized window
Language Pair Access the file list associated with a specific source and target language pair
File Filter Create filter criteria for searching the file list
File List Access a specific file within the language pair
File Progress Bar Monitor the percentage of work completed on a file
Project Progress Bar Monitor the percentage of work completed on a project

You can use filter criteria and sort files using the provided search options.

Files Word Count Translation Status Complete Last Saved a1



Item Action
Files Create file filter criteria
Word Count View total file word count

Translation Status

View status of pending, active, delivered, or completed files

Complete View the file progress bar with completion percentage

Last Saved View the date for when the user most recently saved the file
Clear filter criteria

T Sort filter criteria in ascending or descending order

EXPLORE THE USER INTERFACE

The TXLF Editor view is your default translation and review workspace.

There are two configurations for the TXLF Editor view, controlled from Preferences > Layout.

¢ Table view — Default view displays the source segment to the left and the target segment to the right.

e Stacked view — Displays the source segment row directly above the target segment in a spanned row.

Right-click anywhere in the source or target segments to access the TXLF Editor Context Menu.



WFP Menu File Mame Tak  Filter Bar MenuTab  Action Bar Action Button Takle Filter Collapsed lterms

|
Wordfast |Pro - Project 2 — 0O
= WorstastBro ~ Fie ot Fomttio [N eriinioay Revew | e |
S| want
E B B B | B ‘B2 BB B B
Maxt Pravious Comn|it L e Verity Copy - Mearpa Spit Unconfem Lock/Unbock Clear
Sagment Sagmeant ® Sagmant Source Confam Sagmeant Targel
s
Source or Target v I-laﬂ'ngu Ragex | Enter text to fiter seg ~ | Filler: | Select speaal fiter(s). ~ | O _0'} )
o | English (United States) German (Germany) Score | Status |
1 | TRANSLATION MANAGEMENT. UBERSETZUNGSMANAGEMENT. - D | A
2 IMADE SIMPLE. VEREINFACHT. 100+%
. | @) STREAMLINE PROJECT 'EEFFEKTIVES | . '
MANAGEMENT PROJEKTMANAGEMENT =8
'INTEGRATE WITH ANY SYSTEM INTEGRIEREN SIE MIT JEDEM
4 MOGLICHEM SYSTEM "
EZ)pWORK WITH MULTIPLE B ZUSAMMENARBEIT MIT
> | VENDORS @ JEDEM ANBIETER @z o ®
ACCESS REAL-TIME DATA ZUGRIFF AUF LEISTUNGS-
© KENNZAHLEN IN ECHTZEIT e
'GlobalLink Project Director saves® Mit GlobalLink®Project Director sparen |
organizations millions of dollars by Organisationen| aufgrund der . . .
7 |automating management of | automatischen|Verwaltung von [l92% | A
TM Lookup Notes o Segment History M=tadata Trm:hetkw} + ® Terminjology
|VEREINFACHT v | More Options  ~ Search Glossalies (Source) - O M %
i i Scos | TMM \ENDOR
1 | EDWORKWITH | ED 100+% ENY ANBIETER N
MULTIPLE ZUSAMMENARBE
VENDORS@@Q@ |IT MET JEDEM vendor o)
ANBIETER [ ——
2 | EDWORKWITH | D | 100+%" EN | Vendor o
- Anbieter
4 b
EN-US — DE-DE | Se[yments: 23/33 | S8egment|[Src/TgtMax): 1212/ | Par/sgraph (8rergta|sg: 12112 [JJIIIIEER 1 o woras |emy

Editor Pane Source Segment Target Segment  Terminoclogy Segment Score Status Verification
Column Column Pare Column Column  Column
Item Action
WFP Menu Access different views, quick tools, and user preferences
File Name Tab View an open or chained file

Filter Bar Access all action buttons associated with a specific tab




Item Action
Menu Tab Access a specific function and its action buttons
Action Bar Access all action buttons associated with a specific tab

Action Button

Perform a task

Table Filter

Create filter criteria and or search in the open file

Collapsed Items

Access any remaining tools that do not fit in the window

Editor Pane

Access editor tab content or interact with it using menus and sub-menus

Source Segment Column

View numbered color-coded segments after source file analysis.

Target Segment Column

Use as primary work area for translation entry with or without leveraging a
translation memory (TM)

Terminology Pane

Search the source or target glossaries, or add terms to terminology
glossaries, if enabled

Segment Score Column

View the TM match score represented as a percentage

Status Column

View the status of a segment

Verification Column

Verify and commit a segment with the o

TXLF EDITOR VIEW

Use filter criteria to constrain searches of segment content.

Source or Target Match Case

Option

Regex

Filter: Sort: | Decument

Function

Source or Target

Select from drop-down menu to search source or target segments

Match Case Make your search case-sensitive
Regex Select from drop-down menu to search on regular expression or wild card
characters
Filter Select from drop-down menu to constrain search even further
Activate the filter action
Clear the cumulative filter action
Reset the toolbar filter fields
Sort Select from drop-down menu to order the remaining search list

Configure the maximum word count for the segment filter




TXLF EDITOR VIEW

You can quickly identify the status of a segment in the TXLF Editor view by its status icon.

Status Icon Segment Status

1] A non-linguistic error has occurred in the segment during a Transcheck test

] The segment is locked, so you cannot edit it

% The segment is unconfirmed, so you cannot commit it to the translation memory
5| The segment repeats more than once in the current file

® There is segment information available

O The segment has a note associated with it

]

/! The source segment has been modified

TXLF EDITOR VIEW

The TXLF Editor registers translation progress at the lower right of the window.

Segments: 2/3 | Segment | Src/Tgt/Max): 14/57/56 = Paragraph [ Src/Tgt/Max): 14/57/- 77% (4 words left)
Item Behavior
Segments Registers the number of segments completed versus the total number of

segments

Segment (Src/Tgt/Max)

Registers the number of characters in a source segment and the target segment,
followed by the maximum number of characters allowed in the target segment

Note: The Max segment value turns red when it exceeds the maximum allowed.

Paragraph (Src/Tgt/Max)

Registers the number of characters in the source paragraph and the target
paragraph, followed by the maximum number of characters allowed in the target
paragraph

Note: The Max segment value turns red when it exceeds the maximum allowed.

Word Count Progress Bar

Registers the percentage complete and the number of words remaining

Best Practice: The percentage complete will not progress if the target segment
is empty, or if you have not modified machine translated or fuzzy segments.
To progress to the next unedited or machine translation (MT) fuzzy segment,

either use the Verify Segment action on the Translation tab or use the @ inthe
Verification column. Use the Recalculate Progress action button on the File tab
to update the progress bar for files created or edited in legacy versions.

Note: For Japanese the percentage complete is in characters _naot in words




EXPLORE THE USER INTERFACE

Quick Tools View

Use the Quick Tools view to work with files outside of your projects. Typically, Project Managers use Quick
Tools actions to perform several regular functions on files before sending them on to translators, such as analysis

or cleanup.

WFP Menu Source Files Pane TMPane Action Button Action Bar

Wordfast|Pro - Quick Tools

Actions

BB B |&

Add Add Remove Analyze
Files Foldars File{s)

Source Files L)

- File Name File Type | Size

~" Sample-en-de.docx MS Word (... BIKB
~" Sampleen-de_ ... WFTXLF (.. 24KB

Item

— 1] .

L ]

anslathon Mea|nory Options

e [ ) [ [ E
e . . .
. S =0 =
Cifate Add Connect Add Remove ® Preferences
Lifical Local To Remaota Project TMs ™

®Translation Memory

~” TM Name | Project... Source Lan... Target Lang... Location
~" EMNus-... Project 2 Enaglish German (G... C\Usars\...
~"  EN_DE... Project 2 Enaglish German (G... C\Usars\...

Language Selection

Options

' Fuzzy maich threshold 75 5 | % Matches

| Create TXLF files

TXLF files location  C-\Users\Documents\Source Browse...
Copy all tags
Copy source on no malch

Report Settings
Calculate analysis report percentage by:
Words

* Segments
& Calculate internal fuzzy matches 75 5 | % Matches
Include intemal fuzzy malches as TM malches

report summan Browse

Action

WFP Menu

Access user views and user preferences

Source Files Pane

Select from the available source files list

TM Pane

Select and create TXLF files of the translation memory or configure reports

Action Button

Perform a specific task




Item Action

Action Bar Access all action buttons associated with a specific tab

EXPLORE THE USER INTERFACE

Help and Feedback

HELP AND FEEDBACK

Help

Access online help by selecting the Help action button on the Help tab. If you still have questions after reviewing
online help information, email Hotline Support at support @ r ansl ati ons. com

A Do not submit requests for changes to the software using Help.

= Worndfast Pro ~ Project Files Project TM Project Terminology Reports Reference Files Help

Opfions
7
L O p @
Feedback Wordfast Pro License About Help
Update Management Wordfast Pro

HELP AND FEEDBACK

Feedback

For software issues only, click Feedback. Be as specific as possible, providing the exact steps you took when the
issue occurred.

A Do not submit questions related to software usage to Feedback.



3. Get Started Wordfast

& \We wslcome your feedback

Mame: | |

Your E-mail:® | |

If you have questions about how to use Wordfast Pro, or need help, please review our Online Support
infarmation at wordfast comitraining_supoort.

If you need help with an externally-provided project, please contact your Project Manager first.

Please enter your feedback in the space below. If you have found a bug, please list the exact steps to
reproduce it.

Enter your feedback here

In order to help us investigate the problem, you have the option of sharing your application log and project
files. By the terms of our Mon-Disclogure Agreement, we will not disclose or use your information nor your
project information for anything other than resolving the bug.

[] Send application log files

[ ] Send praject files

oK Cancel

Copyright © Wordfast, LLC 2018. Page 22 of 204



4. Manage Projects

When Wordfast Pro opens, the default view is the Project List view. Once you create a project, you can keep a
project on the project list for as long as it takes to complete it. A project stays in the project list until you remove it.

You can add a project to the Projects List again, even after you removed it. Wordfast does not erase
removed projects, so you can still retrieve them from the project folder on your computer using the
Add Project action.

The Project List view is where you use file format filters; add files; set source and target languages; and select
translation memories (TMs), terminologies, and reference files to manage the translation process for the project.

Waordfast Pro — O X
h Wordfast Pro = JEGI LGS
Project Package Tools Options

P REREBERE R F B8 8 8 % B
Create Open Close Add Modify Remaove Recalculate Import Import SDL Export Quick Preferences
Project Project Project Project Project Project Progress Package Package Package Tools

- ~ || Date Created % Complete a1t =
Projectl C:\Users\  English German 2016/11/30 22:07:19... N 17%
Project2 C:\Users|  English Spanish 2017/03/15 11:42:49. 0%
Project3 C:\Users\  English German 2017/03/21 15:37:59.. 1%
Project4 C:\Users|  English (United States) Portuguese (Brazil) 2017/04/02 11:04:44. . N/A
Projects C:\Usersy  English Spanish 2017/04/06 10:08:03... N/A
Projects C:\Usersy  English German 2017/04/06 22:24:38... N/A

Create a Project

In Wordfast Pro, every translation begins with a project. Projects act as repositories for all related content, along
with associated translation memories (TMs) and glossaries.

A You must create a project before you begin translation.

A project also requires file format filters to convert the source content into segments prior to beginning
the translation process.

To create a project:

1. On the Projects tab, click Create Project.

= voruretro - QU oy

Project Package
- H H= — B T a SRl
PR RREREBEEREE B 8 K
Create Open Cloze Add Modify Remove Recalculate Import Import SOL Export
Project Project Project Project Project Project Progress Package Package Package

2. On the Project Creation dialog, enter a project name.

@ Required fields are marked with a red asterisk.



Project Name:” Wordfast1 Source Files Reference Files

Reuse Project: None - | 0' Add File E'} AddFolder S Create Filter

Save Project To" C\Users\izielsdorf\ Documents\WF PG 4.0 WFP\AC Browse... Name Type Path
Source Language:" English -

Target Language(s):" German (Gemany) X

Translation Memory Glossary Blacklist
=
-0
Name Priority Read O... Type Path

= =
=5 Create Add =t Import

Options

~* Run analysis report on documents
Pre-translate TXLF files

Create Project Cancel

(Optional) If you want to reuse the profile of a previously created local project, select it from the Reuse Project
drop-down list.

Project reuse removes all existing translation memories, glossaries, and blacklists from the new
project. On the Reuse Project Warning dialog, click Yes to agree to reuse the project.

Enter the Save Project To location or click Browse... to select the location for your project.

Select Source Language and Target Language(s) from the drop-down lists.

You can refine the source language and target language drop-down list results by starting to type a
language name.

In the Editor pane, click the Translation Memory tab, if it is not already active.

Transglation Memory Glossary Blacklist

= = . - O ar AU
='IE:' Create :-'ﬂ Add ::1_ Import odif S MOVE

Name Priority Read ...  Type Path



10.

11.

. (Optional) Click Create to add a new local TM for your project.

a) On the Create TM dialog, enter a unique name for the TM.
b) Select a target language to create a language pair, then select the location for the TM on your local disk.

c) Select either primary or secondary priority from the drop-down list to determine which TM you leverage first.

You can select only one TM as the primary. The primary status dictates that the content of that TM
overrides any content in secondary TMs.

d) (Optional) To prevent any edits to the TM, select Read-only.
e) Click OK.

. (Optional) To add an existing TM to your project, click Add, then select a local, remote, or a project-specific

TM from the drop-down menu.

To use a free online tool for work and production that integrates with WordFast Pro, use WordFast
Anywhere (WFA) as your remote, unlimited, and private translation memory (TM).

a) Local — Select a location on your local disk.

b) Add Remote — Enter the TM Server or WF Server or WFA Server details on the Connect to Remote TM
dialog. Refer to Connect to a Remote TM.

c) Add Project TMs — Enter the details on the Add Project TMs dialog by selecting the project.

The source language, target languages, and list of TMs auto-populate, based on the project
you select. Remove the target languages or TMs that you do not want to import, from the target
languages and list of TMs fields.

(Optional) To import an existing TM to your project, click Import.

a) On the Import Translation Memory dialog, select the import File Type: TMX or WF TXT TM format from
the File Type drop-down list.

b) Click Browse to locate and select the project file that contains the TM that you want to import.

c) Select either the Create a new TM or Import into existing TM option. Refer to Import a Local TM.

d) If the TU already exists, select an overwrite option from the drop-down list.
e) Select Clear before import if you want to ensure the import overwrites a clean TM.
f) Click OK.

(Optional) To edit an existing TM to your project, click Modify.

a) On the Modify Local Translation Memory dialog, modify the name of the TM or its priority.
b) Select whether you want to protect the TM as read-only.

(Optional) In the Editor pane, click the Glossary tab.

Translation Memory Blacklist

I:I" Create D?} Add EI-I Import

Name Read Only | Type Path



12.

13.

14.

15.

16.

(Optional) Click Create to add a new local glossary for your project.
a) On the Create Glossary dialog, enter a unique name for the glossary.
b) Select a target language from the drop-down list, then select the location for the glossary on your local disk.

c) Select either primary or secondary priority from the drop-down list to determine which glossary you
leverage first.

You can select only one TM as the primary. The primary status dictates that the content of that
glossary overrides any content in secondary glossaries.

d) If you want to prevent any edits to the glossary, select Read-only.

e) Click OK.

(Optional) To add an existing glossary to your project, click Add, then select a local, remote, or a project-
specific glossary from the drop-down list.

a) Local — Select a location on your local disk.

b) Add Remote — Enter the TMGR Server or WF Server or WFA Server details on the Connect to Remote
Glossary dialog. Refer to Connect To a Remote Glossary.

c) Add Project Glossary — Enter the details on the Add Project Glossary dialog by selecting the project.

The source language, target languages, and list of TMs auto-populate, based on the project you
select. Remove the target languages or TMs that you do not want to import from the target languages
and list of TMs fields.

(Optional) To import an existing glossary to your project, click Import.
a) On the Import Glossary dialog, select the import File Type: TBX or Tab delimited.
b) Click Browse to locate and select the project file that contains the glossaries that you want to import.

c) To configure a glossary creation option, select either the Create a new glossary or Import into existing
glossary. Refer to Import a Local Glossary.

d) Select an overwrite option for preexisting terms.
e) Select Clear before import if you want to ensure the import overwrites a clean glossary.
f) Click OK.

(Optional) In the Editor pane, click the Blacklist tab.
Translation Memory Glossary
[‘f‘ Create ﬁ?é Add [ﬁ:"‘ Import

Name Read Only | Type Path

(Optional) Click Create to create a new local blacklist for your project.

a) On the Create Blacklist dialog, enter a unique name for the blacklist.

b) Select a target language for the blacklist, then select the location for the blacklist on your local disk.
c) If you want to prevent any edits to the blacklist, select Read-only.

d) Click OK.



17.

18.

19.

20.

21.

(Optional) To add an existing blacklist to your project, click Add, then select a local or remote blacklist from the
drop-down list.

a) Local — Select a location on your local disk.

b) Add Remote — Enter the details on the Connect to Remote Blacklist dialog. Refer to Connect to a
Remote Blacklist.

(Optional) To import an existing blacklist to your project, click Import.
a) On the Import Blacklist dialog, select the import File Type: TXT.
b) Click Browse to locate and select the project file that contains the blacklist that you want to import.

c) Select the blacklist creation option: Create a new blacklist or Import into existing blacklist. Refer to
Import a Local Blacklist

d) Select an overwrite option for preexisting terms.
e) Select Clear before import if you want to ensure the import overwrites a clean blacklist.
f) Click OK.

On the Source Files tab, choose a method to add project source files.

Reference Files

Eﬂ?ﬁ Add File E; Add Folder ? Create Filter

Name Type Path

You can drag-and-drop files from a folder to the Files panel.

To copy source files into the Source File folder within the Project folder on your computer, select
Copy Source Files into Source Folder in your General Preferences.

a) (Optional) Add File — Click to browse to the source file.

b) (Optional) Add Folder — Click to browse to the folder location for source files.

On the Reference Files tab, choose a method to add supporting documentation.

Source Files
I A i A
Add File F Add Folder
3 3
Name Type Path

a) (Optional) Add File — Click to browse to the source file.

b) (Optional) Add Folder — Click to browse to the folder location for source files.

(Optional) Select any additional Options.

Run analysis report on  Analyzes source files against TMs and generates a report. You can also view this
documents report under the Reports tab, after opening the project.

Pre-translate TXLF files Populates TM leveraged segments when TXLF files are open.



Use primary MT onno  Leverages primary machine translation (MT) when there are no matches with the
match segments local and remote TMs. This option is only available if you selected Pre-translate
TXLF files.

22. Click Create Project to analyze the files and display the project creation summary.

Here you can see the number of the files added. TMs,
@ zcklists and glossaries along with any errars that might
have occurred.

Ea Bilingual (TXLF) Files

Created: 1
Failed: 1]

? Translation Memories
Added: 1

D-l Glossaries
Added: 2

!é Reference Files
Added: 1]

%,  DBlacklists
Added: 2

+| Cpen created project

23. (Optional) On the WordFast1 dialog, select Open created project.
24. Click OK.

The project is created.

Open a Project

Once you create a project, the next step is to open it. You cannot open files for translation without first opening
the associated project.

To open a project on the Projects tab:
1. Select a project name from the project list on the Projects tab.

2. Click Open Project. You can also double-click on the project name to open it.
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Modify a Project

You can change the project name, source language, and target language using the Modify Project action.

To modify a project:

1. On the Projects tab, select a project, and then click Modify Project.

= Wordfast Pro ~ Y= Help
Project
|:.'.;EI. :D |: I |:.'0
Create Open Close Add
Project  Project  Project  Project

3
Madify
Project

Project

Remove Recalculate
Progress

Import Import SOL
Package Package

=
Export

Package

2. (Optional) On the Modify Project dialog, enter a different title in the Project Name field.

w-

target languages.

Use this dialog to change the project name and either add or remove

Project Name:* Project1

Target Languagei(s):* German X

40X

Cancel




3. (Optional) Add a language in the Target Language(s) field by selecting one from the drop-down list or remove
a language by deselecting it.

4. Click OK.

The modifications are active and the project list displays.

Remove a Project

To remove a project:

You can add a project to the Project List again, even after you removed it. Wordfast does not erase
removed projects, so you can still retrieve them from the project folder on your computer using the
Add Project action.

1. On the Projects tab, select the project to remove, and then click Remove Project.

= voruretro - LR ey

Project Package
FEREEER B F 8 8 R
Create Open Close Add Modify Remove Recalculate Import Impert SDL Export

Project Project Project Project Project Project Progress Package Package Package
2. On the Remove dialog, click one of the action buttons.

*) Remove from the list only

Remaove from the list and move the following resources to Archive folder

Resources #
TXLF Files 2
Reference Files 1
4 3
0K Cancel
Remove from the list only Remove the project from the Projects List but
retain project resources in the project folder on your
computer
Remove from the list and move the following Move the project TXLF, reference, and source files
resources to Archive folder to the Archive sub-folder within the project folder on

your computer

3. Click OK.

The project is no longer in the Projects List.



Package Files

A package file contains all of the required information to work on a translation project. You can use a package file
to share content and files among different Wordfast Pro (WFP) users. The package file can contain complete or
incomplete projects.

A package file generally includes:

e Source files

e All target translatable files

¢ Instructions

e Background information

¢ Reference files

e Comments

¢ Connection to at least one Translation Memory (TM)
e Connection to at least one glossary and blacklist

To access a package file from another user, import the file into WFP. Wordfast connects the imported files to
translation memories and glossaries. It provides you access to all the translatable files and additional resources,
including TMs and glossaries, without any additional setup or configuration.

To share a completed project with other users, export it as a package file.

PACKAGE FILES

Import Package Files

Package files allow different Wordfast Pro (WFP) users to share files. When you import a package file, you
automatically connect the files to translation memories and glossaries. You also gain access to all translatable
files and additional resources. This eliminates the need for manually creating a project.

To import package files:

1. On the Projects tab, click Import Package.

For ease of use, you can drag-and-drop to move a package file into the window's white space.

T o

Project Package
o= H== = 5= o= o= Sl p g
BEERBER B B &£ & 4
Create Open Close Add Modify Remove Recalculate Import Import SDL Export

Project Project Project Project Project Project Progress Package Package Package

2. On the Import Package dialog, click Browse to locate and select the package file.

Required fields are marked with a red asterisk.



Import Package x

as |mport Package
Select options to import a GLP file to the project list

Select a GLP file:™ |C:\Users'.Documerﬂs‘l.Soume\WFP Export Browse...
Source Language: en
Target Languagei{s): de-DE

#*) Update an existing project

Select project to update:™ Projecit1 -

*) Only update the project's existing TXLF files
Update the project's existing TXLF files and add new files

Create a new project

Browse..

] Open project after importing

Import Cancel

3. Choose one of the following:

e Update the active project by clicking Update an existing project and its options.

e Create a new project by clicking Create a new project and its options.

4. (Optional) Select Open project after importing to open the updated or new project when the import
completes.

5. Click Import.

The package file is imported.

@ If you did not deselect Open project after importing, the current project view opens and displays
files for translation.

PACKAGE FILES

Export Package

Use Export Package to share a complete project package with other Wordfast Pro users.



To export a package on the Projects tab:

1. Select a project, and then click Export Package.
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Project Package
BE E E BE B BFE B & &
Create Open Close Add Modify Remove Recalculate Import Import SDL Export

Project Project Project Project Project Project Progress Package Package Package

2. On the Export Package dialog, select either Entire Project or Specific target languages and resources.

Export Package X
e Export Package
Select options to prepare a project export for distribution or archiving
Project Info
Project Name: Project 1
Project Location: C\Users\WordfastPro\projecis\Project 1
Source Language: English
Export

#) Enfire Project

Specific target languages and resources

Resources to Include in Export

Package Name
Select Maming Convention: | Project Name -
Preview: Project 1.glp

Belect Location to Save
CUsers\Documentz\Source\WFP Export Browse...

Export Cancel

Entire Project Click to export all target languages and their associated resources.

Specific target 1. Click to export specific target languages and associated resources.
languages and 2. Click items from the drop-down list for further options to deselect specific
resources Target Language and resources for exclusion from the export.

3. Choose an existing name from the Select Naming Convention drop-down list or enter a name of your choice
in the Custom Name field.



@ The Preview field provides the name of the file as it will export below the Package Name fields.

4. Select a save location for the project package, then click Export.

The exported project package is built and saved to the folder location.

Import an SDL Package

You can import an SDL package file for conversion of SDL source files to a compatible Wordfast Pro format.
Imports include scores for source content, but do not include translation memories, glossaries, and reference files.

To import an SDL package:

1. On the Projects tab, click Import SDL Package or drag-and-drop the SDL Package file into the application

window.

= wouresipo JESS by ]
Project Package
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Create Open Cloze Add Modify Remove Recalculate Import Import SOL Export

Project Project Project Project Project Project Progress Package Package Package

2. On the Import Package dialog, click Browse to locate and select the SDL Package file.

é If the SDL Package file contains unsupported target languages, a warning message notifies you.
Click OK.

Import Package x
e 'Mport SDL Package
Select options to import a package file to the project list
Select a package* CUsers\Desktop\Project 5. sdippx Browse...
Source Language: en-Us
Target Language(s): it-1T,de-DE

Create a new project
Project Mame:* Project 5

Location:* CUsers\Wordfastd\projects Browse...

Open project after importing

Import Cancel

3. Enter the new Project Name.



. Browse and select the save location for the new project.
. (Optional) Select Open project after importing to open the project automatically after import.
. Click Import.

The SDL Package file import completes. For imports with Open project after importing selected, the current
project view is opened and the files for translation are displayed.



5. Manage Project Files

When you open Wordfast Pro, the default Project List view lists all projects you can open. When you open
Wordfast Pro for a project with multiple files, the Current Project view lists all files associated with the project
below the language pair on the Project Files tab.

Wordfast Pro — [m] x
i Wordfast Pro ~ [IZIS=8: "9 Project TM  Project Terminology ~ Reports  Reference Files  Help A X
Files Project
B B = ST [ B B F =
Add Add Close Modify Analyze Transcheck Segment Changes Export Notes Clean Up Recalculate -
Files Foiders Fi Fi Project Project Exp Report Report Report Progress
Word Count Creation Date | Last Saved Translation S... Complete [> I ]
< EN-> DE
: Demo-Sample-En... 277 C:\Users\Laks\Wordfast®\p... 2017/04/20 11... 2017/07/211... 0%
Sample_1.docd. 188 C:\Users\Laks\Wordfast4\p 2017/02{01 13 2017/07/26 0 . 92%
Demo-Sample-En... 277 C:\Users\Laks\Wordfast4\p... 2017/07/24 16... 20170724 1... 0%
sample_3.docct.. 188 C:\Users\Laks\Wordfast4\p...  2017/02/0113..  2017/07/211... . B1%
EN - DE ] 17%

Add Files

You can add files to an existing project using the Add Files option on the Project Files tab.
@
¢ You can add files to a project with different language code variants, as long as they are not

country specific. For example, a project with the country code EN > DE accepts files of any

language code variants. However, if the project language code is EN-US > DE-DE, the only
acceptable additional language code is the generic EN > DE.

If one or more of the source files has a different language code, you will receive a prompt to
modify the project and add the new target language.

To add files to a project, on the Project Files tab:

1. Click Add Files.

R GTGIET L Rd  Project Files Project TM Project Terminology Reports Reference Files Help
Files Project
X -2 (=] rl
== = = A -‘ Lo
Bt B2 0 B B BE B & :
Add Add Translate Chain Open Source Close Modify Bilingual Analyze Transcheck
Files Folders File Files File Project Project Export Report

2. Browse to and select one or more source files on the Open dialog.
3. Click Open.
4. On the Files Report dialog, click OK.

Add a Folder

You can add a folder containing multiple files to an existing project using the Add Folders option on the Project
Files tab.



To add a folder to a project:

1. On the Project Files tab, click Add Folders.

=R TGET Rd  Project Files Project TM Project Terminology Reports Reference Files Help

Files Project

Br B B BEFE B & EB

Add Translate Chain Open Source Close Modify Bilingual Analyze Transcheck
Files Folders File Files File Project Project Export Report

2. Click Select Folder.
3. On the Files Report dialog, click OK.

Open a Source File

You can view a source file in its original format.
To open a source file:

1. Click Open Source File on the Project Files tab.

= Rl Project Files Project TM Project Terminology Reports Reference Files Help

Project

Bwe B [ B BB B & B

Translate Chain Open Source Close Modify Bilingual Analyze Transcheck
Files Folders File Files File Project Project Export Report

2. View the source file when its default application opens.

@ If the default application is not set, choose an application when prompted to do so.

Close a Project

When you are finished working on a project, close it before you open another.
A You can only have one project open at a time.

1. Click Close Project on the Project Files tab.

=t Rl Project Files Project TM Project Terminology Reports Reference Files Help

Files Project

B w B [0 B B BE B & E

Translate Chain Open Source Close Modify Bilingual Analyze Transcheck
Files Folders File Files File Project Project Export Report

2. (Optional) On the Projects List view, select a new project from the list and click Open Project.



Conduct a Bilingual Export

Use Bilingual Export to export the TXLF file with highlighted glossary terms into a .DOC or .DOCX format. This
allows you to edit and spell check the file using Microsoft Word, rather than the internal spell check. You can also
complete a bilingual export or import outside the Project List view using Quick Tools.

A Bilingual exports require you to set Bilingual Export Options in Preferences>General Preferences.

To conduct a bilingual export:

1. On the Project Files tab, select a file or multiple files, then click Bilingual Export.

=it R Project Files Project TM Project Terminology Reports Reference Files Help

Files Project
= —L =t - rl
= == = = B v by
BB 2 [0 B B B B & &
Add Add Translate Chain Open Source Close Modify Bilingual Analyze Transcheck
Files Folders File Files File Project Project Export Report

@ You cannot select files that are already open for bilingual export in TXLF Editor.

2. On the Select bilingual file location dialog, select the destination folder for the exported documents, then
click Select Folder.

The session log is displayed. This log and the exported Word documents are saved in the selected folder.

Log session start time Thu Dec 08 21:02:43 EST 2018

Level Message

INFO ToReviewhMultiTxif w1.2.0_RC1

INFC Bilingual Review Export

INFC The EM ! DE glossary was searched.

INFC Processing C:\Users\Laks\DesktoptL MENWWEWYE testing\Documentation\dettdfiSample 1.docwx txif

INFC Processing C:\Users\Laks\Desktoptl MENWWEWYE testing\Documentation\dettdfiSample 2 docwx.txml. fdf

INFC T8 tus written.

3. (Optional) Open the bilingual export report and review the results.



ID> Sample 3.docx.txml.txlf

m Source (en) Target (de) Score
1 TRANSLATION MANAGEMENT. UBERSETZUNGSMANAGEMENT. 00
2 SIMPLIFIED. VEREINFACHT. 100
3 STREAMLINE [PROJE CT| MANAGEMENT EFFEKTIVES PROJEKTMANAGEMENT 100 Eﬂm mglﬂ [0FRT:Glo1]:
4 [ INTEGRATE WITH ANY SYSTEM TNTEGRATION MIT JEDEM SYSTEM 100 poide
5 WORK WITH ANY [VENDOR) ZUSANMMENARBEIT MIT JEDEM ANBIETER 100
Comment [OFRT:Glo2]:
6 ACCELLERATE TIME TOMARKET KURZERE BEARBEITUNGSZEITEN 87 From: Glossary
7 CUSTOMIZE WOREFLOWS INDIVIDUELLE WOREFLOWS 100 T
8 ACCESS REAL-TIME KPI DATA ZUGRIFF AUF LETISTUNGSEENNZAHLEN IN ECHTZEIT | 100
9 GlobalLink [Project Diractod] saves Mt GlobalLink Project Director sparen Organisationen 100 E‘r}u"; mGeT;s[gmnG lo2]:
organizations millions of dollars by sutomafing | 2ufgrund der automatischen Verwalfung vom - ------roo- oo Fraec: Direcior
the management of localization processes and Lokalisierungsprozessen und -ressourcen Millionen.
fesOources.
10 SEAMLESS IDATAB:\SE INTEGRATI qu NAHTLOSE DATENBANEINTEGRATION 100 Eﬂm mg:i [OFRT:Glo4]:
11 Use [GlobalLind] Comnect with any CMS, PIN, | GlobalLiak Connect Funkiioniert mi jeder CMS-, PINE, 100 DATENBANKINTEGRATION
CCMS, or e-commerce platform | CEMS- oder E-Commerce-Plattform -~~~} —————
12 WORK WITH ANY FILE FORMAT FUR JEDES DATEIFORMAT 100 From: Glossary
13 Next-generation parsing engines extract Parsing-Engines der nichsten Generation extrahieren Inhalte 100 Slebalink
content and prepare it for translation und hereiten sie fiir die Ubersetzung vor
14 [VENDOR-NEUTRAL] PLATFORM ANBIETERNEUTRALE PLATTFORM 100 Eﬂm mglﬂ [OFRT:Gla6]:
151 Allow access to any [rendod or intermal Maximale Ressourcenflexibilitat durch Zugriff auf alle 100 Aroietemetra
translator for maximum resource flexibifity | Anbieter and mtermen Ubersetzer === ==="""""""" " T Comment [OFRT:Glo7]:
16 CONFIGURAELE WOREFLOW KONFIGURIERBARER WORKFLOW 100 From: Glossary
17 Streamline vour translation process through Optimierung des Ubersetzungsprozesses durch 100 T
automation of manual tasks Automatisierung manueller Aufgaben
18 TRANSLATION MEMORY INTEGRATION | INTEGRATION VON TRANSLATION MEMORY 100

Analyze Project Files

Project analysis compares source files to a connected translation memory (TM) to leverage reusable content. Use

the Analyze action to assess files prior to translation or to pre-translate files.
To analyze project files:

1. In the Current Project view, click Analyze.

= Wordfast Pro ~ X =gl Project TM Project Terminology Reports Reference Files Help

Files Project
- L =2 == [ S
e B [ =z B B B S
Add Add Translate Chain Open Source Close Maodify Bilingual Analyze
Files Folders File Files File Project Project Export

2. On the Project Analyze dialog, select the language pairs and files for analysis.

|‘vﬂ¢-

Transcheck
Report

é Verify that the TXLF file you want to analyze is not open in TXLF Editor. You cannot analyze an open

file.



Project Files (1) Analysis Options
] | Project Languages/Files Word Count
: | Pretranslate | 100 % | % matches
M= EM US -= DE DE
v PD en-de.docx.txif 214 *) Copy all tags on segments when there is no TM match

Copy segment source to target when there is no TM match
Do nothing
Calculate analysis report percentage by:
*) Words
Segments

| Calculate internal fuzzy matches (75 % | % matches

Report Settings

Show only analysis report summary

# Export Report

Report Namea:* Alpha Project analysis report
Report Type: htmil -
Report Location:* MUszers/LaniZea/DocumentsTOC Browse...

Translation Memory (0 )

| TM Name Location
v B ENUS -> DE DE
Analyze Cancel
3. Select options under the Analysis Options heading.
Option Action
Pretranslate Select to create translated TXLF files, based on Pretranslate options.

Note: Selecting Pretranslate is an optional step. The percentage defines the
minimum leverage required to pre-translate a specific segment.

¢ % matches—Select the percentage of matches to pre-translate

e Copy all tags on segments when there is no TM match

¢ Copy segment source to target when there is no TM match

¢ Do nothing

Calculate analysis Click an option to set the calculation percentage by either words or segments.
report percentage by:

Calculate internal fuzzy Select to set the calculation percentage for internal partial matches.

matches
Lock segments with Click to prevent the edit of 100% matches and the overwrite of the TM with those
100% matches from edits.

being edited
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Option Action

Do not allow segments  Click to prevent the merging of translation units (TUs) during analysis.
to be merged

Do not allow sources to Click to prevent an overwrite of the source segment with new edits.
be edited

. Select the format for the output report under the Report Settings heading.

a) (Optional) Click Show only analysis report summary.

b) (Optional) Click Export Report, then complete the required fields and select a location.
Select a TM under the Translation Memory heading.

Click Analyze.

On the Report File dialog, view the project files analysis.

Click OK.

Run a Transcheck Report

Use Transcheck Report to verify target segments and flag a variety of common errors within segments. Run a
Transcheck Report on one or more languages or files in a project.

If you have specific terms you want Transcheck to ignore, you can mark those segments for exclusion

in the Transcheck Report using the Transcheck All action. This reduces false positives during
Transcheck error detection. Refer to Use Transcheck All.

To run a Transcheck Report:

1.

Click Transcheck Report on the Project Files tab.

Project Files Project TM Project Terminology Reports Reference Files Help

Files Project
= L =L (= rl
= == = B= s 3 e
e B [ B E E B & :
Add Add Translate Chain Open Source Close Maodify Bilingual Analyze Transcheck
Files Folders File Files File Project Project Export Report

. On the Project Transcheck dialog, select one or more languages or files.



Project Transcheck x

Project Files (2) Transcheck Tests
Disclaimer
Project LanguagesiFiles | Word Count In order for the Spelicheck Transcheck to work you would need to enable the
=N EM -= DE Spelicheck option in the Spelicheck Tab in Preferences.
M : Sample_1.doc 188
M Sample_3.doc 188 SelectiDeselect All
Sample_2.doc 188 -

Blacklist Check

Capitaliz atien Check

Edited Context Match Check
Edited Exact Match Check
Edited Source Check

Empty Target Check

Forbidden Character Check

BEinbr mmnlmdod Toonck M honl

Report Settings
Report Name:* Project1 transcheck report
Repaort Location:™ Browse...

Glossary (2) Blacklist (1)

| Glossary Location

~ = -@EEN-»DE

i . Doc_Terml C:\Users\Laks\OneDrive\Document. ..

i Doc_Term?2 C:\Users\Laks\OneDrive\Document. ..
Run Transcheck Cancel

3. Select the Transcheck Tests you want to conduct.

@ Consistency checks are only accessible through the Project Transcheck dialog.

1. Source consistency check — Use to search for segments with the same target translation,
but with different source segments.

2. Target consistency check — Use to search for segments with same source segments, but
with target translations.

Select the appropriate checkbox to ignore differences such as case, numbers, tags, and whitespace
for source and target file consistency checks.

4. Enter the Report Name and browse to select the Report Location folder.

5. (Optional) If you want to enable the Terminology Check or Blacklist Check tests, select the location of the
Glossary or Blacklist you want Transcheck to use from the list on its tab.

6. Click Run Transcheck.



A Report Summary is created and the report is saved to the chosen location.
Project TransCheck Report - Projectl - English -
German

Report Summary (2 files)

TransCheck ran successfully on 2 files and found 129 errors.
Target Consistency Check ran successfully with 0 errors.
Source Consistency Check ran successfully with 0 errors.

| FileName Total Number of Errors

Sample 1.docxi.txml.txIf 64
Sample 3.docx.txml.txIf 65

Sample 1.docx1.txml.txIf
@TransCheck | 64Emors |

Blacklist Check
Capitalization Check
Number Difference Check
Edited Exact Check
Edited Context Check
Edited Source Check

Empty Target Check
Forbidden Character Check
Mistranslation Check
Notes Check
Punctuation Check
Repeated Words Check
Segment Length Check
Paragraph Length Check

] Copied Source Check

1Spelling Check

1 Tag Check

[ Terminology Check

~NolooolooolNn|joOloooN

-
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Generate a Segment Changes Report

A segment changes report provides you with the history of changes to a segment. You can run a segment
changes report on one or more project files.

To generate a segment changes report:

1. Select a single project file or multiple project files, then click Segment Changes Report.

RGN IET A S TR Project Files Project TM Project Terminology Reports Reference Files Help

Project

BEw BE B 8 B B B R

Close Modify Bilingual Analyze Transcheck Segment Changes Export Motes Clean Up
Files Folders Project Project Export Report Report Report

On the Segment Changes Report dialog, select the languages or files to include in the report.



Project Files (1)

Report Settings

/1 | Project Languages/Files Word Count Show/Hide Columns:

1 @ EN US -> DE DE M Notes

) Sample4_Sample-File_Repeat_en-de . 196 i comments
K Ratings

Post Edit Distance
K] Enable Diff Highlight
Show latest revision from a phase
Open report after export
#) Filter Phase-nameq{s): -

Filter Process-name(s):

Custom report name: SampleProject-1_SegmeniChangesReport_2018_T123456]
Report Location:™ C\Users\Documents'\Source Browse...
Export Cancel

3. Select options from the Report Settings pane.

Option

Action

Show/Hide Columns

Select the columns you want to show by clicking the appropriate checkboxes.

Note: Notes, comments, and ratings each have a column. Blank columns indicate
the feature you selected is not available or there is no data related to that option
for the segment.

¢ Notes, comments, and ratings — Translators and reviewers each have
their own notes column. Only reviewers can add comments and ratings.

e Post Edit Distance — Compares new target content to prior target content
and determines how different they are, down to character additions and
deletions

Enable Diff Highlight

Select to compare differences between new target content to prior target content.
Red strike-through highlights indicate deletions and green highlights indicate new
content.

Show latest revision
from a phase

Select to include the latest content from a specific workflow phase, regardless of
total number of revisions for that phase.

Open report after export

Automatically open the report once the export completes.

Filter Phase-name(s)

Filter content in the report by a specific workflow phase by selecting that phase
from the drop-down list, then choose to include all phases prior to the selected
phase name.




Option

Action

Filter Process-name(s)

Filter content in the report by a specific process, such as No Review or Review
from the drop-down list, then choose to include all phases prior to the selected
phase name. This can be inclusive, so you can select several processes.

Custom Report Name

(Optional) Enter a unique name for the report if it requires customization.

Report Location

Browse and select the file location for saving the segment changes report.

4. Click Export.

5. On the Segment Changes Summary dialog, verify the names of the files you chose to include, then click OK.

Segment Changes Summary

Filename
Sample_1.dood. teml bdf
Sample_2.dood.teml bdf
Doc_Terml.xsx.bdf

x

Segments Segments with changes

oK

6. Open the Segment Changes Report in a new browser window, then close the browser window when you are

done.

Segment Changes Report

PD en-de-IDML-de#TR DC#.idml5331243546933436583.txIf

. Total Source Target
File Name Segments Segments Segments
Changed  Changed
32 1] 2

[ Target Revisions

ID Scon

Use GlobalLink Co
CMS, PIM, CCMS,
platform.

Source

Translator

Target Notes

documenta|GlobalLink Connect funktioniert mit

(Translatiofjeder CMS-, PIM-, CCMS- oder B
—E-Commerce-

Plattform.

nnect with any
or e-cammerce

13:12:19
CST 2016
documenta)
(Translatio

GlobalLink Connect funktioniert mit
jeder CMS-, PIM-, CCM5- oder E-
Commerce-Plattform

13:35:13
CST 2016

11 | 95 |Next generation p

translation.

extract content and prepare for

documenta)
(Transfatio
1}

Tue Dec
06
13:11:33
CST 2016
documenta
(Transfatic

1}

arsing engines Parsing-Engines der nichsten
Generation extrahieren Inhalte und
bereiten sie fir die Ubersetzung

vor:Ubersetzung-vor

£ This is the
first note. -
documentation_g
= Mon Nowv 21
13:51:50 C5T
2016

Parsing-Engines der nachsten
Generation extrahieren Inhalte und
bereiten sie fir die Ubersetzung vor




Generate an Export Notes Report

The notes report is an HTML file that includes all notes added to the bilingual project files.
To generate an Export Notes Report:
1. On the Project Files tab, click Export Notes Report.

=R TGiE L R Project Files Project TM Project Terminology Reports Reference Files Help

Project

BEw B E B & B R B R

Close Modify Bilingual Analyze Transcheck Segment Changes Export Motes Clean Up
Files Folders Project Project Export Report Report Report

2. On the Export Notes Report dialog, select one or more project language files.

Project Files (1) Report Settings
[] ‘ Project Languages/Files | Word Count| Report Location:* |C:'I.Users'l.Laks'\Desktu-p'\LNKI.WF'\WF testing | m
[] = @mEN->DE
1 i Sample_1.doc: 188
| i Sample_3.docc. 188
| E Sample_2.docc 188
Export Cancel

3. Browse and select the Report Location destination, then click Export.

4. On the Export Notes Summary dialog, click OK.

Export Notes Summary

Filename Segments Segments with Notes
Sample_1.doodd beml. bdf 37 3
sample_3.dooc bl bdf 37 1
Sample_2.doodd beml. bdf 37 0

OK

The notes report saves to the specified location.

Clean Up a Project

After you have translated project files, it is time to clean them and update the translation memory (TM). The Clean
Up action converts the bilingual TXLF files into translated target files with the file format of the source.



To clean up the project and update the TM:

1. In Current Project view and on the Project Files tab, click Clean Up.

=R TGET Rd  Project Files Project TM Project Terminology Reports Reference Files Help

Project

B B E B &8 B R B E

Close Modify Bilingual Analyze Transcheck Segment Changes Export Motes Clean Up
Files Folders Project Project Export Report Report Report

2. On the Project Clean Up dialog, select the languages to clean up.

e Froject Clean Up
Select the options that you would like to use to write translated segments to TM and create translated files

Select languages to Translated File Settings
cleanup
Place translated files in the original path of source file -
#*) All Language Pairs
Browse
Create subfolders by language
Add language suffix to the translated file name
Single Language Pair
TM Overwrite Options
Overwrite existing TU -
Select TM(s) to Update
Symbolic Name Type Source Target Path
Doc_TM1 LOCAL en de C:\Users\Laks\Desktop |\ LNE\WF...
Doc_TM2 HTTP en de tms://stg-supportl.translations....
Clean Up Cancel
All Language Pairs Cleans up all language pairs for the project

Specific Language Pairs Cleans up only the language pairs you select from the drop-down list

Single Language Pair Cleans up only one language pair you select from the drop-down list

Specify the location for the translated files from the drop-down list.
(Optional) Select Create subfolders by language.

(Optional) Select Add language suffix to the translated file name.
Select TM Overwrite Options from the drop-down list.

Select the TM(s) to Update from the table.

Click Clean Up.

© ® N o o &~ @

On the Info dialog, click OK.



The cleaned files are saved at the designated location.

Remove a File

If you decide a file does not belong with a specific project, remove it.

@ You can add a removed file back to the current project. Retrieve removed files from the project folder
on your computer by using the Add Files action.

To remove a file from a project:

1. On the Project Files tab, select one or more files, and then click Remove File(s).

=R TGiE L R Project Files Project TM Project Terminology Reports Reference Files Help

Project Package plions

Bw BEE B & B B & B O

Close Modify Bilingual Analyze Transcheck Remove Preferences
Files Folders Project Project Export Report Package Package File(s)

2. On the Remove dialog, choose a removal option.

*) Remove from the list only

Remaove from the list and move the following resources to Archive folder

Resources #
TXLF Files 3
Source Files 7
4 .3
OK Cancel
Remove from the list only Removes the file from the files list

Remove from the list and move Removes the file from the files list, and moves file resources to the
the following resources to Archive sub-folder on your computer
Archive folder

3. Click OK.

The files are removed from the current project.



0. Translate or Review Files

After completing the initial steps of creating a project, connecting to translation memories, and glossaries, the
project files are ready for translation in the TXLF Editor view. After completion of the translation, the project files
are ready for review, using the same TXLF Editor.

Translate a File

Save your work often by clicking Save on the File tab or by pressing Ctrl+S.

To translate a file:
1. On the Project Files tab, select a file and click Translate File.

= Rl Project Files Project TM Project Terminology Reports Reference Files Help
Project
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Add Translate Chain Open Source Close Modify Bilingual Analyze Transcheck
Files Folders File Files File Project Project Export Report

2. (Optional) On the Translation tab, copy all tags in the source segment to the target segment. Refer to Copy All
Tags.

3. Select a target segment and enter the translation.

Fa

‘ Source or Target - Match Case Regex |Enter text fo filter se¢ « | Filter: | Select special filter{s) j:l' ,G'
| 1D English -> German Score Status
TRANSLATION MANAGEMENT. -
1 100+% (/]

UBERSETZUNGSMANAGEMENT.
MADE SIMPLE.
2 | VEREINFACHT. o
STREAMLINE PROJECT MANAGEMENT
EFFEKTIVES PROJEKTMANAGEMENT

[INTFGRATF WITH ANY SYSTFM , , | |~

4. Click Next Segment or press Alt+Down to update the TM, move down one target segment, and leverage next
segment content.

Translate Segments

When you convert a file to a translatable TXLF format, all complete sentences become separate segments,
often divided by formatting or punctuation. Segments may be sentences, words, or numbers, depending on

the formatting of the source file. After you save the segment translations, the application commits the segment
translations to the translation memory (TM). Leveraging the TM automatically and consistently reduces the time
and expense of future translations by translating reoccurring words and phrases.



To facilitate rapid use of language-specific quotation marks, punctuation, and white space, select
Enable Smart Quotes in Preferences > General Preferences > Segment.

There are two configurations for modifying segments in the TXLF Editor view. You can control your configuration
from Preferences > Layout.

e Table view — Default view displays the source segment to the left and the target segment to the right.

e Stacked view — Displays the source segment row directly above the target segment in a spanned row.
This configuration distinguishes among rows by alternating row colors.

@ If there are either split or merged segments, indicated in the Status column with fior ﬁ, all split or
merged rows within the spanned row have the same ID column color.

:
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TRANSLATE SEGMENTS

Translate All Segments

The Translate All option completes the translation of all segments by leveraging content in the connected TMs.
To translate a project file using Translate All:

1. In TXLF Editor, click inside a segment.

2. Click Translate All.

= Wordfast Pro - File Edit Formatting Translation Temminology Review Help
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This leverages content in the connected TM and populates the target segments with translations. When this
process is complete, the screen refreshes and displays the results in the target column. The progress bar
indicates the percentage of translation already complete.

S
Source or Target - Match Case Regex |Enter text to fiter segments... ~ | Filler:| Select special fiter(s ~| O £ X Sort| Documenl )
] English German Score Status
1 |[TRANSLATION MANAGEMENT. UBERSETZUNGSMANAGEMENT. 100% ] -
2 |SIMPLIFIED. VEREINFACHT. 100%
3 |STREAMLINE PROJECT MANAGEMENT EFFEKTIVES PROJEKTMANAGEMENT 100%
4 | INTEGRATE WITH ANY SYSTEM INTEGRATION MIT JEDEM SYSTEM 100% ]
5 |WORK WITH ANY VENDOR ZUSAMMENARBEIT MIT JEDEM ANBIETER | 100%
6 ACCELLERATE TIME TO MARKET KURZERE BEARBEITUNGSZEITEN 100+% >
Additional Tools ~
EN ->DE sc:827c: 96 segments: 35/ 37 [ EESE

TRANSLATE SEGMENTS

View Segment History

In TXLF Editor, view the record of segment changes to the open file on the Segment History tab of the Editor
pane. Changes to segments include segment updates, as well as verify and lock actions.

TM Lookup Notes Segment History Metadata Transcheck (0)

Type Value Score Modificati...

Target | TAUSENDE VON ORGANISATIONEN 100+% 2018/0 «
VERTRAUEN BEIM OPTIMIEREN 827
IHRES GLOBALEN CONTENT 08:57:0 A
MANAGEMENTS AUF GLOBALLINK 3 MDT

Target | TAUSENDE VON ORGANISATIONEN 2018/0
VERTRAUEN BEIM OFTIMIEREN 219
IHRES GLOBALEN CONTENT 13:25:2
MANAGEMENTS AUF GLOBALLINK 4 MST 7,

L] »

EN — DE Segments: 99100 | Segment (Src/Tgt/Max): 76103/~

TRANSLATE SEGMENTS

Verify a Segment

Use the Verify Segment action to automatically modify and commit to a translation memory (TM) a 100%, fuzzy,
context match, or machine translation (MT) match segment, if the segment does not require any further changes.

@ When you verify a segment, it automatically calculates the segment content into the total progress for
the file. Progress totals display in the progress bar using a completion percentage.

To verify a segment:

1. In TXLF Editor, select a segment.

2. Either click @ or click Verify Segment on the Translation tab.



6. Translate or Review Files

*Sample-File_en-de-word_txlf-de-DE¥BH#.docx
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The segment status is changed to Edited and the segment is committed to the TM, changing the highlight
color of the target segment to purple. When you move to the next segment, the target highlight changes from

purple to pink.

TRANSLATE SEGMENTS

Copy Source Content

To copy source content to the target:

1. In TXLF Editor and on the Translation tab, select a source segment.

2. To copy the source content, choose one of the following:

o Click Copy Source.

e As a shortcut, press Alt-S to copy the source content.

3. Select the desired copy action from the resulting drop-down menu.

E B B

Mext Previous Commit

Segment Segment

B

Leverage

Translation

Segment

e B B E B

Werify Copy it Merge

Segment Source
Copy Source

Copy Source Text
Copy Source, Tags and Term Translations

Spiit Unconfirm /
Confirm

Copy Source and Term Translations

Copy Source, Tags, Source and Target Terms

Copy Source with Source and Target Terms
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Option Action

Copy Source Copies from source to target all content and tags

Copy Source Text Copies only content from source to target

Copy Source, Tags and Term Copies from source to target all content text, its tags, and
Translations translated concordance glossary terms

Copy Source and Term Translations Copies from source to target all content text and translated

concordance glossary terms

Copy Source, Tags, Source and Target Copies from source to target all content text, its tags, and both
Terms source and translated concordance glossary terms

Copy Source with Source and Target Copies to target all source and translated concordance glossary

Terms terms

The specified source content is copied to the selected target.

TRANSLATE SEGMENTS

Copy All Source Segments

To copy all source segments to all target segments:

1.

In TXLF Editor and on the Translation tab, click Copy All Sources.

= Wordfast Pro -~ File Edit Formatting Translation Temminology Review Help

Segment
+
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Mext Previous  Unconfirm / Leck Clear Copy Until
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All source segments are copied to all segments in the target column.

. (Optional) Begin translation in the target column.

TRANSLATE SEGMENTS

Split or Merge a Segment

Automated Actions

[+,

Until No Translate
Match Al

You can split or merge an existing segment to change segmentation. This is particularly useful for certain file
types or for languages where the next segment content may need to precede the previous segment. The best
time to split or merge a segment is early in the translation process.

To split or merge a segment:

1.

In TXLF Editor and on the Translation tab, select the segment to split or merge.

2. Click Merge or Split.



= Wordfast Pro = File Edit Formatting Transglation Terminology Review Help

Segment
= B B B B B B R E
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The segment is merged or split and the segment Status column contains either A or fi, respectively. If the
merge includes an entire paragraph, this is denoted with .
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TRANSLATE SEGMENTS

Lock a Segment

You can lock a segment to prevent any further changes to that segment. The best time to lock a segment is when
the translation is complete and the reviewer has confirmed the content after proofreading it. The Commit action
still updates the translation memory (TM) with the target segment content.

To lock a segment:
1. In TXLF Editor and on the Translation tab, select the segment to lock.
2. Click Lock Segment.

= Wordfast Pro -~ File Edit Formatting Translation Temminology Review Help
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The B is displayed in the segment Status column to indicate the segment is locked.



TRANSLATE SEGMENTS

Clear Target Segments
To clear target segments:
1. In TXLF Editor and on the Translation tab, select a target segment.

2. Click Clear Target.

= Wordfast Pro -~ File Edit Formatting Translation Temminology Review Help

Segment
+ +9,
E B B B B B B B
Mext Previous Commit Leverage Verify Copy - Clear | Copy Until Until No
Segment Segment Segment Source Target All Sources Fuzzy Match
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3. From the drop-down menu, choose one of the following:

o Select Clear Target to clear the selected target segment.

o Select Clear All Targets to clear them all.
4. On the Clear Current Segment Target dialog, click Yes to agree to the target content removal.

The target content is removed.

TRANSLATE SEGMENTS

Unconfirm a Segment

Translators can temporarily mark a segment that should not be committed to the translation memory (TM) using
the Unconfirm/Confirm action. This allows translators to temporarily mark the segment, later refer to translation
resources, make any changes, then confirm the translation for that segment based on that research.

To unconfirm a segment:
@ You can only unconfirm a segment that is already confirmed.

1. On the Translation tab, choose one of the following actions:

o Press Alt+Shift+Enter for unconfirm all segments.
e Click Unconfirm/Confirm.

= Wordfast Pro = File Edit Formatting Translation Termminology Review Help

Segment Automated Actions
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The TM is not updated with the target segment content.

The % is displayed in the segment Status column.



2. (Optional) To later confirm the segment, click Unconfirm/Confirm again.

TRANSLATE SEGMENTS
Edit a Source Segment

You can modify the source content of a TXLF file, since you can restore the original source content at any time.
To update the translation memory (TM), commit the edited source segments.

To edit a source segment:
1. In TXLF Editor, select a source segment.

2. On the Edit tab, click Edit Source.

= Wordfast Pro —~ File Edit Formatting Translation Terminology Review Help
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3. Edit the source content, then click outside the segment.

The source segment is saved and the #" is displayed in the Status column.

4. To revert to the original source, click Revert Source.
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Review a File

To review a file:

1. Inthe Project List view, double-click a project.

@ Projects with a single file automatically open in TXLF Editor view.
2. In TXLF Editor, review the source segment and the target translation, then make changes to the Target
segment as needed.

Verify that all tags in the Source segment are in the corresponding location within the Target
segment.
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3. (Optional) Click Find/Replace to search for and replace repeated content. Refer to Find and Replace Content.

4. Click Next Segment or press Alt+Down to update the TM, move down one segment, and leverage the next
segment from the TM.

Save your work often by pressing Ctrl+S or clicking Save on the File tab.

Chain Files

To combine multiple files and view them as a single file, use Chain Files. For example, if you are translating or
reviewing ten files with ten segments each, you can temporarily chain them into a single file of 100 segments.
This is particularly useful with duplicate or similar content among files.

A You cannot export or save chained files as a single TXLF file.

@ You can open and work on a single chained file or multiple sets of chained files in the TXLF Editor
view. Each chained file displays on its own tab.



6. Translate or Review Files Wordfast

To chain files:

1. On the Project Files tab, select a set of files, then click Chain Files.

@ Use Shift+Click to select sequential files or Ctri+Click to select individual files.

. Wordfast Pro - Project 1

=Ly ol Project Files Project TM Project Terminology Reports Reference Files Help
Files

BRE B I B BERE B 8 B B

Tranglate Chain Open Source Close Medify Bilingual Analyze Transcheck Segment Changes
Files Folders File Files File Project Project Export Report Report
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The chained file opens in TXLF Editor with a default file name of Chai ned Fi |l es 1. Each file in the chain

starts with a segment ID of 1 and ends with a file divider. Following segments in the file display a sequential
number located in the ID column.
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2. Click in a segment.
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The file name changes from the chained name to the source file name of the active segment.

*Chained-8ample-File_en-de.docxtxlf *
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3. Translate, review, or edit each segment.
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4. Click Save on the File tab to save the chained file.

The segments are saved in the chained file and restored to their original files without the chained format.

Find and Replace Content

Use Find/Replace to search for and replace text in translated content.




To find and replace content in a file:
1. In TXLF Editor, click the Edit tab.
2. Click Find/Replace.
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3. On the Find/Replace dialog, click in the Find what field, and then enter your search text or select it from the
drop-down list.

Find/Replace x

Q
Find what: | - |
N,
o Reading Highlight Find Next Close

Direction Options

() Backward [ lgnore Case [] Search Source

() Forward [] whole Words Only /] Search Target

[ I1gnore NBSP | Search Open Files

4. (Optional) Click ¥ and #: to expand and collapse the panel for additional options.

@ Search text can include non-breaking spaces.

5. Click Find Next to move through all instances of the content.

6. (Optional) Click Reading Highlight to highlight all instances of the content in all open files.

Find/Replace x
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a Reading Highlight - EEGLELTES Close
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] Search Source

) Backward Clear Highlighting
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7. (Optional) To replace characters or words, click the down arrow on the sidebar, then click in the Replace with
field and enter a replacement.



Find/Replace x
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8. (Optional) Select the direction of the search and any further options.

You cannot use the Whole Words Only search option when entering multiple words or punctuation in
either search field.

9. (Optional) Click the desired action: Replace, Replace All, Find Next, or Close.

The content you found has been replaced with the new content.

Recalculate Progress

Use Recalculate Progress to calculate and update the progress of translated files, particularly files created or
edited in legacy versions. When you open a legacy file, the progress bar contains the N/A flag to denote that it will
not calculate progress. Use the recalculate action to update the progress and word count.

@ Refer to Chain Files to recalculate progress of multiple files.

To recalculate progress of a file:
1. Click Recalculate Progress.
2. Verify the progress bar reflects the current file status.

The progress is updated to reflect the % Complete status of the file.

Spell Check a File

You can use a spellchecker to verify translated content aligns with configured spell checking preferences. Refer to
Configure and Enable Spellchecker. You must verify your Hunspell spelling dictionaries have the latest updates.
Refer to Licensure.




To spell check a file:

1. On the Review tab, click Spellcheck File.

= WordfastPro ~ File Edit Formatting Transiation  Terminology GTV™ UMM Hep |
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2. On the Spelling dialog, review the suggestions and select one of the options.
W Use this page to check spelling.

Not in Dictionary:

INDIVIDUELLE WORKFLOWS

lgnore All
Suggestions:
DRKSHOPS Change
Change All
Preferences Cancel
Item Action
Ignore Once Click to ignore the suggested change for the word once
Ignore All Click to ignore the suggested change for all the occurrences of the word in the file
Change Click to accept the suggested change for the word
Change All Click to accept the suggested change for all the occurrences of the word in the

file

@ If spell checking is not available for the target language, a warning message notifies you. Click OK.

3. To view spell checking preferences, click Preferences or click Cancel to reject any changes.

4. Close the Spelling dialog.

Leverage Translation Memory

Translation memory (TM) acts as a database to provide maximum re-use of previously translated content. It also
serves to facilitate collaboration between globally distributed localization resources.



Projects connected to a translation memory (TM) leverage content matches against an existing TM. TM matches
generally fall into three categories: 100% match, fuzzy repetitions, or no match. Your organization may choose to
alter or add more fuzzy repetition categories. The typical fuzzy repetition values are for 95% to 75% matches. The
segment highlight identifies the type of TM match.

Color Code Category
Green Indicates a 100% match.
Green, Dark Indicates a context match. A context match for a segment must meet one of the

following criteria:
e The segment has a correct checksum or attribute match.
e The previous and next segments also have a 100% match.
e The 100% matched segment is a single paragraph.

Grey Indicates there is no TM match.

Pink Indicates a modified segment.

Pink, Light Indicates the segment was a machine translation (MT) instead of a human translation.
Purple Indicates an update to the TM for a modified segment.

Purple, Light Indicates the update to the TM of a translated and committed segment automatically

updates other repetitive segments within the translation.

Yellow Indicates a fuzzy match.

LEVERAGE TRANSLATION MEMORY

Leveraging a segment involves selecting the best possible translation from the connected translation memories
(TMs) or machine translation engines to populate target segments.

To leverage a TM:
1. Follow the steps in Translate a File.
2. Click the Translation tab in the TXLF Editor, then select the segments to leverage against the current TM.
3. Select an action to leverage the current TM.
Leverage Leverages a single segment
Until Fuzzy Leverages segment content until reaching a fuzzy match

Until No Match Leverages segment content until there is no match

Translate All Leverages all content in all segments

LEVERAGE TRANSLATION MEMORY

A concordance search looks for specific source segment text in a translation memory (TM). To view concordance
search results for both source and target segments, use the TM Lookup tab in the Editor pane.



To conduct a concordance search:

1. Click the Translation tab, then select a word or phrase in the segment in TXLF Editor.

2. Click Concordance Search from the Translation Memory group or press F8.
You can also search for a word or phrase by entering it in the TM Lookup field. Then, to conduct
a search of both source and target, press Enter. Instances of the search term are highlighted in

the Editor pane, along with its bilingual equivalents. To conduct a more specific search, click Find
Source or Find Target.

You can reorder the columns of the TM Lookup results. That reorganization remains, even after you
exit the software.

Notes Segment History Metadata Transcheck (0)

vendor More Options =  Find Source Find Target Clear
# Source Target Score | TM Mame Last Modified Custom Attribute
WORK WITH ZUSAMMENARBEIT | - Doc TM2 | 2015/11/04
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ANBIETER
WORK WITH ZUSAMMENARBEIT | -* Doc_TM1 | 2017/04/04
2 | ANY VENDOR MIT JEDEM @
ANBIETER
Allow access to Maximale - Doc TM2 | 2015/11/04
any \vendor| or Ressourcenflexibilitat
internal durch Zugriff auf alle
3 | translator for Anbieter und internen )
maximum Ubersetzer
resource
flexibility

3. (Optional) To refine the search, select More Options and select a check box from the drop-down list.

Option Action

Case Sensitive Filters by upper and lower case

Exact Filters for only those terms organized in the same sequential order

Automatic Leverage Automatically updates target content when moving to a new segment

Diff Highlight Highlights the difference between the submitted segment and the TM source
segment

Include Private TU (GLTMS) Includes private segments or translation units (TUs) when searching a remote
™

The refined search results for the word or phrase you selected are listed on the TM Lookup tab of the Editor
pane. You can use the results of your search in the related target segments.



LEVERAGE TRANSLATION MEMORY

View TM Leverage Results

Leveraging the translation memory (TM) occurs automatically as you move through the target segments. This
provides you with the best possible segment matches from the TM and is the only search that uses scoring to
select the best match.

To view TM leverage results:
1. In TXLF Editor, click on a source or target segment.

This populates the columns on the TM Lookup tab of the Editor pane and provides a score, based on TM

leverage results.

TM Lookup Notes

Segment History

Metadata Transcheck (0)

More Options =  Find Source Find Target Clear

# | Source Target Score TM HName Last Modified Custom Attribute

1 | SIMPLIFIED. VEREINFACHT. | 100% Doc_TM2 | 2015/11/04 @

7 SIMPLIFIEDI | mit minimalstem | 999 Doc_TM2 | 2013/04/26 ®
plified Aufwand

3 SIMPLIFIED. Vereinfacht. 09% Doc_TM2 | 2014/03/14 ®
Simpified:

4 SIMPLIFIED § Vereinfacht. 099% Doc_TMZ2 | 2014/11/07 ®
Simplifie-

5 | SIMPLIFIED. VEREINFACHT. | 100+%*  Doc_TM1 | 2017/04/04 @

2. Review TM leverage results in each TM Lookup column for that segment.

Item Behavior
Source Displays source segments provided by the TM. Any difference between the submitted
segment and the TM source segment is highlighted.
Target Displays target segments already in the TM.
Score Displays a TM leverage score.
e Percent (%) — 100% and fuzzy matches
¢ Plus (+) — Context matches
e Asterisk (*) — Secondary TM match
¢ Red outline — TM has assessed a penalty to the segment
Refer to Leverage Translation Memory for more information on TM color codes.
TM Name Identifies the name of the leveraged TM. If you are leveraging multiple TMs, it lists the

TMs in order of priority: primary, then secondary TMs.

Creation Date

Identifies the TM segment creation date.

Creation User

Identifies the username of the segment creator.

Last Modified

Identifies the date of the last segment modification.




Item Behavior

Modification User Identifies the user who last modified the segment.

Custom Attribute Identifies any segment custom attribute name and its associated values

@ status Acts as a button to access score breakdown information, including penalties.

columns you want to hide.

3. (Optional) To constrain the columns within the pane, click on any column head, then deselect the names of the

TM Lookup Notes Segment History Metadata Transcheck (0)

- More Options ~  Find Source Find Target Clear
#  Source w Target Score L TM Name Last Modified
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Aufwand

LEVERAGE TRANSLATION MEMORY

Leverage Machine Translations

1 W Last Modified

Medification User

| & Custom Attribute |

w1 Actions

The machine translation (MT) feature can automatically populate target segments whenever you open a file
or when there are no translation memory (TM) segment matches. Select the desired project for your MT and
configure Machine Translation options under Preferences > General Preferences.

To leverage MT:

1. In TXLF Editor and on the Translation tab, click Machine Translation to send the source segment out for MT

and populate the target segment with the results.
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2. (Optional) Verify that the quality of the translation for the source segments aligns with your requirements.

The target segments are populated with the MT for the source segments.

3. (Optional) If you are updating the current segment only, continue your work and repeat as often as necessary
until you are ready to save and commit all translated segments to the TM.



LEVERAGE TRANSLATION MEMORY

Committo the TM

Once you have finished translating some or all of the file segments, update the translation memory (TM) with your
translation. This requires committing some or all of the translated target segments to the TM.

To update the translation memory:

1.

In TXLF Editor and on the Translation tab, choose one of the following:

e First select the segment, then click Commit to commit a single segment to the TM.

e Click Commit All to commit all segments in the file to the TM.
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. (Optional) Verify that the updates you committed to the TM have a purple highlight.

(Optional) If you are updating the TM for the current segment only, continue your work and repeat as often as
necessary until you have committed all translated segments to the TM.

Leverage Terminology Lists

Terminology lists provide users with the ability to standardize term usage and to control the use of terms, variants
of terms, and parts of speech allowed for terms. A terminology list includes a glossary, a specialized list of source
terms, their definitions, and their preferred translations. It also includes alternate phrases for blacklisted terms.

To set up a terminology list, refer to Configure Terminology.

When you select a segment, it highlights all terms within that segment that are in the terminology list with possible
translations in the Terminology pane.

@ There are two possible methods for moving among terms in the Terminology pane.

o Click Next Term or Previous Term.
e Press Ctrl+8 or Ctri+9.
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The term highlight identifies the type of translation match between the source term and the terminology list.

Use Highlight All Terms to view highlights for term matches in the open file.

Color Code Category

Green Exact term match

Yellow Fuzzy term match

Red Missing exact term match
Purple Missing fuzzy term match

LEVERAGE TERMINOLOGY LISTS

Add a Term

You can add terms to both local and remote glossaries. You need read and write user permissions to add terms to
a remote glossary that is not read-only.

To add a term to a glossary:

1. In the Terminology pane, select a word in the source segment and, optionally, the translation in the target
segment, then click +.

2. (Optional) On the Add Term dialog, enter content in the Description field.



@ Required fields are marked with a red asterisk.

Add Term X

-

W Use this page to add a term to the selected glossary.

Source:* INTEGRATE WITH |
Target”* INTEGRATION MIT |
Description: | |
Glossary: Doc_Term - |

oK Cancel

3. Select the proper Glossary from the drop-down list.
4. Click OK.

The new term is added to the glossary.

LEVERAGE TERMINOLOGY LISTS

Edit a Term

A You can only edit terms in the local glossary.

To edit a term:

1. In TXLF Editor, and on the Terminology pane, select a term.

4+ A X < Terminology

|Search Glossaries (Source] | D x -l:!-

roject .

ke ‘@

projekie

Project Management ©

Projektmanagement

4 3
2. Click #'.

3. On the Edit term dialog, make your edits.



W Use this page to edit a term in the selected glossary.

Source:

| project |

Target:
| projekte |

Description:

Modify Cancel

4. Click Modify

The term is edited.

LEVERAGE TERMINOLOGY LISTS

Insert a Term

To insert a term into the current target segment:

1. In TXLF Editor, click at the location for term insertion.
2. Select the term to insert from the Terminology pane.
3. On the upper left of the Terminology pane, click +.

The term is inserted into the target segment.

LEVERAGE TERMINOLOGY LISTS
Search for a Term
To search for a term:

1. In the Terminology pane, enter a term in the terminology filter field, such as the term pr oj ect .

2. Click 2 .



The search results from the connected glossaries are displayed.

+ Terminology
project - ..D x #‘
project -
projekie ®
Project Management ®
FProjektmanagement

Project Director ®
Project Director

4 3

LEVERAGE TERMINOLOGY LISTS

Copy a Term
To copy a term from the glossary into the current target:
1. In TXLF Editor, click a segment that contains glossary terms.

2. On the Terminology tab, click Previous Term or Next Term to select a source term.
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3. Click on the target location where you want to copy to the glossary term.

4. Click Copy.
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The glossary term is copied to the target segment.

LEVERAGE TERMINOLOGY LISTS
Copy a Synonym
To copy a synonym for a term:

1. In TXLF Editor, select a source term in a segment that has a glossary term.



This highlights and adds a border around the source and target terms. Synonyms display in a temporary pop-
up pane and in the Terminology pane.

WORK WITH ANY VENDOR, ZUSAMMENARBEIT MIT JEDEM ANBIETER)

Source: Vendor
Target: Anbiefer
Glossary Name: Doc_Term1

Source: vendor
Target: Anbiefer
Glossary Name: Doc_Term1

+ Terminology
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Anbieter ‘(D

2. Click within the target segment at the location where you want to copy the term.

3. Click Copy.

@ An alternative is to click the preferred target term from the Terminology pane. This also copies the
term to the cursor location in the target segment.
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The target synonym is copied to the target segment.
LEVERAGE TERMINOLOGY LISTS

Remove a Term

A You can only remove terms from local glossaries, not read-only or remote glossaries.

To remove a term:
1. In the TXLF Editor, go to the Terminology pane.

2. Select a term, and then click *.

Use the Delete Term * at the top of the Terminology pane. Do not use the Reset Search *. This
clears the filter.

A warning message notifies you of the pending deletion and asks you to confirm the term removal.



3. Click Yes.

The term is removed from the local glossary.

Manage Tags

Tags contain information related to a block of text, such as format or indentation. Tags are not translated and
come in pairs: an opening and a closing tag.

A Translations must retain the same tags at the correct location within a target segment.

Unless you have disabled Remove incomplete tag pairs in Preferences > General Preferences >
Tags, a warning message results when you try to save a target segment with a missing tag or an
open tag. An open tag is part of a tag pair in the target segment that is missing its matching close tag.
The warning will give you three choices: Fix Manually, Delete, or Always delete.

Hover over a tag to view tool-tip information.

®HBTRANSLATION MANAGEMENT. @

=lontFormat colors"235 33 highlight="D#0#0&0" name="Gotham Medium® size="261" backgroundColor="D#0&080"

foregroundColor= "0 Mame="Gotham Medivm® hidden="false" >

Tags contain numerals to indicate their order in the segment.

Red Indicates you selected the tag, such as 1]
Purple Indicates a tag that specifies formatting, such as
Blue

Indicates a tag that specifies non-formatting controls, such as EDe

MANAGE TAGS

Copy a Tag

Translated content retains the formatting of the source content, so tags are an important element in the final
translation. You can copy tags from the source to the target for formatting and indentation accuracy.

@ Use Preferences > General Preferences > Tags to configure tags as full-sized or shortened.

To copy a tag:
1. Open afile.
2. In TXLF Editor and on the Translation tab, select a segment with tags.

When the selected segment contains tags, the first tag is automatically selected. Red indicates
selection.



3. Choose one of the following actions:

e Click a source segment tag and drag it to the corresponding location in the target segment or press Ctrl-
Down.

e Click a source segment tag, then click in the corresponding target segment location and click Copy.

= Wordfast Pro -~ File Edit Formatting Translation Temminology Review Help

Automated Actions Translation Memory Tags
(=] (=] -— (= o IT_.H . =5
9 -
B Bk 8§ £ & 8 B B B[
Until Until Mo Translate Commit Concordance Machine Analyze Previous Next Copy Edit
Fuzzy Match All All Search Translation Tag Tag Tag

The target segment, highlighted in pink, contains the copied tag at the cursor location you selected in the
target segment.

4. (Optional) Click Previous Tag or Next Tag to select another tag and repeat the process.

MANAGE TAGS

Copy All Tags

@ Use Preferences > General Preferences > Tags to configure tags as full-sized or shortened.

To copy all tags:
1. In TXLF Editor, open a file.
2. On the Edit tab, click Copy All Tags.

All copied tags display at the location of the cursor. Reorder them to reflect the source content order
using the drag-and-drop or copy-and-paste technique.
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3. Select Segment or Document from the drop-down menu.
Segment or Alt+A Copy only the tags for the selected segment to the target.

Document or Alt-Shift+P Copy all tags for the entire document.

All tags are copied to the segment or document.



MANAGE TAGS

Edit a Tag

Most tags in your target content have specific formatting and indentation settings copied from the source. You can
modify tags to change content format in the translated file.

A Do not edit tags in the source segment.

To edit a tag:
1. Open afile.
2. In TXLF Editor, select a tag in a target segment.

3. Choose one of the following actions:
e On the Translation tab, click Edit Tag.
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e Right-click the tag and select Edit Tag from the drop-down menu.

4. On the Edit Tag dialog, modify the tag.

A Verify that all tag edits are valid. Otherwise, the file could become corrupt.

[Edit Tag x
W You can edit tag content below. Note: Adding
invalid edits can corrupt the file on cleanup.
=ffontFormat=
OK Cancel
5. Click OK.

Edits to the tag are saved.



MANAGE TAGS

Clear All Tags
@ Use Preferences > General Preferences > Tags to configure tags as full-sized or shortened.

To clear all tags:
1. Open afile.
2. In TXLF Editor, and on the Edit tab, click Clear All Tags to expand the drop-down menu.
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3. Select Segment or Document.

Segment or Ctrl-Shift-V  Clear only the tags from the selected segment

Document Clear all segment tags for all target segments in the document

A warning message asks you to agree to have all tags cleared from the open file.

4. Click Yes.

All tags are cleared for the target segment or for all target segments in the document.

MANAGE TAGS

Delete a Tag

You may choose to delete target tags, particularly if there are multiple copies of the same tag in the same target
segment. You can only delete target segment tags.

To delete a tag:
1. Open afile.
2. Follow the steps in Translate a File

3. In TXLF Editor, select a tag in a target segment.



4. Choose one of the following actions:

e Press Delete or Backspace.
e On the Edit tab, click Cut, then paste the tag elsewhere.
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@ To undo the change, click Undo or press Ctrl-z.

The target tag is deleted.

Manage Project Notes

You can add notes that are specific to each segment during the translation and review process. If you have
chained files together, you can review all notes for all files in the chain.

Use the Notes tab in the Editor pane to view and manage project notes.

NV To quickly access Notes actions, right-click the segment. Then, select a notes action from the
resulting drop-down list.

MANAGE PROJECT NOTES

View Notes

The Notes tab is in the Editor pane. Notes retain the same ID as the related segment.

@ Segments with notes include a [ in the Status column.

To view notes:
1. Open afile.

2. In TXLF Editor, click the Notes tab in the Editor Pane, then view note details for all file segments.
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Notes for all file segments are displayed.

MANAGE PROJECT NOTES

Add a Note

To add a note:
1. Open afile.
2. In TXLF Editor, select a segment.

3. Choose one of the following actions:
e Click the Notes tab in the Editor pane, then click Add Note.

. il

TM Lookup Notes Segment History Metadata Transcheck (0)

Add Note Edit Note Delete Note Export Notes
ID | CreatorlD Type Date Details
13 Submitter |Review 2018/06/04 Check for correctness. M
13:19:02 MDT

Submitter |Question 2018/06/04 Are you treating "internal translator”

13 13:19:21 MDT as a single phrase for DE?

4 4

EN — DE-DE I Segments: 29/33 Segment (Src/Tgt/Max): 33/83/-  Par

e On the Review tab, click Add Note.
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4. On the Add/Edit Notes dialog, select a Type from the drop-down list.




Add/Edit Notes x

W Use this page to add or edit a nota.

Segment |D: 13

Source: Allow access to any vendor or internal franslator
for maximum resource flexibility

Creator.” Submitter
Date: 20183/06/04 13:10:38 MDT
Type: [Translation| -
| Review
Question
Important
Translation
OK Cancel
Type Description
Translation Select to include data for the reviewer from the translator
Review Select to includes data for the translator from the reviewer
Question Select to solicit a response about the segment from a user
Important Select to flag the data for the segment as a priority for other users

5. Enter the information in the note field.
6. Click OK.

The note is saved and associated with the segment.

MANAGE PROJECT NOTES

Edit a Note

To edit a note:
1. Open afile.

2. In TXLF Editor, select a segment with a note.



3. Choose one of the following actions:
e Click the Notes tab in the Editor pane, then click Edit Note.

TM Lookup Notes Segment History Metadata Transcheck (0) -
Add Note Edit Note Delete Note Export Notes

I | CreatorlD Type Date Details

13 Submitter |Review 2018/06/04 Check for correctness. M
13:19:02 MDT

13 Submitter |Question 2018/06/04 Are you treating "internal translator”
13:19:21 MDT as a single phrase for DE?

4 3
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e On the Review tab, click Edit Note.
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4. On the Add/Edit Notes dialog, edit the note.

AddiEdit Notes x

W Use this pags to add or adit a nots.
Segment 1D: | 13
Source; Allow access to any vendor or infernal franslator
for maximum resource flexibility.
Creator:™ | Submitter |
Date: |2u1smﬁm4 13:19:02 MDT |
Type: |Reuiew - |
Check for cormectness.
oK Cancel
5. Click OK.

The modified note is saved and associated with the segment.



MANAGE PROJECT NOTES

Delete a Note

To delete a note:
1. Open afile.
2. In TXLF Editor, select a segment with a note.

3. Choose one of the following actions:

e Click the Notes tab in the Editor pane, then click Delete Note.

TM Lookup Notes Segment History Metadata  Transcheck (0) -
Add Note Edit Note Delete Note Export Notes
ID | CreatorlD Type Date Details
13 Submitter |Review 2018/06/04 Check for correctness. M
13:19:02 MDT

3 Submitter |Question 2018/06/04 Are you treating "internal translator”
13:19:21 MDT as a single phrase for DE?

4 3
EN — DE-DE Segments: 29/33 Segment (Src/Tgt/Max): 33/83/-  Par

e On the Review tab, click Delete Note.
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The note is no longer attached to the segment. If there are no other notes, the notes icon is removed from the
Status column for the segment.

MANAGE PROJECT NOTES

Export Notes

To export notes:

1. Open afile.



2. In TXLF Editor, choose one of the following actions:
o Click the Notes tab in the Editor pane, and then click Export Note.

-

TM Lookup Notes Segment History Metadata Transcheck (0)

Add Note Edit Note Delete Note Export Notes
ID | CreatorlD Type Date Details
3 Submitter |Review |2018/06/04 Check for correctness. b
13:19:02 MDT
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13:19:21 MDT |as a single phrase for DE?

3
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e On the Review tab, click Export Notes.
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e Right-click the segment and click Export Notes.
3. On the Export Notes dialog, browse and select a location for the exported notes file.
4. Enter a file name and click Save.

All the notes for the open file are saved in the selected folder location as a table in an HTML file format.

Use Transcheck

You can use Transcheck to scan translated content for non-linguistic errors such as missing tags, empty targets,
numbers, and terminology within target segments. The @ is displayed in the Status column for segments with
errors.

@ To enable Transcheck and customize Transcheck options, configure in Preferences > New Project
Preferences.

USE TRANSCHECK
Use Transcheck During Translation

After you have configured Transcheck options, you can begin using Transcheck when you translate a segment
and commit to the TM. You can also use the Transcheck segments while translating Transcheck configuration
option to check for errors during the translation process.

To use Transcheck during translation:
1. In TXLF Editor, click a segment and complete your translation of that segment.

2. Click Next Segment or Alt+Down.



3.

(Optional) If Transcheck identifies an error in the segment, it posts a warning message. Choose one of the
following actions:

e Click Go back to fix the issue to correct the error.

e Click Continue to continue translating without changes.
If you choose to correct the error, the @ is removed from the Status column and from the Transcheck tab.

If you do not correct the error, the @ remains in the Status column and on the Transcheck tab.

USE TRANSCHECK
Use Transcheck All

Use Transcheck All to scan all segments of a file for non-linguistic errors in the target segments and issue
warnings for missing and incorrect text.

Use the Transcheck All option before you complete a file.

To use Transcheck All:

1.
2.

In TXLF Editor, finish translation of all segments in a file.

Click the Review tab, then click Transcheck All.
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A Transcheck report and summary result.

Review the warnings in the Transcheck Summary dialog, then click OK.

. (Optional) On the Transcheck Report, determine the terminology errors you want Transcheck to ignore from

highlighted terms in the Terminology Check report section.

To best optimize the Transcheck Report, you can configure Transcheck to ignore highlighted terms
you identify under conditions you specify. The terms and conditions you select are in the Ignored
Terminology Errors section of the report.



transcheckReport5481583249647184112.html 16

Ignored Terminology Errors

I Error II Action II Condition II Instances

Highlight: Z[Exact Match| |Fuzzy Match| |Exact (No Match)|
1|Fuzzy(No Match)|

Terminology Check:
transcheckReport5481583249647184112.html

Hide this report

Seqg.| Block Source Target Comment
1D 1D

30 131 EFFEKTIVES Incorrect terminology:
PROJECT PROJEKTMANAGEMENT  streamline (eine
MANAGEMENT Stromlinienform geben),

STREAMLINE
(OPTIMIEREN),
Streamline
(Optimierung).

12 1-12-1 |VENDOR- ANBIETERNEUTRALE  Incorrect terminology:
NEUTRAL PLATTFORM VENDOR (ANBIETER).
PLATFORM

15 1-15-1 |Streamline]  |Optimierung| des Incorrect terminology:
your Uberselzungsprozesses| translation process
|translation durch Automatisierung = (Ubersetzungsprozess).
procesﬂ manueller Aufgaben
through

automation of
manual tasks.

21 2-6-1 Track all Unternehmensweit alle  Incorrect terminology:
projects in Projekte in Echtzeit ENTERPRISE
real time nachverfolgen und nie  (BERICHTERSTELLUNG).

5. (Optional) Click a highlighted term.

6. (Optional) On the Ignore Terminology Transcheck Error dialog, compare the source string with the target
equivalents.

7. (Optional) Select either When term is for source terms in the glossary or When target contains for target
terms.



Ignore Terminology Transcheck Error X

Source string: =irea w
I >
®  Whentermis streamline(eine Stromlinienform
[StraamlinalOntimierunnl
When Target
O Contains:
lgnore Ignore All (3) Mext

8. (Optional) Either click Ignore to disregard the single instance of a string or Ignore All to disregard every
instance of a string.

@ The number following Ignore All contains the total number of instances within that file.

Ignore Terminology Transcheck Error x

Source string:

C o menem s ansiton process

When Target Ubersetzungsprozess
® Contains:

Ignore All {3) Previous Next

9. (Optional) Review the terms in the Ignored Terminology Errors section of the Transcheck report.
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Ignored Terminology Errors
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3 1-3-1 STREAMLINE | EFFEKTIVES Incorrect terminology:
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10. (Optional) After closing the Transcheck report, select any remaining segments with a @ in the Status column.
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11. (Optional) Click the Transcheck tab to examine the details of the segment error.

@ The total number of errors in the segment is the number in parentheses on the Transcheck tab.

TM Lookup Notes Segment History Metadata Transch

Previous error MNext error Refresh Ignore warning

# Warning Explanation

1 | Tag Check Source contains
formatting missing in
the target.

2 | Unedited Fuzzy Target contains a

Check fuzzy match that has

not been modified.

3 | Untranslated Text | Source text is not

Check translated in the

target.

eck (3)

Cause

Source contains "1, 2,
3" which is missing in

target.

Target contains a 98%

match that has not
been modified.

"in" should be
translated in target.

12. (Optional) Click Next error or Previous error on the Transcheck tab to view the next or prior segment error.

13. Choose one of the following actions:

e Correct the error and click Refresh to complete the correction.

e Click Ilgnore warning to continue reviewing error warnings without making any changes.



If you correct the error, the @ is removed from the Status column.

If you do not correct the error, the @ remains in the Status column.

Leverage Auto-Propagation

The purpose of auto-propagation is to leverage repetitive segments and re-use content. Configure and enable
your auto-propagation preferences under Preferences > General Preferences > Auto-Propagation.

To leverage repetitive content:

1. Select a segment for translation in the TXLF Editor. In this example, a filtered search locates and identifies
duplicate segments.
S
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2. Enter the translation for the first target segment.

3. To commit terms, click Commit, or click Next Segment, then press Alt+Down.



Once you commit the target segment, this updates the TM and automatically propagates the update to target
segments throughout the file, based on segment preferences.
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Source or Target « Match Case Regex |Enter fexi fo filter segments | Filter: | Duplicale segmenis ~ ,DG > Sort: |Doc

(0] English -> German Score Status
THOUSANDS OF ORGANIZATIONS TRUST GLOBALLINK TO [STREAMLINE

CONTENT MANAGEMENT

24
TAUSENDE| VON ORGANISATIONEN VERTRAUEN BEIM OPTIMIEREN IHRES | 1 ©

GLOBALEN CONTENT MANAGEMENTS AUF GLOBALLINK|
THOUSANDS OF ORGANIZATIONS TRUST GLOBALLINK TO STREAMLINE

CONTENT MANAGEMENT

>4 TAUSENDE YON ORGANISATIONEN VERTRAUEN BEIM OPTIMIEREN IHRES 90

GLOBALEN CONTENT MANAGEMENTS AUF GLOBALLINK
THOUSANDS OF ORGANIZATIONS TRUST GLOBALLINK TO STREAMLINE

CONTENT MANAGEMENT

a7
TAUSENDE VON ORGANISATIONEN VERTRAUEN BEIM OPTIMIEREN IHRES 9

GLOBALEN CONTENT MANAGEMENTS AUF GLOBALLINK

Leverage Auto-Suggestion

You can use autosuggestion to propose target content based on specific source content, such as numbers, URLs,
and proper names. You can also use it to propose terms for the glossary, translation memory (TM) matches, and
sub-segment TM matches. Configure and enable your autosuggestion preferences under Preferences > General
Preferences > Auto-Suggestion.

Monitor Maximum Segment Length

Based on Project Director (PD) settings, your files may have a set maximum segment length. Any violation of
a segment that exceeds the maximum characters allowed results in a change to the segment Max value in the
progress bar from black to red. In the example, the target segment has 57 characters, when there is a limit of 56.

Segments: 213 | Segment (Src/Tgt/Max): 14/57/56 | Paragraph (Src/Tgt/Max): 14/57/- _

Users can monitor the progress bar for maximum segment length violations, and can also configure the
Transcheck Report to flag such violations. Refer to Configure Transcheck.

Use Live Preview

You can view the translated content in its original format for MS Word DOC and DOCX files or MS PowerPoint
PPT and PPTX files.

Use the default Live Preview to generate a dynamic preview of the translated file in TXLF Editor.
To generate a live preview:

1. Open a file in TXLF Editor.



2. On the File tab, select Live Preview from the Preview drop-down menu.

@ Only one preview option is possible at a time.
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3. (Optional) Interact with the live preview of the file.

For MS Word files
The preview pane docks to the right. Click E for
docking options. Live Preview highlights the active

segment. Move to any other segment by clicking on /
that area of the live preview. ( ; I a I L I n k

Project Director

@
f \ Taak
e0® @
o’ N

EFFEKTIVES INTEGRATION MIT
PROJEKTMANAGEMENT JEDEM SYSTEM

Mit GlobalLink Project Director sparen
4 3
For MS PowerPoint files ¥ Whole document loading  Loaded pages 33 4 Page: 3r+
PowerPoint files can be graphically intensive and so
may take time to load. The progress bar provides
real-time loading status. Click x to cancel the Live
Preview.

¢ Docking — The preview pane docks to the
right. Click E1 for docking options. Live Preview
highlights the active segment. Move to any
other segment by clicking that area of the live
preview.

e Slide Access — Click the forward or back
arrow to progress through the slide deck or
type the deck slide number in the Page field.

To return to the first slide in the deck, click E3.

4. Enter the translation or leverage the TM for any segment, then click Next Segment on the Translation tab or
press Alt-Down.

The new translation is displayed. To collapse or expand the live preview pane, click E or &.



5. (Optional) Click Synchronize Live Preview on the File tab to refresh the pane.

Use PDF or HTML Preview

You can view the translated content in its original format, if it is an MS Office or HTML source format, using the
Preview action in the TXLF Editor.

To preview files as a PDF or in HTML output:
1. Select a file with translated content on the File tab.

2. Select Office Preview or Html Preview from the Preview drop-down menu.

@ Only one preview option is possible at a time.
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The preview of the translated content is displayed.

Save a File

As you work on a file, frequently save your changes to a local folder .
To save your work:
1. Click the File tab, if you are not already on it.

2. In TXLF Editor, click either Save or a Save Options action.
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Save File As Translated Select to save the active file to a local folder.
Save Select to save the active file to a local folder with the existing file name.

Save As Select to save the active file to a local folder under a different name.

A progress bar is displayed. After successful completion, the file is updated in a local folder.



/. Leverage Project TMs

A translation memory (TM) provides maximum content re-use and facilitates collaboration among localization
resources. Users can leverage reusable content using one of two different types of TMs.

Consider using a free, hosted service: WordFast Anywhere (WFA). WFA allows translators to connect

to a shared server and interact with a private, remote TM and glossary.

Local TM Located on your local computer system and only you can access it.

Remote TM Located on a server that other translators can access. This allows multiple

translators to leverage the available content and update the TM with new reusable
content.

@ You can remove a TM from a project so it is no longer in the project TM list. When you remove a local

TM from a project, it remains in the TM folder on your computer system. To add a removed local TM
back to the project, use the Add Local action on the Project TM tab. To add a removed remote TM
to the project, use the Connect to Remote action on the Project TM tab.

Create a Local TM

Create a local translation memory (TM) when you are sure you do not want collaboration with other users. If
you are not sure, connect to a free, hosted service: Wordfast Anywhere (WFA). Refer to Connect To a Remote

Glossary.

To create a local TM:

1.
2.

On the Projects tab, double-click a project from the projects list to open it.

On the Project TM tab, click Create Local.
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On the Translation Memory dialog, enter the required TM configuration.

@ Required fields are marked with a red asterisk.



Translation Memory

W Create Translation Memory

Name:™* |

Target Language:* German -

Location:™ Browse...

Priority:* Secondary -

| Selected

Read-only
oK Cancel

Field Action
Name Enter a unique TM name that includes the client or organization name and the

TM's language for easy identification.

Target Language

Select target languages. Target languages are limited to those languages
configured in the project.

Location Select the destination where the application saves the new TM.
Priority Set the sequence in which the application uses the TM during translation, using
the Primary TM first, followed by any Secondary TMs.
Note: You can only select one TM as primary.
Selected (Optional) Select to use the current TM for the project.
Read-Only (Optional) Select to leverage the TM without updating it with the new translation.
4. Click OK.

The new TM is created and is displayed in the Project TM list.

Add a Local TM to a Project

You can add a local TM to your project at the time of creation or as a separate action.

You can add TMs created by Wordfast Pro 4 or 5 only. If you want to add TMs from Wordfast Classic
or Wordfast Pro 3, use the Import TM option.

To add a local TM to a project:

1. On the Projects tab, double-click a project from the projects list.

2. Click the Project TM tab, and then click Add Local.
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3. On the Opening TM dialog, browse to the local TM folder and select it.
4. Click Select Folder.

The selected TM is added to the project and displayed in the Project TM list.

Add Project TMs

Some projects may use multiple local and remote translation memories (TMs). In such instances, it is more
efficient to add all of the TMs for the project with a single Add Project TMs action.

To add project TMs:
1. On the Projects tab, double-click a project from the projects list.

2. On the Project TM tab, click Add Project TMs.
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3. On the Add Project TMs dialog, enter the project TM information.

W Select a Project containing TMs you would like to
add

Select a Project.” Adaptive Transcheck1 -
Source Language: | English

Target Language(s): | Garman {Gemany)

List of ThMs: German_DE, Adaptive Transcheck-German
OK Cancel
Field Action
Select a Project Select a project name from the drop-down list.

Source Language Leave the auto-populated source language.




Field Action

Target Language(s) Leave the auto-populated target languages.
List of TMs Review the list of TMs associated with that project.
4. Click OK.

The selected project TMs are added to the project and are displayed in the Project TM list.

Connect to a Remote TM

You can connect to one or more translation memories (TMs) that reside on other computers, including a free,
hosted service: Wordfast Anywhere (WFA).

@ Wordfast Anywhere allows translators to connect to a shared server and interact with a private,
remote TM and glossary.

To connect to a remote TM:

1. On the Projects tab, double-click a project from the projects list to open it.

2. On the Project TM tab, click Connect To Remote.
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3. On the Connect to Remote TM dialog, select the appropriate tab, based on your server options.

e TM Server
o WF Server
o WFA Server

4. (Optional) Add a TM Server on the TM Server tab, complete the required fields, and then click OK.

Required fields are marked with a red asterisk.



W Uss this page to connect to remote Th.

TM Server WF Server

WFA Server

Symbolic Name:”

URL Estting=

URL"

Address”

Part:

TMS Falder:”
Cluster Short Code:"
TM Short Code:”
User:”

Password:"

Workgroup 1D:

TM Update Ssttings

TM Cleanug Passcode:

Priority:
| Selscted

Read-only

Field or Option

example: im:/addressport TMS *im=LE{ Test

Primary -

0K Cancel

Action

Symbolic Name

Enter a unique name for the TM.

URL

Enter the remote TM URL using the following format: t m / / addr ess: port/
TMS?. The remaining URL Settings automatically populate when you enter the
URL string. Click Test to validate the connection.

TM Cleanup Passcode

Enter the password to update the TM for the project.

Priority Select a priority from the drop-down list.
The priority determines the sequence of reference during translation, first
referencing the primary TM, then any secondary TMs. You can only designate
one TM as primary.

Selected (Optional) Select to use the current TM for the project.

Read Only (Optional) Select to leverage the TM without updating it with the new translation.

5. (Optional) Add a WF Server on the WF Server tab, complete the required fields, and then click OK.

Required fields are marked with a red asterisk.



W Use this pags to connect to remote Th.

TM Server W Server WFA Server

Symbolic Name:™

URL Esttings

UAL:" example: wiljemith:password@address Test
Address”

Part:"

UserMame:”

Password:

Workgroup 1D:

PM and TM admin

Use TM Write Password

Priority: Primary -
| Selected
Read-only
0K Cancel
Field or Option Action
Symbolic Name Enter a unique name for the TM.
URL Enter the remote TM URL using the following format: wf : / /

j smith. passwor d@ddr ess: port/ TM5?. The remaining URL Settings
automatically populate when you enter the URL string.

(Optional) The Password and Workgroup ID fields depend on server settings.
Click Test to validate the connection.

Priority Select a priority from the drop-down list.
The priority determines the sequence of reference during translation, first
referencing the primary TM, then any secondary TMs. You can only designate
one TM as primary.

Selected (Optional) Select to use the current TM for the project.

Use TM Write Password (Optional) Require a password to clean up target content and update the TM.
Include the password in the TM Write Password field after selecting this option.
If a password is not set in the WF Server, then select the checkbox, but leave the
field empty.

Read Only (Optional) Select to leverage the TM without updating it with the new translation.




6. (Optional) Add a WFA Server on the WFA Server tab, complete the required fields, and then click OK.

W Use this pags to connect to remote Th.

TM Server WF Server WFA Server

Symbolic Name:™ WordFast Anywhere Adaptive Test

APl key:~ Test
Priority: Primary -
W Selected

Read-only
0K Cancel

Field or Option Action
Symbolic Name Enter a unique name for the TM.
API Key Enter the API key you obtain from WFA.

1. Log in to your free WFA accountatht t ps: // wwv. freet m com

2. Click on TMs & Glossaries, then Setup.

3. On the TMs and glossaries management dialog, select a TM or
Glossary.

4. Click Manage Sharing.

5. On the TMs and glossaries shares dialog, click on the API key and copy
the text string.

6. Paste the API key into the Connect to Remote TM dialog using the
following format: user nane@234567, and then click Test to validate the
connection.

Priority Select a priority from the drop-down list.
The priority determines the sequence of reference during translation, first
referencing the primary TM, then any secondary TMs. You can only designate
one TM as primary.

Selected (Optional) Select to use the current TM for the project.

Read Only (Optional) Select to leverage the TM without updating it with the new translation.

The new TM is added to the project and is displayed in the project TM list.

Open and Edit a Local TM

You can open and edit local translation memory (TM) entries at any time after TM creation.



A You cannot open a remote TM in TM Editor.

To open and edit a local TM:
1. On the Projects tab, double-click a project from the projects list to open it.

2. On the Project TM tab, select a translation memory and click Open TM.
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3. On the TM Editor tab, view the translation units (TUs) for both source and target languages.
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4. (Optional) To search for source or target translation units (TUs), enter your search criteria in the appropriate
fields in the Filters sidebar, and then click Find.



You can make your filtered search case-sensitive or specify an exact match, then filter further by

creator, user, and modification date.

5. (Optional) To reset your search criteria, click Clear.

6. (Optional) Use the Edit Options actions, such as Cut, Copy, and Paste to edit a TM entry.

Modify a TM

To rename, write-protect, or change the priority of a TM, use the Modify TM action.
To modify a local or remote TM:

1. On the Projects tab, double-click a project from the projects list to open it.

2. Selecta TM.

3. On the Project TM tab, click Modify TM.
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4. On the Translation Memory dialog, modify the TM details as required.

@ Required fields are marked with a red asterisk.

Translation Memory x
W Modify TM

Name:™* Doc_TM1

Browse...
Priority:* Secondary -
| Selected
Read-only
oK Cancel

@ If you modify the Name field, it will only make the TM name change within the Wordfast Pro
application, not on your local disk.



@ You can only select one primary TM for a project.

5. (Optional) Select the TM identified in the Name field for the current project using Selected.

6. (Optional) Select Read-only to allow users to leverage the TM but not update it with new translation.

7. Click OK.

Your modifications to the TM are saved.

Copy a Local TM

Copy a TM to use an existing TM for a new project.

@ The copied TM is in the Wordfast Pro TM format, regardless of the original TM format.

To copy a local translation memory:

1.
2.

On the Projects tab, double-click a project from the projects list to open it.

On the Project TM tab, select a translation memory and click Copy TM.
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. On the Copy Translation Memory dialog, enter the TM Name.

@ Required fields are marked with a red asterisk.

= Create a copy of the selected translation memory. Please enter a name for
the copy, location, and decide if you want to flip the TM languages.

Source TM: Doc_TM1

Mame:* |

Location:* Browse...
Flip Languages

Copy Cancel

Browse and select the Location on your disk for the TM copy.

. (Optional) Select Flip Languages, to reverse the source and target languages, and then click Copy.

A copy of the translation memory is saved in the selected folder location.



Import a Local TM

To use a local translation memory (TM) from another linguist, use the Import TM action.
To import a local TM:
1. On the Projects tab, double-click a project from the projects list to open it.

2. Click Import TM on the Project TM tab.
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3. On the Import Translation Memory dialog, select the import File Type from the drop-down list.

@ Required fields are marked with a red asterisk.

W Import Translation Memory

File Type" TMX -

Import File:™ C\Users\Deskiop\de-DE TM\TranscheckDE tmx Browse...
Create Mew TM

#) Import Into Existing TM

Existing Th:" -

If TU already exisis” Add as a new TU -

Delete all TUs from existing T

0K Cancel

Field Action

File Type e WF Classic TM—File format provides backward compatibility for Wordfast

Classic and Wordfast Pro 3.

e TMX—Translation Memory eXchange file format provides compatibility

with all translation tools.

Import File Identifies the file for import.

Create New TM Imports the TM into a new TM file.

Import into Existing TM Imports the TM into an available TM file, based on selection from the drop-down

list.




Field Action

Existing TM Selects an available TM file, based on selection from the drop-down list.
If TU already exists Imports the TM into an available TM file, based on selection from the drop-down
list.
Delete all TUs from Deletes the existing TM and replaces it with the new TM.
existing TM
4. Click OK.

The translation memory is imported and is displayed in the Project TM list.

Export a Local TM

To share a local translation memory (TM) with another linguist, use the Export TM action.
To export a local TM:

1. On the Projects tab, double-click a project from the projects list to open it.

2. Select a TM assigned to that project.

3. Click Export TM on the Project TM tab.
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4. On the Export Translation Memory dialog, choose a location and export type for the TM export file.

@ Required fields are marked with a red asterisk.

Export Translation Memory x
- Specify existing Translation Memory for export, and
choose a location and export type for the TM
Translation EN_DE-de -
Memory:®
Export Type:" ThiX v
File: Location:* Browse...
oK Cancel
Translation Memory Select a TM from the drop-down list.
Export Type Select the export file type from the drop-down list.

File Location Browse and select the folder location for the export.



5. Click OK.

The selected translation memory exports to the selected folder location.



8. Leverage Project Terminology Lists

Terminology is a phrase used to identify two distinct groupings: the glossary and the blacklist.

¢ Glossary—A database of preferred source terms, words, and phrases paired with their target equivalents
designated as preferred and client-specific
¢ Blacklist—A database of rejected target terms prohibited from use in the translation

Leverage Project Glossaries

A glossary includes source terms and a correlated list of preferred target terms.

LEVERAGE PROJECT GLOSSARIES
Create a Local Glossary

To create a local glossary:
1. On the Projects tab, double-click a project from the projects list.

2. On the Project Terminology tab, click Create Local.

R T T st Ul Project Terminology

Terminology
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Create Add Connect Open Impaort Export Add Project

Local Local To Remote Glossary Glossary Glossary Glossanies

3. On the Create Glossary dialog, enter the glossary information.

W Create/Modify Glossary

Mame:* | |

Target Language:* |German - |

Location:* | Browse...

| Selected
Read-only

oK Cancel

@ Required fields are marked with a red asterisk.

Field Action

Name Enter a unique name for the glossary.

Source Language The source language auto-populates.




Field Action

Target Language Select a language from the drop-down list. The target languages for your project
are those available in the drop-down list.

Location Enter the file location for the new glossary.

Selected (Optional) Select to use the current local glossary for the project.

Read Only (Optional) Select to leverage the glossary without updating it with new terms.
4. Click OK.

The new glossary is displayed in the project glossary.

LEVERAGE PROJECT GLOSSARIES

Add a Local Glossary

You can only add glossaries created by Wordfast Pro 4 or 5. For glossaries from Wordfast Classic or Wordfast
Pro 3, use the Import Glossary action. Refer to Import a Local Glossary.

To add a local glossary:
1. On the Projects tab, double-click a project from the projects list.

2. On the Project Terminology tab, click Add Local.
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3. On the Creating Glossary finder, browse to a glossary folder and select it.
4. Click Select Folder.

The selected glossary is added to the project and is displayed in the project Glossaries list.

LEVERAGE PROJECT GLOSSARIES

Add Project Glossaries

Some projects may use multiple local and remote glossaries. In such instances, you can add all of the glossaries
from a previous project with a single Add Project Glossaries action.

To add project glossaries:
1. On the Projects tab, double-click a project from the projects list to open it.
2. On the Project Terminology tab, click Add Project Glossaries.
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3. On the Add Project Glossaries dialog, enter the project glossaries information.

- Select a Project containing Glossaries you would
like to add

Select a Project:* AdaptiveTranscheck1 b
Source Language: | English

Target Language(s): German (Gemany)

List of Glossaries: de-DE-TechDoc

OK Cancel
Field Action
Select a Project Select a project name from the drop-down list.
Source Language Leave the auto-populated source language, based on the project.
Target Language(s) Leave the auto-populated target languages, based on the project.
List of Glossaries Review the list of glossaries associated with that project.

4. Click OK.

The selected project glossaries are added to the project and displayed in the project Glossaries list.

LEVERAGE PROJECT GLOSSARIES

Connect To a Remote Glossary

You can connect to a glossary residing on another server, including a free hosted service: Wordfast Anywhere
(WFA).

Wordfast Anywhere allows translators to connect to a shared server and interact with a private,
remote translation memory (TM) and glossary.

To connect to a remote glossary:

1. On the Projects tab, double-click a project from the projects list.

2. On the Project Terminology tab, click Connect To Remote.
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3. On the Connect to Remote Glossary dialog, select the appropriate tab, based on your server options.

4. (Optional) Add a Term Manager (TMGR) Server on the TMGR Server tab, complete the required fields, then
click OK.

@ Required fields are marked with a red asterisk.

TMGR Server WF Server WFA Server

Mame:"

Target Language:” German (Germany) -
URL Settings
URL:" example: imgr/faddress:portimgr? Test
Address”
Username:”
Password:”

Project Short

example: ABCO000001, ABCO000002
Code”

| Selected
Read-only

] Create Blacklist Connection

OK Cancel
Field or Option Action
Name Enter a unique name for the glossary.
Target Language Select a language from the drop-down list. This list is constrained by the available

target languages for your project.

URL Enter the remote glossary URL using the following format: t ngr: //
addr ess: port/ TMGR?.

Note: The remaining URL Settings automatically populate when you enter the
URL string. This includes the username, password, and project short code.
Click Test to validate the connection.

Selected (Optional) Select to use the current glossary for the project.
Read Only (Optional) Select to leverage the glossary without updating new terms.
Create Blacklist (Optional) Select to connect to an available blacklist already in TMGR.

Connection




5. (Optional) Add a WF Server on the WF Server tab by completing the required fields, then click OK.

Required fields are marked with a red asterisk.
W Connect To Remote Glossary

TMGR Server WF Server

Mame:"

Target Language:~
URL Esttings
URL:"

Address”
Port:"
Username:”
Password:”

Waorkgroup 1D:

| Selected

Field or Option

WFA Server
German (Gemany) -
example: wi/jsmith:passwordi@ady Test
OK Cancel
Action

Name

Enter a unique name for the glossary.

Target Language

Select a language from the drop-down list. This list is constrained by the available
target languages for your project.

URL Enter the remote glossary URL using the following format: wf : / /
j smith: passwor d@ddr ess: port/tnmgr?. The remaining URL Settings
automatically populate when you enter the URL string. Click Test to validate the
connection.

Address Enter the address associated with the URL.

Port Enter the port associated with the URL.

Username Enter the username associated with the URL log in.

Password (Optional) Enter the password associated with the username.

Workgroup ID

(Optional) Enter the workgroup ID for the project.

Selected

(Optional) Select to use the current glossary for the project.

Read Only

(Optional) Select to leverage the glossary without updating new terms.

6. (Optional) Add a WFA Server on the WFA Server tab by completing the required fields, then click OK.



TMGR Server WF Server WFA Server

Mame:" WordFast Anywhere Adaplive Test

Target Language:~ German (Germany) -

APl KEY:" usernamei@1234567 Test

Selected
] Read-anly
OK Cancel

Field or Option Action
Name Enter a unique name for the glossary.
Target Language Select a language from the drop-down list.

Note: This list is constrained by the available target languages for your project.

API Key Enter the API key you obtain from WFA.
1. Log in to your free WFA account atht t ps: // www. freet m com
2. Click on TMs & Glossaries, then Setup.
3. Onthe TMs and glossaries management dialog, select a glossary.
4. Click Manage Sharing.
5. On the TMs and glossaries shares dialog, click on the API key and copy

the text string.

6. Paste the API key into the Connect to Remote Glossary dialog on the
WFA Server tab using the following format: user nane@234567, then
click Test to validate the connection.

Selected (Optional) Select to use the current glossary for the project.

Read Only (Optional) Select to leverage the glossary without updating new terms.

The selected glossary is added to the project and displayed in the project Glossaries list.

LEVERAGE PROJECT GLOSSARIES

Open and Edit a Local Glossary

You can open and edit local glossary entries at any time after glossary creation.

A You cannot open a remote glossary in Wordfast Pro.



To open and edit a local glossary:

1.
2.

On the Projects tab, double-click a project from the projects list to open it.
On the Project Terminology tab, select a local glossary, and click Open Glossary.

R - T T S ees L ]  Project Terminology

Terminology
ol R O E E B -
Create Add Connect Open Import Export Add Project

Local Local ToRemote  Glossary  Glossary  Glossary Glossanes

In the Glossary Editor, view the terms for both source and target languages. You can also filter, add, remove,
and update terms.

(] Wordfast Pro - O *
BT Y Glossary Editor

MNavigation Edit Options Term Opfions Terminology Opfions Opfions
oo % D @ B B EH
MNext Previous Cut Copy Paste Add Term Remove Import Export Preferences
Update Update Term Glossary Glossary
_ o] Source Target Description Creation User ‘Creation Date Medification U... | Modi
S Network Netzwerks Laks 2017/03/2  Laks ‘m
Source and target - 1 Systems ysteme 311:21:26 3
EDT I
Term Text:
Enter Term Text PERSON  PERSON Laks 2017/03/2  Laks :
5 AL AL 3 11:21:27 :
FIREWAL FIREWAL EDT I
Ls Ls
Access Netzwerkz Laks 2017/03/2  Laks :
3 Protection  ugangssc 311:21:27 3
hutz EDT I
TECHNIC TECHNIS Laks 2017/03/2  Laks :
4 AL CHER 3 11:21:27 :
SUPPOR  SUPPOR EDT I
T T
TURNKE  FERTIGL Laks 2017/03/2  Laks :
5 Y OSUNG 3 11:21:27 3
SOLUTIO EDT I
NS
O Find ¥ Clear . > =

. (Optional) To search for source or target terms, enter your search criteria in the appropriate fields in the Filters

sidebar, and then click Find.

@ You can make your filtered search case-sensitive or specify an exact match, then filter further by
creator, user, and modification date.

. (Optional) To reset your search criteria, click Clear.

. (Optional) Use the Edit Options actions, such as Cut, Copy, and Paste within the source and target columns.



LEVERAGE PROJECT GLOSSARIES

Import a Local Glossary

To exchange glossaries with other translators, save the exported glossary to a local drive, then use the Import
Glossary action to import it to your project.

@ To exchange glossaries among projects on your local drive, use the Add Project Glossaries action.

To import a local glossary:
1. On the Projects tab, double-click a project from the projects list.
2. Click Import Glossary on the Project Terminology tab.

R - T St L]  Project Terminology
Terminology
B B K E 40 B &8
Create Add Connect Cipen Import Export Add Project
Local Local To Remote Glossary Glossary Glossary Glossarnies

3. On the Import Glossary dialog, select the import File Type from the drop-down list.

Required fields are marked with a red asterisk.

Import Glossary X
W Import Glossary

File Type:" |TBX -

Import File:™ |G:xUsers"lzieIsdorﬂDncumerﬂs‘l.Snume\.de-DE Term\de-DE_TechDo| Browse...

| | Create a new glossary

(®) Import into existing glossary

Existing Glossary:™ | - |

If the term already exists:™ |Add as new term - |

|:| Delete all terms from existing glossary

OK Cancel




Field Action

File Type Select a file format for importing raw text files.

e Term Base eXchange (TBX) — Use with other CAT tool glossaries

e Tab delimited text file (TXT) — Use with Wordfast Classic and Wordfast
Pro glossaries

Import File Click Browse to locate and select an Import File.

Create a new glossary  Click to use the imported glossary to create a new glossary rather than add terms
to an existing glossary.

Import into existing Click to use the imported glossary to add to the selected glossary.

glossary

Existing Glossary Select from the drop-down list to append the imported glossary to an existing
glossary file.

If term already exists Select from the drop-down list to import the term into an existing glossary file.

e Add as a new term — Add the term to the existing glossary file.

e Do not overwrite — Ignore the term and retain the term already in the
glossary file.

e Overwrite existing term — Use the new term to replace the term already
in the glossary file.

Delete all terms from Select to delete the existing term and replace it with the new glossary term.
existing glossary

4. Click OK.

The glossary is imported and is displayed in the project Glossaries list.

LEVERAGE PROJECT GLOSSARIES

Export a Local Glossary

To exchange glossaries with other translators, use the Export Glossary action and save it to a local drive, then
send it to another translator to import to their project.

@ To exchange glossaries among projects on your local drive, use the Add Project Glossaries action.

To export a local glossary:

1. On the Projects tab, double-click a project from the projects list.

2. On the Project Terminology tab, select a glossary and click Export Glossary.
R I AL ]} Project Terminology

Moo OB R B I

Create Add Connect Open Import Export Add Project
Local Local To Remiote Glossary Glossary Glossary Glossarnies



3.

4.

5.
6.

On the Export Glossary dialog, select a glossary from the drop-down list.

W Export Glossary

Glossary* Doc_Termi -

Export Type:® TBX -

File:* Browse...
OK Cancel

Select the file Export Type from the drop-down list.

e Term Base eXchange (TBX) — Use with other CAT tool glossaries
¢ Tab delimited text file (TXT) — Use with Wordfast Classic and Wordfast Pro 3 glossaries

Click Browse to locate and select the export file location, then click Save.
Click OK.

The glossary is exported to the specified file location.

Leverage Project Blacklists

You can use a blacklist to exclude words or phrases from use in the target segment.

LEVERAGE PROJECT BLACKLISTS
Create a Local Blacklist

You can create a blacklist for your project on your local computer.

To create a local blacklist:

1.
2.

On the Projects tab, double-click a project from the projects list.

On the Project Terminology tab, click Create Local in the Blacklist group.

I Project Terminology Reporis Reference Files Help A X

Blacklist
?l = =
0 B &€ @ @ € & & =
»ort Export Add Project Create Add Connect Open Import Export
sary  Glossary Glossaries Local Local  ToRemote  Blacklist  Blacklist  Blacklist

. On the Create Blacklist dialog, enter the required blacklist information.

@ Required fields are marked with a red asterisk.



Create Blacklist x

W Create a New Blacklist

Name:* |
Language:* German -
Location:* Browse...
] Selected
Fead-only
oK Cancel
Field Action
Name Enter a unique blacklist name that includes the client or organization name and the
blacklist target language for easy identification.
Select the blacklist's target language, which is limited to languages configured in
Language .
the project.
Location Select the destination for the new blacklist.
Selected (Optional) Select to use the current blacklist for the project.
Read-Only (Optional) Select to leverage the blacklist without updating it with the new
translation.
4. Click OK.

The new blacklist is created and is displayed in the project terminology list.

LEVERAGE PROJECT BLACKLISTS

Add a Local Blacklist

Use a local blacklist already created on your computer when you want to leverage a translation blacklist, but do
not want to collaborate with other users. You can add a local blacklist to your project at the time of creation or as a
separate action.

To add a local blacklist:
1. On the Projects tab, double-click a project from the projects list to open it.

2. On the Project Terminology tab, click Add Local in the Blacklist group.

I Project Terminology Reports Reference Files Help A X

Blacklist
1 n Ol e e & & & @ -
ort Export Add Project Create Add Connact Open Import Export

sany Glossary Glossaries Local Local To Remote Blacklist Blacklist Blacklist

3. On the Creating Blacklist finder, browse to a blacklist file and select it.

4. Click Select Folder.



The selected blacklist is added to the project and is displayed in the project terminology list.

LEVERAGE PROJECT BLACKLISTS

Connect to a Remote Blacklist

You can connect to one or more blacklists that reside on other computers.
To connect to a remote blacklist:

1. On the Projects tab, double-click a project from the projects list.

2. On the Project Terminology tab, click Connect To Remote.

| PrtectTerminctogy
Blacklist

7 0 B & & « €& & & =

»ort Expoit Add Project Create Add Connect Opan Imiport Export

sary Gilossary Glossarnies Local Local To Remote Blackhst Blacklist Blacklist

3. On the Connect to Remote Blacklist dialog, enter the required information, based on your server options.

@ Required fields are marked with a red asterisk.

W Connect to Remote Blacklist

Mame:* |

Target Language:™ German -
URL Settings
URL:* example: tmgr://address port/imgr ?project= Test
Address:*
Username:*
Password:*

Project Short Code:* | example: ABC

| Selected
OK Cancel
Field or Option Action
Name Enter a unique name for the blacklist.
Target Language Select a target language from the drop-down list.
URL Enter the remote TMGR URL using the following format: t ngr: //

addr ess: port/ TMS?. The remaining URL Settings automatically populate
when you enter the URL string. Click Test to validate the connection.




Field or Option Action

Address Enter the remote address.

Username Enter the username associated with the URL log in.

Password Enter the password associated with the username.

Project Short Code Enter the short code for the project, such as ABCO000001.

Selected (Optional) Select to use the current blacklist for the project.
4. Click OK.

The new remote blacklist is displayed in the project terminology list.

LEVERAGE PROJECT BLACKLISTS

Open and Edit a Local Blacklist

You can open and edit local blacklist entries at any time after blacklist creation.
A You cannot open a remote blacklist in Wordfast Pro.

To open and edit a local blacklist:
1. On the Projects tab, double-click a project from the projects list to open it.

2. On the Project Terminology tab, select a local blacklist, and click Open Blacklist.

I Project Terminology Reports Reference Files -] A X

Blacklist
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3. On the Blacklist Editor tab, view the blacklist terms for both source and target languages. You can also filter,
add, remove, and update terms.

El Wordfast Pro
MNavigation Edit Optlc-ns Term Options Blacklist Options Opticns
il - 7 ;
o C X% D@D E% & @ E
Next Previous Cut Copy Paste Remaove Import Export Preferences
Update Update Blacklist Blacklist
1 Please click Click
Search:
Forbidden - 2 Organisation Organization
Term Text: . B
3 Waming popup Waming message
2 Find ¥ Clear




4. (Optional) To search for source or target blacklist terms, enter your search criteria in the appropriate fields in
the Filters sidebar, and then click Find.

You can make your filtered search case-sensitive or specify an exact match, then filter further by
creator, user, and modification date.

5. (Optional) To reset your search criteria, click Clear.
6. (Optional) Use the Edit Options actions, such as Cut, Copy, and Paste to edit entries within the forbidden

and suggested term columns.

LEVERAGE PROJECT BLACKLISTS

Import a Local Blacklist

To use a local blacklist from another source, use the Import Blacklist action.
To import a local blacklist:

1. On the Projects tab, double-click a project from the projects list.

2. Click Import Blacklist on the Project Terminology tab.

= Wordfast Pro ~ Project Files Project TM Project Terminology Reports Reference Files Help

Terminclogy Blacklist
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3. On the Import Blacklist dialog, select the import File Type from the drop-down list.

Required fields are marked with a red asterisk.

Import Blacklist x
W Import Blacklist
File Type:® Tk -
Impaort Fila:™ ChUsersizielsdorfiDocuments\Source\de-DE Term\de-DE_Te Browse...

*) Create a new blacklist

oK Cancel

Field Action

File Type Select TXT as the file format for importing raw text files.




4.

Field Action

Import File Click Browse to locate and select an Import File.

Create a new blacklist Click to use the imported blacklist to create a new blacklist, rather than add terms
to an existing blacklist.

Import into existing Click to use the imported blacklist to add to the selected blacklist.

blacklist

Existing Blacklist Select from the drop-down list to append the imported blacklist to an existing
blacklist file.

If term already exists Select from the drop-down list to import the term into an existing blacklist file.

e Add as a new term — Add the term to the existing blacklist file.

¢ Do not overwrite — Ignore the term and retain the term already in the
blacklist file.

e Overwrite existing term — Use the new term to replace the term already
in the blacklist file.

Delete all terms from Select to delete the existing term and replace it with the new blacklist term.
existing Blacklist

Click OK.

The blacklist is imported and displayed in the project Blacklist.

LEVERAGE PROJECT BLACKLISTS
Export a Local Blacklist

To share a local blacklist with another linguist, use the Export Blacklist action.

To export a local blacklist:

1.
2.

On the Projects tab, double-click a project from the projects list.

Select a blacklist from the project Blacklist on the Project Terminology tab.

. Click Export Blacklist on the Project Terminology tab.

I Project Terminology Reporis Reference Files Help A~ X
Blacklist
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. On the Export Blacklist dialog, choose a blacklist name, export type, and folder location for the blacklist

export file.

@ Required fields are marked with a red asterisk.



Export Blacklist x

W Export a blacklist

Blackhst:" Blacklrst -

Export Type:* Txi -

File Locaton:" Browse...

oK Cancel

Blacklist Select a blacklist from the drop-down list.

Export Type Select the export file type from the drop-down list.

File Location Browse and select the folder location for the export file.
5. Click OK.

The selected blacklist exports to the selected folder location.

Use Project Terminology Options

You can use the Options group of the Project Terminology tab to modify and remove glossaries and blacklists.

USE PROJECT TERMINOLOGY OPTIONS

Modify a Glossary or Blacklist

To modify a glossary or blacklist:

1.
2.
3.

On the Projects tab, double-click a project from the projects list.

On the Project Terminology tab, click a glossary or blacklist.

Click Modify.
Reference Files Help ~ X
Blacklist Options
e & © & € € 0 0 -
Create  Add Gonnect Open Import Export Maodify  Remove
Local  Local ToRemote  Blacklist  Blackiist  Blacklist
. On the Create Glossary or Modify a Blacklist dialog, enter the required information. Based on your selection,

other fields auto-populate.

@ Required fields are marked with a red asterisk.



Create Glossary x

W Create/Modify Glossary
MName:* Glossary EN-DE
Browse
«" Selecled
Read-only
oK Cancel

W Modify a Blacklist

Marma:* Blacklist

Browse
+ Selected
~’ Read-only
oK Cancel
Name Modify the name of the current blacklist or glossary.
Selected (Optional) Select to use the current blacklist or glossary for modification.
Read Only (Optional) Select to leverage the glossary or blacklist without updating it with the new
translation.
5. Click OK.

Your modifications are saved.

USE PROJECT TERMINOLOGY OPTIONS

Remove a Glossary or Blacklist

When you remove a glossary or blacklist from a project, the glossary or blacklist file remains in the glossary or
blacklist folder on your computer. You can add it again with the Add Local or Connect to Remote action.

To remove a glossary or blacklist:
1. On the Projects tab, double-click a project from the projects list.

2. On the Project Terminology tab, select a glossary or blacklist.



3. Click Remove.

x

Reference Files Help ~
Blacklist

¢ & & & @& & L O

Create Add Connect Open Import Export Modify Remove
Local Local  ToRemole  Blacklist  Blacklist  Blacklist

A warning message asks you to agree to the removal.
4. Click Yes.

The selected glossary or blacklist is removed from the project terminology list.



9. Monitor Reports

Use the Reports tab to open and to export auto-generated analysis and cleanup reports to CSV, HTML, XLS, and
PDF formats.

[ Wardfast Pro — | %
= Worndfast Pro ~ Project Files Project TM Project Terminology Reports Reference Files Help ~ X
Opfions
2
-
Remove Export
Report
|F-!epcrt MHame | |Lccaticn Creation Date 9 T =
—-f EN-> DE
—-_ Analysis
¢ [ Analysis Reportlopt  C:\Users\Laks\Wordfast#\project...  2017/04/02 17:07:31 EDT
= Cleanup
n Clean Up Report.rpt C:\Users\Laks\Wordfast4\project...  2017/04/04 23:25:07 EDT
n Clean Up Reportl.rpt C:\Users\Laks\Wordfast4\project...  2017/04/04 23:26:16 EDT
EN -> DE | 5.59%

Open a Report

Use the Open Report action to open and view an auto-generated report.
To open a report:

1. On the Reports tab, select a report.

2. Double-click the report file name.



Report File x

Primary TM: tms://stg-supportl.com/TMS?
tm=DOC000003/MARDDO003&uUsr=Mar-en-
Secondary TM:
file://C:\Users\Laks\Desktop\LNK\WF\WF
testingDoc_TM1

H summary
Match Types Segments Words Percent Tags
Leveraged 70 372 99 5]
Repetitions 2 2 1 0
TM Matches
Context 6 60 16 &
100% 64 312 83 0
95%-99% 0 0 0 0
85%-94% 0 0 0 0
75%-84% 0 0 0 0
50%-74% 0 0 0 0
No Match 2 2 1 0
Ignored 0 0 0 0
Total 74 376 100 6
Chars/Word 6.46
Chars Total 2430

H c:\Users\Laks\Wordfast4\ projects\Document
ation2\de\txIf\Sample_1.docx1l.txml.txIf

H c:\Users\Laks\Wordfast4\ projects\Document
ation2\ de\txIf\Sample_3.docx.txml.txIf

oK

3. Review the report, and then click OK to close the dialog.

Export a Report

You can export an auto-generated report to a CSV, HTML, XLS, or PDF file format before you view it.
To export a report:
1. On the Reports tab, select a report.

2. Select a format from the Export drop-down list.

= Wordfast Pro ~ Project Files Project TM Project Terminology Reference Files Help

2

Remove Export -

3. Browse to the location for the report, enter a file name, and click Save.

The report is saved to the designated location.



10. Manage Project Reference Files

You can include reference files in a project to provide context. Typical reference files are additional instructions,
illustrations, workflow diagrams, certifications, or any file that might aid translators and reviewers. Reference files
remain untranslated.

A Users cannot modify reference files once you attach them to the project.

@ Wordfast Pro — | X
= Worndfast Pro ~ Project Files Project TM Project Terminology Reports Reference Files Help A~ X
Options
I rl | [T =
!ﬂ} = @ =)
Add Open Show Remove
Files File Instructions File(s)
|F e Name | File Type Location | o 1t =
n WF4 Basic Instructions_07.2016.pdf reference-files C:\Users'\Laks\Wordfast4\projects\Project4\references\WF4 Basic Instrct
n 2017.xdsx reference-files C:\Users\Laks\Wordfast4\projects\Project4\references2017.xdsx
EN-US > PT-BR - e

Add Reference Files

To add reference files:
1. On the Projects tab, double-click a project from the projects list to open it.

2. On the Reference Files tab, click Add Files.

= Wondfast Pre ~ Project Files Project TM Project Terminology Reports

Options
R S B
Add Open Show Remove

Files Fie Instructions File(s)

3. On the Open dialog, browse and select the reference file. To select multiple reference files, press Ctrl and
select them.

4. Click Open.

The files are added to the reference files list for the project.

Open a Reference File

To open a reference file:
1. On the Projects tab, double-click a project from the projects list to open it.
2. On the Reference Files tab, select a reference file from the list.

3. Click Open File.



= WordfastPro ~ ProjectFiles  ProjectTM  Project Terminology  Reports SIS Heip |

Options
_ O o
Add Open Show Remove

Files File Instructicns File(s)

The selected file is opened.

View Submission Instructions

Submitters can include instructions as part of the Package files imported into Wordfast Pro.

To view instructions:

1.
2.

On the Projects tab, double-click a project from the projects list to open it.
On the Reference Files tab, click Show Instructions.

= WordfastPro ~ ProjectFiles  Project TM  Project Terminology  Reports [ILESSESTE Help |

Options
I | ~
BRE & B
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Files File Instructions File(s)

In the Instructions dialog, review the instructions on the first Instructionstab, then click the Background
Instructions tab for any project-related or more general information and instructions.

. Click OK.

The Instructions dialog is closed.

Remove a Reference File

You can remove a reference file from a project, but the file remains on your local computer.

@ To add a removed reference file, use the Add Files action on the Reference Files tab.

To remove a reference file:

1.

On the Projects tab, double-click a project from the projects list to open it.

2. On the Reference Files tab, select the files you want to remove.

3. Click Remove File(s).

= WordfastPro ~ ProjectFiles Project TM  Project Terminology  Reports [ILEUEATEN Heip |

Options
R K B
Add Open Show Remaove

Files File Instructions File(s)

4. On the Remove dialog, select one of the available buttons.



#) Remove from the list only

Remove from the list and move the following resources to Archive folder

Resources

Reference Files

OK Cancel

Remove from the list only

Remove from the list and move the following
resources to Archive folder

5. Click OK.

Removes the reference file from the files list, but
retains the reference files resources in the project
folder on your computer

Removes the reference file from the files list and
moves them to the archive folder inside the project
folder on your local computer



11. Use Quick Tools

You can use Quick Tools to create and work with files outside of projects. Typically, Project Managers use Quick

Tools before cleaning up and sending files on to translation.

@ Access the Quick Tools view from the drop-down menu on the Wordfast Pro tab.

@ Wordfast Pro
= Wordfast Pro ~

[=] Project List

%, Quick Tools

L* Preferences

@ Exit Wordfast Pro
Projecte

Project?

Project 8

Projects

Project

TXLF Editor Close Add Modify
Praject Project Project
TM Editor =
Location
Glossary Editor
’: C:\Users\Laks\Wordfa. ..
Blacklist Editor

C:\Users\Laks\Desktop...
C:\Users\Laks\Wordfa...
C:\Users\Laks\Wordfa...
C:\Users\Laks\Wordfa...
C:\Users\Laks\Wordfa. ..
C:\Users\Laks\Desktop...
C:\Users\Laks\Wordfa. ..

Remove Recalculate
Project Progress
Source Lang -
English
English
English

English {United States)
English
English
English
English {United States)

Package
& &
Import Import SOL
Package Package
Target Lang -

German
Spanish
German
Portuguese (Brazil)
Spanish
German
German

Ttalian (Ttaly)
German (Germany)

Tools

& R

Export Quick

Package Tools
Date Created

2016/11/30 22:07:19...
2017/03/15 11:42:49 .
2017/03/21 15:37:59...
2017/04/02 11:04:44..
2017/04/06 10:08:03...
2017/04/06 22:24:38...
2017/07/18 13:47:06...
2017/07/19 16:55:42...

Options

[

Preferences

% Complete

17%
0%
1%
N/A
N/A
N/A

N/A

Analysis

The Analysis tab is displayed when you first open Quick Tools. Any further Quick Tools access
displays the last Quick Tools tab you used.

To analyze files:

1. Click the Wordfast Pro drop-down menu and select Quick Tools.

2. Click the Analysis tab if it is not already selected.




@ Wordfast Pro - Quick Tools

= Wordfast Pro - D

File

s B B
Add Add Remawve
File(s)

Files Folders

Source Files

Cleanup Pseuwdo Translation Bilingual Export Bilingual Import

Translation Memory

e
o

Actions
= & & = =)
=il T+ (3 -
Add
Local

Add
Project TMs

Remawve
T

Connect
Ta Remote

Create
Lacal

Analyze

Translation Memory

O x
Help A~ X
Options

—
—
—

Preferences

| File Name ‘FlleType |8ize

|:| TM Name ‘Prﬂjecl... |80urce Lang... Target Lang... Location

— Languags Sslsction

Source Languages:" | English

Target Languages:” | German (Germmany)

— Optionz

] Fuzzy match threshold S Matches

] Create THLF files

TXLF files location | CUsers\Documents\WEP\Resources TMY EBrowse...

[] copy all tags

|:| Copy source on no match

— Rieport Ssttings
Calculats analysis report percentage by:
| ! Words

'I' Segments

b Calculate internal fuzzy matches % Matches

[ ] Include internal fuzzy matches as TM matches

|repart summary - | Browse.. -

3. Click Add Files to browse and select a file from a folder or click Add Folder to browse and select a folder and
all its files.

@ To add multiple files, press the Ctrl key and select the files.

@ You can also drag and drop files into the Source Files pane.

4. (Optional) Add and select a Translation Memory.

@ If you do not select a TM, the analysis report displays the word count without TM leverage.

5. Select the Source Language and Target Languages.



6. (Optional) Select analysis report Options:

¢ Fuzzy match threshold — Select the baseline match percentage for TM leverage

e Create TXLF files — Create a TXLF file format as part of the analysis

e TXLF file location — Browse and select the TXLF analysis file location

e Copy all tags — Include all source tags in the target segments of the TXLF analysis file

e Copy source on no match — When there is no matching target content, insert source content in its
place

7. Select Report Settings.

¢ Select Words or Segments as the means of calculating analysis percentages.

e (Optional) Select Calculate internal fuzzy matches according to the match percentage you set or
select an alternate percentage.

e (Optional) Select Include internal fuzzy matches as TM matches

e Select the report format from the drop-down list, then browse and select a location for the report on your
local computer.

8. Click Analyze.

The Report File dialog is displayed and the report summary in the chosen format is saved to your local
computer.

Report File x

Primary TM: tms://stg-supportl.com/TM5?
tm=D0OC000003/MAROO0003&usr=Mar-en-
de&pwd=*****

Secondary TM:
file://C:\Users\Laks\Desktop\LNK\WF\WF
testing\Doc_TM1

H summary

Match Types Segments Words Percent Tags
Leveraged 70 372 99 6
Repetitions 2 2 1 0
TM Matches
Context 6 60 16 [
100% 64 312 83 0
95%-99% 0 0 0 0
85%-94% 0 0 0 0
75%-84% 0 0 0 0
50%-74% 0 0 0 0
Mo Match 2 2 1 0
Ignored 0 0 0 0
Total 74 376 100 53
Chars/Word 6.46
Chars Total 2430

oK



Cleanup

To convert bilingual TXLF files to their original source format in the target language, use the Cleanup action.
Refer to Translate Segments.

A Cleanup updates the translation memory (TM).

To clean up a bilingual TXLF file:
1. Click the Wordfast Pro drop-down menu and select Quick Tools.

2. Click the Cleanup tab.

File Name  Source Lang...

Target Lang... Size

@ Wordfast Pro - Quick Tools - O
= Wordfast Pro ~ Analysis Cleanup Pseudo Translation Bilingual Export Bilingual Import Help A X
File Actions Translation Memory Oplions
B - — (= (=] (=] (=] = =
e B B EH & 8 8 &8 & E
Add Add Remave Cleanup Create Add Connect Add Remoaove Preferences
Files Folders Filz(s) Local Local To Remoie Project TMs TM
TXLF Files Translation Memory

TM Name | Project ... | Source Lang... Target Lang...  Location

— TM Update Optionz

Update Cption: Owerwrite exisfing TU -

Add attribute
Add file name as an atribute

Write "unedited fuzzy' to TM

Wirite "exact’ matches to TM

Write ‘unedited MT" to TM

— Tranzlatad File Settings

| Create translated filas
(#) Place translated files in TXLF location

Choose location for translated files

W] Add languags suffix for filename

report summary -

3. Click Add Files to browse and select a file from a folder or click Add Folder to browse and select a folder and

all its files.

4. Add and select a Translation Memory.



To better understand content matches or the TM, refer to Leverage Project TMs.

5. (Optional) Select TM Update Options:

Update Option — Select one of the TM update options from the drop-down menu: Append, Do not
add to TM, Do not overwrite TU, Overwrite existing TU, or Overwrite if attributes are identical.
Add attribute — Select and enter an attribute to write to the TM for the cleaned up segments

Add file name as an attribute — Select to add the TXLF file name as an attribute to write to the TM for
cleaned up segments

Write 'unedited fuzzy' to TM — Select to write fuzzy matches to the TM without user modification
Write 'unedited autopropagated fuzzy' to TM — Select to write automatically inserted fuzzy matches
to the TM without user modification

Write 'exact' matches to TM — Select to write context matches to the TM without user modification
Write 'unedited MT' to TM — Select to write machine translation to the TM without user modification

6. (Optional) Select the Translated File Settings:

Create translated files — Default option; generates final files in original format

Place translated files in TXLF location — Saves the translated files in the same location as your
TXLF files

Choose location for translated files — Sets a location on your local computer for translated files after
you browse and select it

Add language suffix for filename — Adds the target language code to the file name as a suffix

7. Click Clean Up.

You can copy the source content to the target content as a pseudo translation for target languages. Pseudo
translations are of use when the content has accented characters and the text expands by twenty percent or
more. Pseudo translation provides a preview of translatable content and any formatting complexities in the target.

You can pseudo translate source or TXLF files.

If you are using Demo Mode, the limit on processing pseudo translation is 20 files. To pseudo
translate more than 20 files simultaneously, obtain a Wordfast Pro license.

To pseudo translate files:

1. Click the Wordfast Pro drop-down menu and select Quick Tools.

2. Click the Pseudo Translation tab.



Wordfast Pro — | X

Pseudo Translation Bilingual Export Bilingual Import Help ~ X

File Actions Options
e B B E
Add Add Remove Pseudo Preferences
Files Folders File(s) Translate
Files Pseudo translation
K o

Langusge Selection
~| File Name Source | Target L Size

~  sample_l.docobdf  English German 25KBE
~  sample_2.doccbdf  English German 25KBE

Pseudo translation Options

w

. Select either the TXLF or Source file type for pseudo translation.

B

In the Language Selection pane, select a Source Language and Target Language.

)]

. (Optional) In the Pseudo translation Options pane, select the desired check boxes and one of the radio
button options.

6. Click Add Files to browse and select a file from a folder. Click Add Folder to browse and select a folder and

all its files.

@ To add multiple files, press the Ctrl key and select the files. You can also drag and drop files into the
Source Files pane.

7. Click Pseudo Translate.

A successful completion message is displayed.

Quick Tools Bilingual Export

Use Bilingual Export to export the TXLF file with highlighted glossary terms to a .DOC or .DOCX format for edit
and translation of the content using Microsoft Word (Word).

You must not edit the export table format. This includes merging or expanding segments and adding
text outside of the target or notes column. Editing the export table format will result in errors during
bilingual import.

To conduct a Quick Tools bilingual export:

1. Click the Wordfast Pro drop-down menu and select Quick Tools.

2. Click the Bilingual Export tab.



[#) Wordfast Pro - Quick Tools — O

= Wordiast Pro ~  Analysis Cleanup Pseudo Translation Bilingual Export Bilingual Import Help A M
File Actions Terminclogy Options
B e B B B BB B B B B
Add Add Remove Bilingual Create Add Connect Add Project Remove Preferences
Files Folders File(s) Export Local Local To Remete Glossaries
TXLF Files Glossaries
~ File Name Source Language Target Language Size Glossary N... | Project Name | Source Lan... Target Lang... Location
~1  sample_1.docbdf English German 25KB
~1  sample_2.docbdf English German 25KB

Bilingual Export Options

Select export type from drop down: Bilingual Review Export -
Open repert after export
Exclude the notes column
Track changes
Protect document (Word 2003+)
Exgort all TXLF files as one bilingual file

] Export as Docx

Bilingual Filz Location:™ Browse...

. Click Add Files to browse and select a TXLF file from a folder or click Add Folder to browse and select a

folder and all its files.

. Click Add Local to browse and select a local glossary file from a folder or click Connect To Remote to browse
and select a remote glossary.

. (Optional) Click Add Project Glossaries to browse and select a glossary associated with a specific project to
add to the available Glossaries list.

. Select the TXLF files and glossaries for bilingual export from each list.

. Select your Bilingual Export Options.

Option Action

Export Type Export type options:

e Bilingual Review Export — Creates a bilingual Word document.

e WFC Bilingual Export (Export only) — Creates a Wordfast
Classic compatible document solely for export.

e MSWord Table — Creates a Word document with the source and
target in a two-column table.

¢ Bilingual Review Export - WFC (allows import) — Creates a
bilingual Word document for import by Wordfast Classic users.

Open report after export Automatically displays the Export Report after a bilingual export.




Option Action

Exclude the notes column Removes the Notes column from the exported Word document. Instead,
the export includes the notes from the TXLF file as Comments in the
Word document.

Track changes Selects track changes in the exported Word document.

Protect document (Word 2003+) Only allows content edits in the available table space. This helps avoid
any import errors.

Export all TXLF files as one Exports all converted TXLF files into a single bilingual Word document.
bilingual file

Export as Docx Exports bilingual file in the .DOCX Word file format.

Bilingual File Location Sets the folder location for bilingual export documents.

8. Click Bilingual Export
The bilingual export log is displayed and saved to the specified folder on your local computer.

Log session start fime Wed Dec 07 12:40:23 EST 2016

Level Message

INFO | ToReviewdMultiTxlf w1 2.0_RCA

INFO | Bilingual Review Export

INFO | Processing C:\lsers'Laks\Deskiopt LMK Training \Revised files for Training\Revised files for.. Sample 1.docx. bdf

INFO | 37 tus written.

The exported document is also saved to the specified folder on your local computer.

>389bldef-4093-47c2-b58d-b7bedch0038 f</FID> Sample 3.docx.txml.txlf

Source (en) Target (de) Score

o
-
o
s

D
1 TRANSLATION MANAGEMENT. UBERSETZUNGSMANAGEMENT. 20
2 SIMPLIFIED. VEREINFACHT. 100
3 STREAMLINE D)RD_]]:_(_TI MANAGEMENT | EFFEKTIVES PROTEKTMANAGEMENT 100 Eﬂmmg;t [OFRT:Glo1]:
4 [INTEGRATE WITHANY SYSTEM TNTEGRATION MITJEDEMSYSTEM 0 R = Sl
3 WORK WITH ANY [VENDOH| ZUSAMMENARBEITMIT JEDEM ANBIETER 100 T
6 ACCELLERATE TIME TOMARKET KURZERE BEARBEITUNGSZEITEN 87 B me m: Glossary o
i CUSTOMIZE WORKFLOWS INDIVIDUELLE WOREFLOWS 100
ACCESS REAL-TIME KPI DATA ZUGRIFF AUF LEISTUNGSKENNZAHLEN IN ECHTZEIT | 100
9 GlobalLink Project Directa] saves Mt GlobalLink Project Director sparen Organisationen 100 EDm mglu [OFRT:Gla3]:
organizations millions of dollars by automating | aufgrund derantomatischen Verwaltung vorr === ----=-=-=- = froooeo B oo
the management of localization processes and Lokalisierungsprozessen und -ressourcen Millionen.
TESQUrCes.
10 SEAMLESS [DATABASE INTEGRATION NAHTLOSE DATENBANKINTEGRATION 100 ?'ﬂ "lg'l‘l [OFRT:Gla4]:
11" ["Use [GlobalLind] Connect with any CMS, PIM,_| GlobalLink Connect funktioniert mit jeder CMS-, PIN-, 00 | DATENBANKINTEGRATION
CCMS, or e-commerce platform """ - GEMS-oder E-Commerce-Plattformy -~ ------ oo B ORI Glos]:
12 | WORK WITH ANY FILE FORMAT FUR JEDES DATEIFORMAT 100 From: Glossary
13 Next-generation parsing engines extract Parsing-Engines der nichsten Generation extrahieren Inhalte 100
content and prepare it for translation und bereiten sie fiir die Ubersetzung vor
14 [VENDOR-NEUTRAI] PLATFORM ANBIETERNEUTRALE PLATTFORM 100 Comment [OFRT:Glo6]:
= = - F
13 Allow access to any -@ or internal Maximale Ressourcenflexibilitt durch Zugniffauf alle 100 A
translator for maximum resource flexibifiry | “ibieter und intermen Ubersetzer ¢ [OFRT-Gla7]:
16 CONFIGURABLE WORKFLOW KONFIGURIERBARER WORKFLOW 100 me :Glossary
17 Streamline your translation process through Optimierung des Ubersetzungsprozesses durch 100
automation of manual tasks Automatisierung manueller Aufgaben
18 TRANSLATION MEMORY INTEGRATION [ INTEGRATION VON TRANSLATION MEMORY 100

Quick Tools Bilingual Import

Use Bilingual Import to re-import your translated or edited Microsoft Word bilingual export document.

You must upload both the translated or edited bilingual Word document and the source TXLF file you
used during export.



Since imports overwrite content from the export, create a backup of the original TXLF file for
reference.

@ e For bilingual files, the first number in the Counter column indicates the count of TXLF files
in the bilingual file that are paired with the added files in the TXLF Files panel. The second
number indicates the total count of TXLF files that were used during Bilingual Export.

e For TXLF Files, when the bilingual Word document and the corresponding TXLF file are paired,

a ¥ is displayed. If the files are not paired, a ®is displayed.

To complete bilingual import of files:
1. Click the Wordfast Pro drop-down menu and select Quick Tools.

2. Click the Bilingual Import tab.

Wordfast Pro - O it
= Wordfast Pro ~ Analysis Cleanup Pseudo Translation Bilingual Export Bilingual Import Help A~ X
File Actions Opticns
s B B E =l
Add Add Remove Bilingual Preferences
Files Folders File(s) Import
Bilingual Files Bilingual Import Options
File Name File Type | Size Counter Open report after import
ToReviewBundle.bdf . MS Wo... 72KB 01 Accept Tracked Changes
TXLF Files
File Name | Source ... | Target...  Size Paired

3. Click Add Files to browse and select a TXLF file from a bilingual export folder, such as Sanpl e. t x| f. doc,

and add it to the Bilingual Files list.

é You must select the correct file format from the drop-down list. Select MS Word Document when
uploading the bilingual Word document and WF TXLF Document when uploading the TXLF file.

4. (Optional) Click Add Folder to browse and select a folder and all its files from a bilingual export folder to add

to the available TXLF Files list.

5. Select the Bilingual Files and TXLF Files from each list for bilingual import.

@ To select multiple files, press the Ctrl key during selection.

6. Select your Bilingual Import Options.



Open report after import  Automatically opens the report after the bilingual import

Accept Tracked Changes Accepts tracked changed in the bilingual Word document

7. Click Bilingual Import.

The bilingual import log is displayed. The translations and edits in the bilingual export Word document are
imported into the specified TXLF file on your local computer.

@ The import overwrites the TXLF file content with the imported bilingual Word document content.

Log session start fime Thu Dec 08 12:21:52 EST 2018

Level Message

INFO | FromReviewMultiT=lf v1.2.0_RC1

INFO | Caollecting offfine tus from C:\lsersi\Laks\Deskiopi\ L MESWFWWE testing\Documentstion'\ ToReviewBundle-1of2. tdf doc

INFC | WY SIWYG tag checker DISABLED

INFC | TransCheck DISABLED

Importing to C:\Users\Laks\Deskiop\L MK Traning\Revised files for Training'Revised files for TrainingUpload
files'\Sample 2 docx fxif

Modified targst:

1-2-1

INFO | Diff : EFFEKTIVES PROJEKTE MAMAGEMENT

XML Before: EFFEKTIVES PROJEKTMAMAGEMENT
XML After: EFFEKTIVES PROJEKTE MANAGEMENT

INFO

INFO | File changed: 1 of 37 collected segments were menged.




12. Configure Preferences

You user preference options control the functions available to you in the user interface. Configure preferences at
either the project level or the file level.

= Wordfast Pro = File Edit Formatting Translation Terminology Review Help

Clipboard Source Actions Options

T rxBBb R B R BR B @

Undo Redo Cut Copy Paste Find / Copy All - Clear All Revert Show Whitespace Preferences
Replace Tags Tags Source Source Characters

Preferences fall into three primary categories:

o General Preferences
e Current Project Preferences
o User Preferences

General Preferences

Use General Preferences to configure user interface and TXLF Editor preferences.

GENERAL PREFERENCES

Configure Color Settings

Colors preferences control color customization for specific types of content in TXLF Editor.
To configure colors used in the translation table:

1. Select Preferences from the Wordfast drop-down menu.

2. On the Preferences dialog, click Colors under General Preferences.



-~ .
General Preferences W Customize the colors used in the translation table
Colors
General Colors
lcons Auto-Propagated Editor View l:l
Layout Committed into TM Editor View ]
Segment Context Match Editor View B
Shortcuts Exact TM Match Editor View [ ]
Wamnings Exact Term Match Editor View ]
Tags Fuzzy TM Match Editor View [ ]
Auto-Propagation Fuzzy Term Match Editor View l:l
Auto-Suggestion
Machine Translated Editor View l:l
Spelichecker Missing Exact Term Match Editor View l:l
achine Transiation Missing Fuzzy Term Match Editor View l:l
Current Project Preferences Hodified Target Editor View |:|
Replacement No TM Match Editor View ]
Translation Memory Selected Term Color Editor View -
Terminology
R -
.:I . Cancel

3. Click the color box for any Item Name, then select another color from the color palette on the Color Picker
dialog.

4. Click OK to close the dialog.
5. Click OK.

GENERAL PREFERENCES

Configure General Settings

General preferences link a specific username to project-related content changes.
To customize general settings:

1. Select Preferences from the Wordfast drop-down menu.

2. On the Preferences dialog, click General under General Preferences.



Preferences

General Preferences

W Change general settings

Selected user name will be placed for Motes, TM and Segment changes. For this change to take effect,

Colors
General
User Name
Fonts
User Mame:

lcons

Disclaimar
Layout

please reopen your project(s) to re-establish connections.
Segment
Shortcuts General Preferences
Warnings *) Copy Source or TXLF Files into Project Folder Structure
Tags Create TXLF File with language suffix next to the Source File

Create Folder with language suffix next to the Source File where TXLF file will be stored

Auto-Propagation

/1 Add score column to bilingual table

Auto-Suggestion
Spelichecker Bilingual Review Export

Machine Translation

Select Bilingual Review Export Options:

/1 Open report after export
New Project Preferences

] Exclude the notes column
Replacement

] Track changes
Translation Memory

Protect document (Word 2003+)

Terminoclogy

Export all TXLF files as one bilingual file

Penalties ~

OK Cancel

3. Enter the User Name for user identification on Notes, TM, and segment changes.

4. Select one of the source file locations.

Option

Action

Copy Source or TXLF Files into Project Folder
Structure

Click to create a sub-folder within the project
language folder for storing source files.

Note: If the source file is a TXLF file, a copy is saved.

Create TXLF File with language suffix next to the
Source File

Click to create a TXLF copy of the source file at the
same location with the target language code as a
suffix.

Note: If the source file is a TXLF file, no copy is
saved.

Create Folder with language suffix next to the
Source File where TXLF file will be stored

Click to create a TXLF copy of the source file in a
source file sub-folder using the target language code
as a suffix.

Note: If the source file is a TXLF file, no copy is
saved.

Add score column to bilingual table

Select to include the TM score in the bilingual table
export.

5. Select the Bilingual Review Export options that allow you to export a file with highlighted glossary terms to a

Microsoft Word .DOC or .DOCX format.



Option

Action

Open report after export

Select to automatically open the Bilingual Report after
the export completes.

Exclude the notes column

Select to exclude the notes column from the exported
MS Word document.

Track changes

Select to enable track changes in the exported MS
Word document.

Protect document (Word 2003+)

Select to write-protect the document. This allows
users to edit only the target segment content and add
notes.

Export all TXLF files as one bilingual file

Select to export all submission files as a single
bilingual file.

Export as Docx

Select to export the bilingual report in the
Word .DOCX file format.

GENERAL PREFERENCES

Fonts preferences control customization of font type and size for application-wide functions, such as notes.

To configure fonts:

1. Select Preferences from the Wordfast drop-down menu.

2. Click Fonts under General Preferences.



“
General Preferences W Customize the fonts used throughout the application
Colors
General Fonts
Fonts N
ltem Name Font Size Change
Icons TXLF Editor Font Arial 13-
Layout TM Lookup Font Arial 12
Segment Term Lookup Font Arial 12
Blacklist Editor Font Arial 13 h
Shortcuts
Warnings Preview:
Tags
Auto-Propagation The quick brown fox jumps over the lazy dog.

Auto-Suggestion

Spelichecker — Language Specific Font

Machine Translation ~
Item Name Font Size Add
Chinese SimSun 13 - Remove
Current Project Preferences Japanese M5 Mincho 13 -
Replacement Korean Batang 13 -
Translation Memory o
Disclaimer
Terminology rFont Styles (Typeface on OSX) are not supported by the editor ‘

Kl -

Select an application-specific font and size for an item name, such as Segment History Font.

Click Change.
(Optional) Preview the impact of your change in the Preview pane.
Select a language-specific font.

Add, remove, or change the language-specific font

© N o o »~

Click OK.

GENERAL PREFERENCES

Configure Icon Settings

Icons preferences control the relative size of the icon and include or exclude the icon title.
To configure icon settings:

1. Select Preferences from the Wordfast drop-down menu.

2. On the Preferences dialog, click Icons under General Preferences.



-
General Preferences W Customize the appearance of the icons the application ribbon
Colors
General lcons
Fonts Seticons size:
() Large icons
lcons ) g
(®) Medium icons
Layout - .
v () Small icons
Segment ] Display text
Shortcuts
Warnings
Tags

Auto-Propagation
Auto-Suggestion
Spellchecker

Machine Translation

Current Project Preferences
Replacement
Translation Memory

Terminology

Kl -

3. Select a size for application icons.
4. (Optional) Deselect Display text to exclude icon description text.

5. Click OK.

GENERAL PREFERENCES

Configure Layout Options

Layout preferences control the arrangement of user interface views.
To configure layout options:

1. Select Preferences from the Wordfast drop-down menu.

2. Click Layout under General Preferences.



Preferences x

General Preferences W Change the layout and appearance of the application

Colors
General Editor
Fonts Editor Layout:
lcons () Table View
Stacked View
Layout
Segment Table View:
Shortcuts Hide ID Column
_ Hide Score Column
Warnings

Hide Table Header
Tags

Auto-Propagation Score Column Position:

Auto-Suggestion (_) Before Target
() After Target
Bpelichecker
Machine Translation
Current Project

Current Project Preferences ] Display Language Codes in Current Project View

Replacement Display Full Language Name in the Current Project View

Translation Memory Status Bar Representation
Terminology (#») Language Codes
e h () Full Languaas Mame h
0K Cancel
3. (Optional) Modify the Editor Layout.
Table View Default view displays the source segment to the left and the target
segment to the right.
Stacked View Displays the source segment directly above the target segment in a

spanned row.

*Sample-File_en-de-word_txif-def#Vé.docx X N

|Suurce or Target - | Maich Casze Regex |Ent&r fext fo filter sec | Filter: |Select special filter(z) | Q ,O-' )

1D English -> German Score Status

TRANSLATION MANAGEMENT. -
1 UBERSETZUNGSMANAGEMENT. o
MADE SIMPLE.
VEREINFACHT.
BSTREAMLINE PROJECT MANAGEMENT @

ByEFFEKTIVES PROJEKTMANAGEMENT @

N

. (Optional) Modify the Table View layout to hide or show columns.

[¢)]

. (Optional) Modify the TM Score Column Position layout for before or after the target column.

»

. (Optional) Modify the Current Project layout to include the target language name or use a language code in
the view.

~

. (Optional) Modify the Status Bar Representation layout in the Current Project view.



Language Codes Click to include language codes on the Status Bar.

Full Language Name Click to include the complete language name on the Status Bar.

8. Click OK.

GENERAL PREFERENCES

Configure Segment Actions

Segment Actions preferences control segment action behaviors, such as Smart Quotes or Smart Punctuation.

To configure segment actions:

1. Select Preferences from the Wordfast drop-down menu.

2. On the Preferences dialog, click Segment under General Preferences.
General Preferences W Configure how segment will work in the text editor

Colors
General Segment actions
Fonts W] Mext/Previous Segment action leverages next/previous segment
lcons ] Open the last edited segment when opening a file
Layout Leverage the first opened segment on click
Segment i/ Capitalize the first letter of the target segment (Except Asian languages)
Shortcuts ] Enable Smart Quotes
Warnings Skip Unedited 100% Matches
Tags Skip Unedited Context Matches
Auto-Propagation Cursor position on segment opening:
*) Start

Auto-Suggestion
End
Spelichecker

Machine Translation

Current Project Preferences
Replacement
Translation Memory

Terminclogy

3. Select a segment option.

Option

0K Cancel

Action

Next/Previous Segment action
leverages next/previous segment

Select to automatically leverage the TM for the segment as you
make the segment active.

Open last edited segment when
opening a file

Select to go to the last segment edited after reopening a file.

Leverage the first opened segment
on click

Select to automatically leverage the TM for the first open segment
you click after opening a file for translation.




Option

Action

Capitalize the first letter of the target
segment (Except Asian Languages)

Select to convert translated segments to sentence case. Not
applicable for Asian languages.

Enable Smart Quotes

Select to activate both Smart Quote and Smart Punctuation
features.

e Smart Quotes — Changes the quotation marks to smart
quotes, depending on the target language.

e Smart Punctuation — Changes white space and
punctuation mark elements to those appropriate for the target
language, with the exception of Chinese, Japanese, and
Korean (CJK) languages and those that read from right-to-
left (RTL), such as Arabic, Hebrew, Persian, and Urdu.

Note: The white space group includes spaces, non-breaking
spaces, and white space representations: the middot and overring.
The white space group also includes cases where an exclamation
point or question mark exists in isolation at the beginning of the
segment, sentence, or paragraph.

Skip Unedited 100% Matches

Select to ignore 100% matched segments.

Skip Unedited Context Matches

Select to ignore segments with context matches.

Cursor position on segment opening

Select to place the cursor at the beginning or end of the active
segment.

e Start — The default places the cursor at the beginning of the
segment on segment selection.

e End— Places the cursor at the end of the segment on
segment selection.

GENERAL PREFERENCES

Shortcuts preferences control keyboard shortcuts for the commands that you frequently use.

To customize keyboard shortcuts:

1. Select Preferences from the Wordfast drop-down menu.

2. On the Preferences dialog, click Shortcuts under General Preferences.



Preferences x

=
General Preferences w Customize and define your keyboard shortcuts for the application
Colors
General Shortcuts
Fonts Scheme: Wordfast Pro style -

Icons 1 Include Unbound Commands

Layout

Search:
Segment
Select command by single clicking to assign new key combination
FilaniEliE Commands T Shorteut View
Warnings About Choose Binding BlacKist Editor, T...  *
Tags Add Blacklist Alt+C Project
. Add Blacklist Term Choose Binding Blacklist Editor
Auto-Propagation
Add Files Choose Binding Quick Tools, Project
Aute-Suggestion Add Folder Choose Binding Quick Tools, Project
Spellchecker Add Glossary Alt+0 Quick Tools, Project
Machine Translation Add Note Alt+5hift+N Editor
Add Project Ctrl+5hift+A Home
Add Project TMs Ctrl+5hift+6 Quick Tools
Current Project Preferences
I Add Reference Files Choose Binding Project
Replacement Add TM Tl wick Tools Brojec T
Translation Memory Description:
Terminology
-
OK Cancel

3. Select a style Scheme from the drop-down list.

When changing or creating new shortcut key sequences, the sequence must either begin with a Ctrl,
Alt, or Shift, must use a function key, or use a combination of these.

4. Select a Command from the command list and enter a new sequence of keys in the Shortcut column, then
click OK.

5. (Optional) If you choose a shortcut key sequence already in use, a warning message notifies you that it will
override the prior key sequence. Click Yes to save the new shortcut for a command.

The new shortcut key sequence is saved.

GENERAL PREFERENCES

Configure Warning Messages

Warnings preferences control the type of warning notifications you receive.
To configure warning messages:

1. Select Preferences from the Wordfast drop-down menu.

2. On the Preferences dialog, click Warnings under General Preferences.



“ “
General Preferences W Configure which warning messages you want to see in the application

Colors

General Warnings

Fonts 1 Welcome message

lcons /1 No TM available warning

Layout ] Transcheck warnings

Segment ] Owverwrite target warning

Shortcuts /1 Copy all sources warning

Warnings 1 End of document warning

Tags 1 Remove segment tags warning

Auto-Propagation 1 Remove all tags warning

Auto-Suggestion ] Remove Targetwarmning

Spellchecker 1 Remove all target warning

Machine Translation 8 Remove Term waming

1 Show duplicate shortcuts warning

Current Project Preferences /1 Show targetwith tags warning

Replacement /] Terminology highlighting info message

Translation Memory /] Remove Th waming

Terminology /1 Remove glossary warning

R - /T Remove blacklist waming -

Kl -

3. Select your warning notifications.

4. Click OK.

GENERAL PREFERENCES
Configure Tags and Formatting

Tags and Formatting preferences control the tag mode, representation, and font size in TXLF Editor.
To configure tag and formatting options:
1. Select Preferences from the Wordfast drop-down menu.

2. On the Preferences dialog, click Tags under General Preferences.



General Preferences W Configure how tags and formatting are viewed and worked with in the editor
Colors
General Tags and Formatting
Fonts Text Formatting:

lcons Show supported text formatting

*) Show formatting as Tags

Layout
Preview:
Segment
This is the [Eir Non-Formatting 4= mode.
Shortcuts
Warnings Tag Naming:
Tags *) Full Name

Short Name
Auto-Propagation

Numbered Tags
Auto-Suggestion
Spelichecker Remove incomplete tag pairs

Machine Translation ] Apply source segment formatting to target segment

Current Project Preferences
Replacement
Translation Memory

Terminology

0K Cancel
3. (Optional) Modify Text Formatting options.
Option Action
Show supported text Click to display formatted content in TXLF Editor view, along with a
formatting sample of the formatted content in Preview.
Show formatting as Tags Click to display content with formatting tags in TXLF Editor view, along

with a sample of the formatted content and tags in Preview.

4. (Optional) Modify Tag Naming options.

Option Action

Full Name Click to view the tag's full name, for example Font .
Short Name Click to view the tag's short name, for example F.
Numbered Tags Click to view the tag's number, for example 3.

Remove incomplete tag pairs  Select to delete incomplete or incorrect tags from the file.

Apply source segment Select to apply segment formatting within a tag from the source segment
formatting to target segment  to the target segment.

GENERAL PREFERENCES

Configure Auto-Propagation

Auto-Propagation preferences control the automatic update of content with specified types of TM matches.



To configure auto-propagation:
1. Select Preferences from the Wordfast drop-down menu.

2. On the Preferences dialog, click Auto-Propagation under General Preferences.

General Preferences W Configure how Auto-Propagation options will populate segments
Colors
General Auto-Propagation
Fonts ] Enable Auto-Propagation for repetitions
lcons Enabling Auto-Propagation will update all empty target segments for the entire file.
Layout Enable Auto-Propagation across all open files
Segment Usze Auto-Propagation to overwrite segments containing:
Context matches

Shortcuts

W 100% matches
‘Warnings

W Fuzzy matches
Tags

W Auto-propagated matches

Auto-Propagation
Edited =egments

Auto-Suggestion
g ] Machine translated segments

Spelichecker
pe Committed segments

Machine Translation

Current Project Preferences
Replacement
Translation Memory

Terminology

0K Cancel

3. Select Enable Auto-Propagation for repetitions to activate additional auto-propagation options (default).

4. (Optional) Select Enable Auto-Propagation across all open files to apply auto-propagation to all files that
are open.

5. Select the desired Auto-Propagation options.

Option Action

Context matches Select to overwrite context leveraged translation memory (TM) matches
100% matches Select to overwrite 100% leveraged TM matches (default)

Fuzzy matches Select to overwrite partial TM matches (default)

Auto-propagated Select to overwrite all auto-propagated matches (default)

matches

Note: If there are multiple segments that have the same content, editing a
segment auto-propagates the change to all matching segments.

Edited segments Select to overwrite edited segments using Auto-Propagation
Machine translated Select to overwrite machine translated content (default)
segments

Committed segments Select to overwrite translated content that is committed to the TM




GENERAL PREFERENCES

Configure Auto-Suggestion

Auto-Suggestion preferences control automatic recommendations for source content, such as numbers, URLs,
and proper names. It can also recommend terms for the glossary, Translation Memory (TM) matches, and
machine translation (MT) matches.

To configure auto-suggestion:
1. Select Preferences from the Wordfast drop-down menu.

2. On the Preferences dialog, click Auto-Suggestion under General Preferences.
General Preferences W Configure how features will work in the text editor

Colors

General Auto-Suggestion
Fonts ] Enable Auto-Suggestion
lcons Enable suggestions for:
Layout W Capitalized source words
Segment W Glossary terms
Shortcuts ™
Warnings TM sub-segments

MT

Tags
Auto-Propagation
Auto-SBuggestion
Spelichecker

Machine Translation

Current Project Preferences
Replacement
Translation Memory

Terminology

oK Cancel
3. Select the Enable Auto-Suggestion check box and suggestion options, then click OK.
Option Action
Capitalized source Select for source segment suggestions: numbers and capitalized words only
words
Glossary terms Select for glossary suggestions, based on the project
™ Select for translation suggestions from the TM
TM sub-segments Select for sub-segment translation suggestions from the TM

MT Select for machine translation (MT) translation suggestions.




GENERAL PREFERENCES

Configure and Enable Spellchecker

Spellchecker preferences control the interaction between the application and either Microsoft Office or Hunspell.

Either option requires software installation on your computer.

To configure and enable Spellchecker:

1. Click Spellchecker in the General Preferences group.

General Freferences w Configure how spellchecking will work in the editor
Colors

General Spellchecking

Fonts /| Enable Spellchecking

leans Check for spelling errors as you type

Layout Choosa spalichacker

Segment Microsoft Otfice (PC-only and if installed)
Shortcuts *! Hunspell

Warnings

Tags

Auto-Propagation
Auto-Suggestion
Spelichecker

Machine Translation

Current Project Preferences

Replacement
Translation Memory

Terminology

2. Select Enable Spellchecking to enable Spellchecker.

oK Cancel

é Deselect Enable Spellchecking to disable Spellchecker. Disabling Spellchecker clears all
Spellchecker preferences. You must reconfigure your preferences when you re-enable Spellchecker.

3. (Optional) Select Check for spelling errors as you type and configure for Microsoft Office or Hunspell, based

on your installation.

To install Hunspell, go to Help > Wordfast Pro Update, choose the required language JAR, and click

Update. Select Hunspell for any of the following languages after you install it.

Language Code Language Code
Arabic AR Korean (South Korea) KO-KR
Basque (Basque) EU-ES Latvian (Latvia) LV-LV
Bosnian (Bosnia) BS-BA  Lithuanian (Lithuania) LT-LT




Language Code Language Code
Bulgarian (Bulgaria) BG-BG Malaysian (Malaysia) MS-MY
Catalan (Catalan) CA-ES  Norwegian (Bokmal Norway) NB-NO
Croatian (Croatia) HR-HR  Norwegian (Nynorsk Norway) NN-NO
Czech (Czech Repubilic) CS-CZ  Polish (Poland) PL-PL
Danish (Denmark) DA-DK  Portuguese (Brazil) PT-BR
Dutch (Netherlands) NL-NL Portuguese (Portugal) PT-PT
English (Canada) EN-CA  Romanian (Romania) RO-RO
English (United Kingdom) EN-GB  Russian (Russia) RU-RU
English (United States) EN-US  Scottish Gaelic (United Kingdom) GD-GB
Estonian (Estonia) ET-EE Serbian (Serbia) SR-RS
Farsi (Iran) FA-IR Slovak (Slovakia) SK-SK
Finnish (Finland) FI-FI Slovenian (Slovenia) SL-SI
French (Canada) FR-CA  Spanish (Mexico) ES-MX
French (France) FR-FR  Spanish (Spain) ES-ES
Galician (Spain) GL-ES  Swedish (Sweden) SV-SE
German (Germany) DE-DE  Swahili (Kenya) SW-KE
Greek (Greece) EL-GR  Tagalog (Philippines) TL-PH
Hebrew (Israel) HB-IL Thai (Thailand) TH-TH
Hindi (India) HI-IN Turkish (Turkey) TR-TR
Hungarian (Hungary) HU-HU  Ukrainian (Ukraine) UK-UA
Indonesian (Indonesia) ID-ID Urdu UR
Irish (Ireland) GA-IE Vietnamese (Vietnam) VI-VN
Italian (ltaly) IT-IT Welsh (United Kingdom) CY-GB
Japanese (Japan) JA-JP Zulu (South Africa) ZU-ZA
Kazakh (Kazakhstan) KK-KZ

4. Click OK to save your configuration.

GENERAL PREFERENCES

Machine Translation (MT) preferences control automatic population of target segments with translations that
have no translation memory (TM) segment matches.



To configure a machine translation engine:
1. Select Preferences from the Wordfast drop-down menu.

2. On the Preferences dialog, click Machine Translation under General Preferences.

Preferences 4
“
General Preferences W Configure how machine translation engines work while you are translating
Colors
General Machine Translation
Fonts Machine Translation Behawvior
Icons *) Show MT results in TM Lookup when there is no TM match
Always show MT results in TM Lookup
Layout
Allow all unedited segments in active document to be leveraged with MT
Segment
Remove MT score from score column when a segment is edited
Shortcuts
Warnings
Enable Google Translator
Tags

Enable Microsoft Translator
Auto-Propagation
Enable WorldLingo

Auto-Suggestion
Disclaimer for public providers

Spellchecker Source segments are submitted to Machine Translation providers. Make sure this is compatible with your
confidentiality requirements. Mote that target segments (your translation) are not fed into MT providers,

RTINS I T they remain confidential.

Current Project Preferences
Replacement
Translation Memory

Terminology

OK Cancel

3. Select one of the following:

o Show MT results in TM Lookup when there is no TM match, to show machine translated content without
local or remote TM matches.

o Always show MT results in TM Lookup, to show machine translated content with leveraged segments.
TM matches display in TM Lookup with the MT matches.

4. Select check boxes to allow All unedited segments in active document to be leveraged with MT, and to
Remove MT score from score column when segment is edited.

5. Select Google Translator, Microsoft Translator, or WorldLingo as the primary machine translator. You can
enable all three, but you can only designate one as the primary machine translator.

6. Select MT options for each machine translator, then perform the designated setup tasks associated with each
machine translator.

@ WorldLingo has a limited set of source languages for MT.



e Arabic e French e Korean

e Chinese Simplified e German e Portuguese

e Chinese Traditional e Greek e Russian

e Dutch e ltalian e Spanish

e English e Japanese e Swedish
Translator Options

Enable Google
Translator

Google Translator is a paid service, you need to register and get a key to enter below (if left blank, Google engine
will be disabled).

API :

Use Google Premium Edition (using Neural MT for limited language pairs)

/| Use Google Translator as primary Test

To register, please check Google Translate API.

To access and enable Google Premium edition please check Google Translate Premium Edition API.
Premium Edition using Neural MT is only available for limited language pairs listed below. If non supported
languages are used with Premium, Google might provide you with standard edition translation.

Available language for Google Translate

Available language for Premium Google Translate

Enable Microsoft

Microsoft Translator APl is now available in the Azure portal under the Cognitive Services category. You need to

Translator subscribe to the new service and enter the new key in the field below (if left blank, MS Translator will be
disabled). Also, you can broaden your search by entering a category as one of the parameters.
Key:
Category Name :
Use Microsoft Translator as primary Test
To register, follow the link below. The free option still exists; however, a credit card is now required for
identification.
How to sign up for Microsoft Translator on Azure
Available language for Azure Search Service REST API
Enable WorldLingo

Use WorldLingo as primary Test

WorldLingo MT has a limited source language set.

7. Read the disclaimer and click OK.

Your machine translation preferences are configured.

New Project Preferences

New project preference options control whatever has been set up for this project by the Project Manager.

@ Settings begin with standard defaults.



NEW PROJECT PREFERENCES

Configure TM Content Replacement

Replacement preferences control TM replacement of specified types of content to increase TM match results.
To enable replacements:

1. Click Replacement in the New Project Preferences group.

Segment -
Shorteuts W Configure how translation memaories are used in your project

Warnings

Replaceables
Tags
/] Enable replacement of detected text in TM results for higher TM matches
Auto-Propagation
& Mumber replacement
Auto-Suggestion
1 URL replacement
Spellchecker
W Punctuation replacement
Machine Translation
~ Email address replacement

Current Project Preferences
Replacement
Translation Memory
Terminology
Penalties
Transcheck
Segmentation

Filters

User Preferences

Advanced Settings

Kl -

2. Select Enable replacement of detected text in TM results for higher TM matches, and then enable specific
content type replacement options.

3. Click OK.

NEW PROJECT PREFERENCES
Configure a Translation Memory

Translation Memory (TM) preferences control project-level TM behaviors.



To configure a translation memory (TM):

1. Click Translation Memory in the New Project Preferences group.

Preferences x
segme
- -
Shortcuts W Configure how translation memaories are used in your project
Warnings
Tags Translation Memory
Auto-Propagation Write ‘exact’ matches to TM

Auto-Suggestion Write ‘'unedited MT" to TM

Spelichecker Write 'unedited fuzzy' to TM

Machine Translation

Copy Source to Target on no match

New Project Preferences Set Fuzzy TM match threshold (35): EI

Replacement Report Sstiings

Calculate analysis report percentage by:
Translation Memory

. *) Words
Terminology
Segments
Penalties M| Calculate internal fuzzy matches and set threshold to (%) |75 2
Transcheck

M Include intemnal fuzzy matches as TM matches

Segmentation

Filters Whan Updating an sxisting TU
*) Add to TM by overwriting the existing TU
Add to TM; overwrite the existing TU if attributes are identical (default)
User Preferences :

Add new segments to TM; do not overwrite the existing TU

Advanced Settings Add to TM; do not overwrite the existing TU

“ canw'

2. (Optional) Select TM match options.

Option Action

Write 'exact' matches to Select to commit contextual matches to a TM.
™

Write 'unedited MT' to Select to commit unedited machine translated matches to a TM.
™

Write 'unedited fuzzy' to Select to commit unedited fuzzy matches to a TM.
™

Write 'unedited Select to commit unedited auto-propagated fuzzy matches to a TM.
autopropagated fuzzy'
toT™M

Copy source to Target  Select one of the options to copy specific content components to the target
on no match segment when there is no match during TM leverage.

Fuzzy Match Threshold Select the baseline percentage for TM matches from the drop-down list.

Note: This percentage specifies the TM leverage limit for a fuzzy match. For
example, with a threshold of 75%, all segment translations below a 75% match

are marked as 'No match' ngmpntc

3. Select Report Settings options.



4. (Optional) Select only one TM condition from When Updating an existing TU when editing an existing
translation unit (TU).

5. (Optional) Select the Total number of TUs shown in TM Lookup pane value.

6. Click OK.

NEW PROJECT PREFERENCES

Configure Terminology

Terminology preferences control terminology lists for leveraging previously translated content.
To select terminology options:

1. Select Preferences from the Wordfast drop-down menu.

2. Click Terminology under New Project Preferences.

Preferences "
Segment -
Shortcuts W Configure how glossaries are used in your project
Warnings
Terminology
Tags

Term Highlight Sattings
Auto-Propagation ~] Enable fuzzy term recognition
Auto-Suggestion +/1 Enable term highlighting when typing terms
Spelichecker /] lgnore case for term highlighting

Machine Translation
Term Lookup Settings

Mumber of terms shown in the Term Lookup pane: 100

1

Current Project Preferences
Replacement
Translation Memory
Terminology
Penalties
Transcheck
Segmentation

Filters

User Preferences
Advanced Settings

OK Cancel

3. Select Enable fuzzy term recognition to view fuzzy matches.

4. Select Enable term highlighting when typing terms to indicate terminology matches by highlight when
entered in the translation.

5. Select Ignore case for term highlighting to ignore case difference in terminology matches.

6. Select the number of matches you can view, then click OK.



NEW PROJECT PREFERENCES

Configure TM Penalties

Penalties preferences help maintain a high quality of content leveraged from a translation memory (TM). This
involves assessing a penalty to TM matches to provide a relative score for those TM matches. You can assign
a relative value to each penalty type when calculating the translation score. This score helps users differentiate

between 100% match, fuzzy match, and no match content.

To configure penalties for TM matches:

1. Select Preferences from the Wordfast drop-down menu.

2. On the Preferences dialog, click Penalties under New Project Preferences.

Preferences
Seyiie
Shortcuts
Warnings
Tags
Auto-Propagation
Auto-Suggestion
Spelichecker

Machine Translation

New Project Preferences
Replacement
Translation Memory
Terminclogy
Penalties
Transcheck
Segmentation

Filters

User Preferences

Advanced Settings

W Configure how translation memory matches are penalized

Penalties
Value: Min: Manc:
/] Case
] Non Literal 05 2 1 - 10 =
M Tag 0s 2 1 = 10 =
Whitespace
1 Align 3 =
] Machine Translation 15 -
Multiple Translation
Local TM
Remote TM
Private TU
Public TU
Secondary TM
W] Attribute 1 =

n Canwl

3. Select a penalty, supply a threshold, then click OK.

Penalty Action

Case Select to consider differences in case

Non Literal Select to consider differences in special characters, including
punctuation, space, apostrophe, dash, and quote

Tag Select to consider differences in tagging

Whitespace Select to consider differences in blank spacing

Align Select to consider differences in translation units (TUs) with

alignment attributes




Penalty Action

Machine Select to consider differences in TUs based on machine

Translation translation (MT)

Multiple Select to consider differences in TUs based on duplicates within

Translation the TM with different translations

Local TM Select to consider differences in TUs from the local desktop copy

Remote TM Select to consider differences in TUs from a remote TM

Private TU Select to consider differences in work-group TUs from a remote
™

Public TU Select to consider differences in non-work-group TUs from a
remote TM

Secondary TM Select to indicate that the translation leverages a secondary TM

Attribute Select to consider differences in attributes

If attribute is not Select for when a custom attribute in a TU does not match the
text box attribute

If filename Select for when the file name attribute in a TU does not match
attribute does not the TXLF file name
match

NEW PROJECT PREFERENCES

Transcheck preferences control at the project level how Transcheck verifies target segments and issues

warnings about common translation errors. For example, if a tag is missing or there is incorrect text, a @ displays
in the Status column.

To configure Transcheck:
1. Select Preferences from the Wordfast drop-down menu.

2. On the Preferences dialog, click Transcheck under New Project Preferences.

There are primary Transcheck options, some of which provide additional sub-options.



Segment
Shortcuts
Warnings

Tags
Auto-Propagation
Auto-Suggestion
Spellchecker

Machine Translation

New Project Preferences
Replacement
Translation Memory
Terminology
Penalties
Transcheck
Segmentation

Filters

User Preferences

Advanced Settings

Option

' ' & Configure the Transcheck settings for your project

Transcheck
Disclaimear
In order for the Spellcheck Transcheck to work you would need to enable the Spellcheck option in the
Spellcheck Tab in Preferences.

Transcheck segments while translating

Select/Deselect All

Blacklist Check
Capitalization Check
Edited Context Match Check
Edited Exact Match Check
Edited Source Check
Empty Target Check
Forbidden Character Check
Mistranslated Text Check
Mote Check

Mumber Difference Check
Paragraph Length Check

Punctuation Check
OK Cancel

3. To control how Transcheck evaluates source and target segments, select different configuration settings.

Action

Transcheck segments

while translating

Select to enable Transcheck during translation.

Select/Deselect All Select to enable or disable all Transcheck options. To select only some
Transcheck options, continue down the settings list.
Blacklist Check Select to identify terms in target segments that are banned from use in the

content.

Note: The blacklisted term list must be a tab-delimited file.




Option

Action

Capitalization Check

Select to identify differences in capitalization, then select the appropriate check
boxes.
e All Caps Mismatch — Select to identify text in the target that is all upper
case, when the source is not all upper case.
e First Word Case Difference Check — Select to verify the first letter of the
first word is capitalized consistently in source and in target.
e Target Capitalization Mismatch Check — Select to identify upper case
text in the target that is in lower case in the source.
e Source Capitalization Mismatch Check — Select to identify upper case
text in the source that is in lower case in the target.
e Skip exact matches — Select to ignore capitalization on exact matches.
e Skip context matches — Select to ignore capitalization on context
matches.

Edited Context Match
Check

Select to identify if there are edits to context matches from the TM.

Edited Exact Match
Check

Select to identify if there are edits to exact matches from the TM.

Edited Source Check

Select to identify if there are edits to the source of a segment.

Empty Target Check

Select to identify segments containing no content in the target column.

Forbidden Character
Check

Select to identify target segments containing forbidden characters, such as the
tilde, asterisk, or ampersand.

1. Click Add, enter the forbidden character or character string in the column
1 field, then click Update.

2. Select whether you want to ignore exact matches or content matches.

Mistranslated Text
Check

Select to identify segments with common translation errors. This generates a
report that lists the correct and wrong usage of translated text.

1. Suppress noise — Select to remove redundancy from the reported
warnings or errors.

2. Skip exact matches — Select to ignore common translation errors on
exact matches.

3. Skip context matches — Select to ignore common translation errors on
context matches.

Note Check

Select to identify and run a report of segments with notes. When you run
Transcheck while in TXLF Editor, every segment that has notes has a related
alert flag

e Skip exact matches — Select to ignore notes on exact matches.

e Skip context matches — Select to ignore notes on context matches.




Option

Action

Number Difference
Check

Select to identify numerals in the source segment that match the target segment.
e Treat numbers separated by hyphens and dashes as single number —
Select to ignore hyphenation and dashes separating numbers.
e Skip exact matches — Select to ignore numerals on exact matches.
e Skip context matches — Select to ignore numerals on context matches.

Paragraph Length
Check

Select to identify target paragraph lengths that exceed the maximum character
length set for the paragraph.

Punctuation Check

Select to identify consistency in typical punctuation, such as commas or periods,
between source and target segments.

1. Click Add, enter the source punctuation mark in the column 1 field, the
target punctuation mark in the column 2 field, then click Update.

2. Select to include dual occurrences of a punctuation mark, ignore exact
matches, or ignore content matches.

Repeated Word Check

Select to identify duplicated words in the translation.

e Skip exact matches—Select to ignore repeated words on exact matches.

e Skip context matches—Select to ignore repeated words on context
matches.

Segment Length Check

Select to verify if the translation complies with preset limits on characters and
words.

e Strict Character Length Check (Zero means unlimited) — Select to
identify violations of minimum and maximum character length.

e Character Expansion Check — Select to identify violations of minimum
and maximum character expansion, as a percentage.

e Word Expansion Check — Select to identify violations of minimum and
maximum word expansion, as a percentage.

e Attribute Character Max Length Check — Select to identify violations of
attribute text that exceeds the maximum character length.

e Skip exact matches — Select to ignore segment length on exact
matches.

e Skip context matches — Select to ignore segment length on context
matches.

Extended Punctuation
Check

Select to identify consistency in less common symbols, such as copyright
symbols, trademarks, and bullets, between source and target segments.

e Skip exact matches — Select to ignore extended punctuation on exact
matches.

e Skip context matches — Select to ignore extended punctuation on
context matches.




Option Action

Copied Source Check Select to identify segments in the target that contains segments copied from the
source.

e Skip exact matches — Select to ignore exact matches of copied source
content.

e Skip context matches — Select to ignore exact matches of copied source
content.

e Skip tokens — Select to ignore software tokens within regular expressions
in the copied source, suchas [-+_/\[\] () #:;. A Z0-9] +

Spelling Check Select to employ spellcheck as you enter the translation.
If the spellcheck language is not available, a message notifies you that
Transcheck will continue, but the spellcheck does not take place.
e Skip exact matches — Select to ignore spellcheck on exact matches.
e Skip context matches — Select to ignore spellcheck on context matches.

Tag Check Select to identify missing tags in the target segments.

e Check for non-formatting tags.

e Check for Source formatting missing in target.

e Check for formatting that exists in target but not in source.

e Skip exact matches — Select to ignore tags with exact matches.

e Skip context matches — Select to ignore tags with context matches.

Terminology Check Select to determine if the terms in the source segment are translated correctly
based on the terms in the terminology list.

e Enforce Term Case — Select to verify the source text matches the exact
case of the term.

e Fuzzy Term Check — Select to include terms that approximately match
the term.

e Skip exact matches — Select to ignore terms with exact matches.
e Skip context matches — Select to ignore terms with context matches.

Unconfirmed Segment  Select to verify if the segment is marked unconfirmed.
Check e Skip exact matches — Select to ignore unconfirmed exact match
segments.

e Skip context matches — Select to ignore unconfirmed context match
segments.

Unedited Exact Check Select to determine if exact matches were not edited.

Unedited Fuzzy Check  Select to determine if fuzzy matches were not edited.

Unedited MT Check Select to determine if machine translated matches were not edited.




Option Action

Untranslatable Text Select to determine if the content that cannot be translated in source and target
Check segments is consistent.

1. Click Add, enter the untranslatable content in the column 1 field, then click
Update.

2. Enter an untranslatable regular expression in the custom field.

3. Skip exact matches — Select to ignore exact matches of untranslatable
regular expressions.

4. Skip context matches — Select to ignore content matches of
untranslatable regular expressions.

Untranslated Text Select to determine if any segments are not translated. Typically, this occurs
Check when you copy the source into the target segment prior to translation, but missed
translating that segment.
e Skip exact matches — Select to ignore untranslated exact match text.

e Skip context matches — Select to ignore untranslated context match text.

Whitespace Check Select to identify mismatched or double white spaces in the target segment.

e Skip exact matches — Select to ignore exact white space matches.

e Skip context matches — Select to ignore white space context matches.

4. Click OK.

Transcheck is reconfigured for the current project.

NEW PROJECT PREFERENCES

Segmentation preferences control how the TXLF editor separates file content into logical segments for a project.
To select segmentation options:
1. Select Preferences from the Wordfast drop-down menu.

2. Click Segmentation under New Project Preferences.



Preferences

SEY

Shortcuts
Warnings

Tags
Auto-Propagation
Auto-Suggestion
Spelichecker

Machine Translation

Current Project Preferences
Replacement
Translation Memory
Terminology
Penalties
Transcheck
Segmentation

Filters

User Preferences

Advanced Settings

W Configure how bilingual files are segmented

Segmentation

Mots

Please note that the current segmentation changes will apply only to the newly created TXLF files, and NOT
to the already created ones.

Segmentation on break

Select segmentation type |-ﬂFF|.IGA'I'IDH -

Define end-of-segment markers (ESM)

Space Tab Mon-Breaking Space Line Feed Carriage Return

Define rules for ending segmenis
] A number followed by an ESM
An ESM without a trailing space should end a segment
An ESM followed by a space and a lower-case letter should end a segment

Select abbraviations that should not be segmented on

Select a language: English (United States) -

Adj. Adm. Adv. Apr. Ar. Asst. Aug. Ave. Bart. Blidg. Blvd. Brig. Bros. Capt. Cmdr. Co. Col. Comdr. Con. Corp.Cpl. .Crit =
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Segmentation Preview

oK Car

3. Select Segmentation on break to enable segmentation on line breaks.

4. Select APPLICATION or SRX from the Segmentation Type drop-down list.

5. Define the end-of-segment marker (ESM) characters.

1. (Optional) Enter specific characters into the ESM field to specify custom segment end characters.

2. (Optional) Select checkboxes for any additional end-of-segment markers.

© © © N o

Click OK.

NEW PROJECT PREFERENCES

Select the rules you want for ending segments.
Select a language from the drop-down list. The default language is US English.
(Optional) Enter abbreviations you want to ban during the segmentation process, separated by commas.

(Optional) Enter and review sample text to test your configuration.

Configure File Format Filters

Filters preferences control the file format filters for importing source content to Wordfast Pro.



To configure file format filters:
1. Select Preferences from the Wordfast drop-down menu.

2. Click Filters under New Project Preferences.

Preferences X
seu e
- «
Shortcuts W Configure how translatabls content is parsed from source files
Warnings
Tags Filters

Auto-Propagation Genfigurstion

Auto-Suggestion Extract numbers:* -

Spelichecker

Machine Translation Available filterz | Default

— Active Server Page (".asp) - Add

New Project Preferences Active Server Page (*.asp) O e

Replacement — Adobe InDesign Interchange (*.inx)

Translation Memory Adobe InDesign Interchange (*.inx) .

Terminology — Flat OPC XML Word Document Format (*.xml)

Penalties Flat OPC XML Word Document Format (*.xml) .

Transcheck — Hypertext Markup Language (*.htm)

Segmentation Hypertext Markup Language {*.htm) -

Filters
Format Settings

User Preferences

Advanced Settings

- -

3. Select afilter configuration from the Extract numbers drop-down list to define the filter action on source
segments that contain only numbers.

all Extracts all segments with only numbers for translation
time_date_measure Extracts only segments with time and date
none Does not extract any segments that contain only numbers

4. To select the file filter settings for the open project, click a filter to list the current settings in the Format
Settings pane.

5. (Optional) Change settings in the Format Settings pane. The options are specific to the file filter you select.

6. (Optional) Add a custom file filter for a filter you need that is not already in the list by clicking Add.



as CN0Ose a file format and enter the filter name to
display.

Choosze file format:* -

Filter Name:*

Format Settings

OK Cancel

7. On the New Filter dialog, click the Choose file format drop-down menu and select a format from the list you
want to use as a template for the new filter.

8. Enter a filter name in the Filter Name field, and then verify your configuration is correct in the Format Settings
pane.

9. Click OK.

User Preferences

You can manage your user preferences, including restoring them to the default state and exporting or importing
them.

USER PREFERENCES
Configure Advanced Settings

Advanced Settings preferences control the means to restore a Wordfast Pro installation to factory or default
settings, migrate preferences between computers, and customize strings.



To configure advanced settings:

1. Click Advanced Settings in the User Preferences group.

Preferences x
Segment - -
®® Restore, export, or import your preference settings
Shortcuts
Warnings

Default Settings
Tags
Restore Original By pressing the Restore Original butten, all of your preferences wil revert to their criginal
Auto-Propagation settings at the time of installation. Please note that once this butten has been pressed, all of
your customized new project and general preferences wil be lost.

Auto-Suggestion

Spellchecker
P By pressing the Restore Defaults button, all of your preferences for the current project will

revert to the default new project preferences. Please note that a project needs to be open
for this button to have any effect.

Restore Defaults
Machine Translation

New Project Preferences

Exportfimport Preferences Settings
Replacement

“fou wil be able to export all the settings values that are currently applied in the Preferences.
Translation Memaory Export P a 1y app
Terminoclogy
Penalties
Import After implementing the settings, they will be applied once you press the OK button in the
Transcheck Preferences dialog.

Segmentation

Filters
Customization String List
User Preferences Disclaimer
For these settings to be applied, restart the application.
Advanced Settings = =

-~

0K Cancel

2. (Optional) Restore the Default Settings by either clicking Restore Original, based on original settings at the
time of installation, or Restore Defaults, based on default preferences.

@ This action removes all the projects, TMs, and glossaries in the Wordfast Pro installation.

3. (Optional) To set export and import preferences, click Export or Import to apply export or import settings
values to user preferences.

¢ On the Export dialog, select all or some of the preferences settings, browse and select a file name and
location, then click Export.

¢ On the Import dialog, browse and select the exported preferences file name and location, select all or
some of the preferences settings, then click Import.

4. (Optional) Click &, type an option in the Customization String List field, then click OK.
5. Click OK.

The configuration is complete.



The application supports accented characters for many language sets: those accents combined with standard
characters and those that are autonomous ligatures.

The key combinations identified here are for use with Windows operating systems and do not pertain
to Mac OS.

Many accents combine with standard characters.

Accent Sample Key Combination Notes
Acute 6orO Ctrl+', v 'is the apostrophe key
Ctrl+', Shift+V v is a lower case vowel
V is an upper case vowel
Circumflex 6 or O Shift+Ctrl+*, v v is a lower case vowel
Shift+Ctrl+, Shift+V V is an upper case vowel
Grave dorO Ctrl+*, v v is a lower case vowel
Ctrl+°, Shift+V V is an upper case vowel
Tilde fi or N Shift+Ctrl+~, ¢ ~ is the tilde key
Shift+Ctrl+~, Shift+C c or C is a character, but only works with upper
and lower case N, O, or A
Umlaut dorO Shift+Ctrl+:, v - is the colon key

Shift+Ctrl+:, Shift+V

v is a lower case vowel
V is an upper case vowel

Other accents require incorporation with the individual characters, so are treated as a complete character.

Complete Name Key Combination Notes
Character
i Inverted exclamation Alt+Shift+Ctrl+! Press and hold all three keys simultaneously
point
¢ Inverted question mark  Alt+Shift+Ctrl+? Press and hold all three keys simultaneously
corC French C cedilla Ctrl+, , c Press Control and the comma key, release both
Ctrl+, , Shift+C keys, then press C or press and hold Shift+C
e orE OE ligature Shift+Ctrl+&, o Press and hold Shift+Ctrl+&, release the keys,
Shift+Ctrl+&, Shift+O and press O or press and hold Shift+O
3 German sharp or Shift+Ctrl+&,s Press and hold Shift+Ctrl+&, release the keys,
double S and press S
gord Nordic O slash Ctrl+/, o Press and hold Ctrl+/, release both keys, and

Ctrl+/, Shift+O

press O or press and hold Shift+O




Complete Name Key Combination Notes

Character

aorA Nordic A-ring, Shift+Ctrl+@, a Press and hold Shift+Ctrl+@, release the keys,
Angstrom sign Shift+Ctrl+@, Shift+A  and press A or press and hold Shift+A

xor k£ Old English AE ligature Shift+Ctrl+&, a
Shift+Ctrl+&, Shift+A

Press and hold Shift+Ctrl+&, release the keys,
and press A or press and hold Shift+A

dorb Icelandic or Old English Ctrl+', d
eth Ctrl+', Shift+D

"is the apostrophe key
Press and hold Ctrl+', release both keys, and
press D or press and hold Shift+D

To insert accents or accented characters:

1. (Optional) To enter a character that combines with an accent, follow the key combinations in the accent table.

e For example, to create an A with an acute ligature, hold down the Control key and press the apostrophe
key. Release both keys and either press A or press and hold Shift+A.

e For example, to create an O with the grave ligature, hold down the Control key and press the
apostrophe key. Release both keys and either press the O or press and hold Shift+0.

2. (Optional) To enter a complete accented character, follow the key combinations in the complete character

table.

e For example, to create the inverted exclamation point, press and hold Alt+Shift+Ctri+!, then release all

keys.

e For example, to create the ce ligature, first press and hold Shift+Ctrl+&, then release the keys and

either press O or press and hold Shift+D.

The Formatting tab in the TXLF Editor includes formatting tools you can use to edit the target content format.

Formatting tools fall into three categories: format, tags, and options.

FORMATTING TOOLS

Format category options are only available for MS Office source file formats.

Button Keyboard Shortcut Description
B Ctrl+B Format the selected text as bold.
Bold

T Ctri+l Format the selected text as italic.

Italic




Button

Keyboard Shortcut

Description

U Ctrl+U Format the selected text as underlined.
Underline
X Ctrl+= Format the selected text as subscript.
Subscript
X Ctrl+Shift+= Format the selected text as superscript.
Superscript
ABE No shortcut Format the selected text to display as strikethrough

Strike

(deleted), without actually deleting the text.

FORMATTING TOOLS

Button Keyboard Shortcut Description
= No shortcut Display actual formatting associated with tags for the
Tag active segment (when supported.)
Formatting
No shortcut Display the content of the formatting tags for the active
Tag segment.

Mon-Foermatting

FORMATTING TOOLS

Button

Keyboard Shortcut

Description

[= ]

Mon-Breaking

Ctrl+Shift+Space

Insert a non-breaking space at the cursor location.

Space
qq No shortcut Insert a marker to indicate left-to-right reading direction.
Left To Right
Marker
qq No shortcut Insert a marker to indicate right-to-left reading direction.
Right To Left
Marker
& Ctrl+D Attach and detach the Formatting toolbar. When

Attach /
Detach

attached, the toolbar is displayed as a tab. When
detached, the toolbar is displayed as a minimized
toolbar that can be moved to any area of the TXLF
Editor.




This topic includes the keyboard shortcuts that are available for PC and Apple users for Wordfast Pro, Wordfast
Classic, SDLX, and Trados.

KEYBOARD SHORTCUTS

A This section only includes shortcuts with a default application-assigned keystroke sequence.

Commands Shortcut View
Add Blacklist Alt+C Project
Add Glossary Alt+O Project
Add Note Alt+Shift+N Editor
Add Project Ctrl+Shift+A Home
Add Project TMs Ctrl+Shift+B Quick Tools
Add Term Ctri+Alt+T Editor
Add TM CtrlI+N Project
Analyze Ctrl+Space Editor
Attach/Detach Toolbar Ctrl+D Editor
Bold Ctrl+B Editor
Clear all tags (Segment) Ctrl+Shift+V Editor
Clear Target Document Alt+Shift+Delete Editor
Clear Target Segment Ctri+Alt+X Editor
Close Ctrl+W Editor
Close project from home window Ctrl+Shift+X Home
Close segment Esc Editor
Commit All Segments to TM Ctrl+Alt+End Editor
Commit Current Segment Alt+End Editor
Confirm/Unconfirm Segment Alt+Enter Editor
Confirm All Segments Ctrl+Shift+Enter Editor
Copy CtrlI+C Blacklist Editor, TM Editor, Glossary Editor, Editor
Copy All Sources Ctrl+Alt+Insert Editor
Copy All Tags (Document) Alt+Shift+P Editor
Copy All Tags (Segment) Alt+A Editor




Commands Shortcut View
Copy selected text to target Alt+F12 Editor
Copy Source Alt+S Editor
Copy Tag Ctrl+Alt+Down Editor
Copy Term Ctrl+0 Editor
Copy TM Ctrl+Shift+C Project
Create Blacklist Alt+B Project
Create Glossary Alt+N Project
Create TM Ctrl+Shift+N Project
Current Segment Leverage Alt+- Editor
Cut Ctrl+X Blacklist Editor, TM Editor, Glossary Editor, Editor
Delete Note Alt+Shift+D Editor
Edit Note Alt+Shift+E Editor
Edit Term Ctrli+E Editor
Export Blacklist Alt+K Project
Export Glossary Alt+E Project
Export Report as PDF format Alt+U Project
Export TM Ctrl+Shift+E Project
Find/Replace Ctrl+F Editor
Get Bilingual Table Ctrl+Alt+P Editor
Go To Segment Ctrl+G Editor
Help Ctrl+Alt+H Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home
Import Blacklist Alt+J Project
Import Glossary Alt+l Project
Import TM Ctrl+Shift+l Project
Insert a cent sign Ctrl+; Editor
Insert Copyright Symbol Ctrl+Alt+C Editor
Insert Ellipsis Ctrl+Alt+. Editor
Insert em dash Alt+Shift+- Editor
Insert en dash F10 Editor
Insert non-breaking hyphen Ctrl+Shift+- Editor
Insert non-breaking space Ctrl+Shift+Space Editor
Insert Registered Trademark Ctrl+Alt+R Editor

symbol




Commands Shortcut View

Italic Ctrl+l Editor

Key Assist Panel Ctrl+Shift+L Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Last Modified Segment Shift+F5 Editor

Leverage Previous TU Alt+Left Editor

Leverage the first TM Lookup Alt+1 Editor

match

Leverage the second TM Alt+2 Editor

Lookup match

Leverage the third TM Lookup  Alt+3 Editor

match

Leverage the fourth TM Lookup  Alt+4 Editor

match

Leverage the fifth TM Lookup Alt+5 Editor

match

Leverage the sixth TM Lookup  Alt+6 Editor

match

Leverage the seventh TM Alt+7 Editor

Lookup match

Leverage the eighth TM Lookup Alt+8 Editor

match

Leverage the Next TU Alt+Right Editor

Machine Translate Ctrl+Shift+M Editor

Merge Segments Alt+Page_Down Editor

Modify Alt+M Project

Modify TM Ctrl+Shift+T Project

Move the cursor between the Shift+Tab Editor

source and the target

Next Segment (Committo TM)  Alt+Down Editor

Next Segment (No Commit) Ctrl+Down Editor

Next Tag Ctri+Alt+Right Editor

Next Term Ctrl+9 Editor

Next View Alt+W Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Open Blacklist Alt+H Project

Open Glossary Alt+G Project




Commands Shortcut View

Open Project Ctrl+Shift+P Home

Open TM Ctrl+Shift+G Project

Paste Ctrl+Vv Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Preferences F9 Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Previous Segment (No Commit) Ctrl+Up Editor

Previous Segment (TM Commit) Alt+Up Editor

Previous Tag Ctri+Alt+Left Editor

Previous Term Ctrl+8 Editor

Pseudo Translate Ctrl+Shift+Y Quick Tools

Quick Tools Alt+Q Home

Redo Ctrl+Y Blacklist Editor, TM Editor, Glossary Editor, Editor

Remove Glossary Alt+R Project

Remove Reference Files Alt+0 Project

Remove Report Alt+Z Project

Remove TM Ctrl+Shift+R Project

Replace/Find Ctrl+H Editor

Run Transcheck Ctrl+Shift+Q Editor

Save Ctrl+S Editor

Save As F12 Editor

Save File As Translated Ctrl+Alt+S Editor

Show White Space Characters  Ctrl+Shift+8 Editor

Simple Project Creator Ctrli+P Home

Source TM Lookup Ctrl+Shift+F Editor

Spell Check F7 Editor

Split Segment Alt+Page_Up Editor

Strikethrough Ctrl+K Editor

Subscript Ctrl+= Editor

Superscript Ctrl+Shift+= Editor

Term Info Alt+T Editor

Terminology Highlight Ctrl+F5 Editor

TM Concordance F8 Editor

Toggle uppercase/lowercase Shift+F3 Editor




Commands Shortcut View

Translate All Ctrl+Shift+End Editor

Translate File Ctrl+O Project

Translate Until Fuzzy Ctrl+Alt+F Editor

Translate Until No Match Ctrl+Shift Editor

+Page_Down

Unconfirm All Segments Alt+Shift+Enter Editor

Underline Ctrl+U Editor

Undo Ctrl+zZ Blacklist Editor, TM Editor, Glossary Editor, Editor
Verify Segment Ctri+Alt+V Editor

A This section only includes shortcuts with a default application-assigned keystroke sequence.

Commands Shortcut View

Add Blacklist Alt+C Project

Add Glossary Alt+O Project

Add Project Ctrl+Shift+A Home

Add Project TMs Ctrl+Shift+B Quick Tools
Add Reference Files Alt+1 Project

Add Term Ctri+Alt+T Editor

Add T™M Ctrl+N Project
Analyze Ctrl+Space Quick Tools
Attach/Detach Toolbar Ctrl+D Editor

Bold Ctrl+B Editor
Clear Target Document Alt+Shift+Delete Editor
Clear Target Segment Ctri+Alt+X Editor
Close project from home window Ctrl+Shift+X Home
Commit All Segments to TM Ctrl+Alt+End Editor
Commit Current Segment Alt+Q Editor
Confirm/Unconfirm Segment Alt+Enter Editor
Confirm All Segments Ctrl+Shift+Enter Editor

Copy CtrI+C Blacklist Editor, TM Editor, Glossary Editor, Editor




Commands Shortcut View

Copy All Sources Ctrl+Alt+Insert Editor

Copy All Tags (Segment) Alt+P Editor

Copy Source Alt+Insert Editor

Copy Tag Alt+Shift+Down Editor

Copy Tag Ctrl+Alt+Down TM Editor

Copy Term Ctrl+Alt+0 Editor

Copy TM Ctrl+Shift+C Project

Create Blacklist Alt+B Project

Create Glossary Alt+N Project

Create TM Ctrl+Shift+N Project

Current Segment Leverage Alt+- Editor

Cut Ctrl+X Blacklist Editor, TM Editor, Glossary Editor, Editor

Export Blacklist Alt+K Project

Export Glossary Alt+E Project

Export Package Ctrl+E Home

Export Report as PDF format Alt+U Project

Export TM Ctrl+Shift+E Project

Find/Replace Ctrl+F Editor

Go To Segment Ctrl+G Editor

Help Ctri+Alt+H Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Import Blacklist Alt+J Project

Import Glossary Alt+l Project

Import TM Ctrl+Shift+l Project

Insert non-breaking space Ctrl+Shift+Space Editor

Italic Ctrl+l Editor

Key Assist Panel Ctrl+Shift+L Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Last Modified Segment Shift+F5 Editor

Leverage Previous TU Alt+Left Editor

Leverage the Next TU Alt+Right Editor

Merge Segments Alt+Page_Down Editor

Modify Alt+M Project

Modify Project Ctrl+Shift+M Home




Commands Shortcut View

Modify TM Ctrl+Shift+T Project

Next Segment (No Commit) Ctrl+Down Editor

Next Tag Ctrl+Alt+Right Editor

Next Term Ctrl+Alt+9 Editor

Next Update Alt+Down Blacklist Editor

Next View Alt+W Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Open Blacklist Alt+H Project

Open Glossary Alt+G Project

Open Project Ctrl+Shift+P Home

Open Reference Files Alt+2 Project

Open TM Ctrl+Shift+G Project

Paste Ctrl+V Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Preferences F9 Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Previous Segment (TM Commit) Alt+Up Editor

Previous Tag Ctri+Alt+Left Editor

Previous Term Ctrl+Alt+8 Editor

Pseudo translate Ctrl+Shift+Y Quick Tools

Redo Ctrl+Y Blacklist Editor, TM Editor, Glossary Editor, Editor

Remove Glossary Alt+R Project

Remove Project CtrI+Alt+R Home

Remove Reference Files Alt+0 Project

Remove Report Alt+Z Project

Remove tag Ctrl+Alt+Up Editor

Remove TM Ctrl+Shift+R Project

Replace/Find Ctrl+H Editor

Save Ctrl+S Editor

Save As F12 Editor

Save File As Translated Ctrl+Alt+S Editor

Show White Space Characters  Ctrl+Shift+8 Editor

Simple Project Creator CtrlI+P Home

Spell Check F7 Editor




Commands Shortcut View
Split Segment Alt+Page_Up Editor
Strikethrough Ctrl+K Editor
Subscript Ctrl+= Editor
Superscript Ctrl+Shift+= Editor
Term Info Alt+T Editor
Terminology Highlight Ctrl+F5 Editor
TM Concordance Ctrl+Shift+F Editor
Translate File CtrI+O Project
Translate Until Fuzzy Ctrl+Alt+F Editor
Translate Until No Match Ctrl+Shift Editor
+Page_Down

Unconfirm All Segments Alt+Shift+Enter Editor
Underline Ctrl+U Editor
Undo Ctrl+Z Blacklist Editor, TM Editor, Glossary Editor, Editor
Verify Segment Ctri+Alt+V Editor

A This section only includes shortcuts with a default application-assigned keystroke sequence.

Commands Shortcut View

Add Blacklist Alt+C Project

Add Glossary Alt+O Project

Add Note Alt+Shift+N Editor

Add Project Ctrl+Shift+A Home

Add Project TMs Ctrl+Shift+B Quick Tools
Add Term Ctri+Alt+T Glossary Editor
Add Term Ctrl+T Editor

Add TM CtrlI+N Project
Analyze Ctrl+Space Editor
Attach/Detach Toolbar Ctrl+D Editor

Bold Ctrl+B Editor
Clear Target Document Alt+Shift+Delete Editor




Commands Shortcut View

Clear Target Segment Ctri+Alt+X Editor

Close Ctrl+Shift+W Editor

Close project from home window Ctrl+W Home

Commit All Segments to TM Alt+End Editor

Commit Current Segment Alt+Q Editor

Confirm/Unconfirm Segment Alt+Enter Editor

Confirm All Segments Ctrl+Shift+Enter Editor

Copy CtrlI+C Blacklist Editor, TM Editor, Glossary Editor, Editor

Copy All Sources Ctrl+Alt+Insert Editor

Copy All Tags (Document) Alt+Shift+P Editor

Copy All Tags (Segment) Alt+P Editor

Copy selected text to target Alt+F12 Editor

Copy Source F4 Editor

Copy Tag Ctrl+Alt+Down Editor

Copy Term Ctrl+Alt+0 Editor

Copy TM Ctrl+Shift+C Project

Create Blacklist Alt+B Project

Create Glossary Alt+N Project

Create TM Ctrl+Shift+N Project

Current Segment Leverage F8 Editor

Cut Ctrl+X Blacklist Editor, TM Editor, Glossary Editor, Editor

Delete Note Alt+Shift+D Editor

Edit Note Alt+Shift+E Editor

Edit Term Ctrl+E Editor

Export Blacklist Alt+K Project

Export Glossary Alt+E Project

Export Report as PDF format Alt+U Project

Export TM Ctrl+Shift+E Project

Find/Replace Ctrl+F Editor

Go To Segment Ctrl+L Editor

Help Ctri+Alt+H Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Import Blacklist Alt+J Project




Commands Shortcut View
Import Glossary Alt+l Project
Import TM Ctrl+Shift+l Project
Insert copyright symbol CtrlI+Alt+C Editor
Insert ellipsis F11 Editor
Insert em dash Ctrl+F10 Editor
Insert en dash F10 Editor
Insert non-breaking hyphen Ctrl+F9 Editor
Insert non-breaking space Ctrl+Shift+Space Editor
Insert Registered Trademark Ctrl+Alt+R Editor
symbol
Italic Ctri+l Editor
Key assist panel Ctrl+Shift+L Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home
Last Modified Segment Shift+F5 Editor
Leverage previous TU Alt+Left Editor
Leverage the first TM Lookup Alt+1 Editor
match
Leverage the second TM Alt+2 Editor
Lookup match
Leverage the third TM Lookup  Alt+3 Editor
match
Leverage the fourth TM Lookup  Alt+4 Editor
match
Leverage the fifth TM Lookup Alt+5 Editor
match
Leverage the 6th TM Lookup Alt+6 Editor
match
Leverage the 7th TM Lookup Alt+7 Editor
match
Leverage the 8th TM Lookup Alt+8 Editor
match
Leverage the Next TU Alt+Right Editor
Machine Translate Ctrl+Shift+F8 Editor
Merge Segments Ctrl+J Editor
Modify Alt+M Project
Modify Project Ctrl+Shift+M Home




Commands Shortcut View

Modify TM Ctrl+Shift+T Project

Move the cursor between the Shift+Tab Editor

source and the target

Next Segment (Committo TM)  Alt+Down Editor

Next Segment (No Commit) Ctrl+Down Editor

Next Tag Ctrl+Alt+Right Editor

Next Term Ctrl+Alt+9 Editor

Next View Alt+W Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Open Blacklist Alt+H Project

Open Glossary Alt+G Project

Open Project Ctrl+Shift+P Home

Open TM Ctrl+Shift+G Project

Paste Ctrl+Vv Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Preferences F9 Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Previous Segment (No Commit) Ctrl+Up Editor

Previous Segment (TM Commit) Alt+Up Editor

Previous Tag Ctrl+Alt+Left Editor

Previous Term Ctrl+Alt+8 Editor

Pseudo Translate Ctrl+Shift+Y Quick Tools

Redo Ctrl+Y Blacklist Editor, TM Editor, Glossary Editor, Editor

Remove Glossary Alt+R Project

Remove Reference Files Alt+0 Project

Remove Report Alt+Z Project

Remove Tag Ctrl+Alt+Up Editor

Remove TM Ctrl+Shift+R Project

Replace/Find Ctrl+H Editor

Run Transcheck F12 Editor

Save Ctrl+S Editor

Save File As Translated Ctrl+Alt+S Editor

Show White Space Characters  Ctrl+Shift+8 Editor

Simple Project Creator Ctrl+P Home




Commands Shortcut View
Source TM Lookup Ctrl+Shift+F Editor
Spell Check F6 Editor
Split Segment Ctrl+Enter Editor
Strikethrough CtrlI+K Editor
Subscript Ctrl+= Editor
Superscript Ctrl+Shift+= Editor
Term Info Alt+T Editor
Terminology Highlight Ctrl+F5 Editor
TM Concordance F7 Editor
Toggle uppercase/lowercase Shift+F3 Editor
Translate All Ctrl+Shift+End Editor
Translate File CtrI+O Project
Translate Until Fuzzy Ctrl+Alt+F Editor
Translate Until No Match Ctrl+Shift Editor
+Page_Down

Unconfirm All Segments Alt+Shift+Enter Editor
Underline Ctrl+U Editor
Undo Ctrl+Z Blacklist Editor, TM Editor, Glossary Editor, Editor
Verify Segment Ctri+Alt+V Editor

A This section only includes shortcuts with a default application-assigned keystroke sequence.

Commands Shortcut View

Add Blacklist Alt+C Project

Add Glossary Alt+O Project

Add Project TMs Ctrl+Shift+B Quick Tools
Add Reference Files Alt+1 Project

Add Term CtrI+Al+T Glossary Editor
Add Term Ctrl+F11 Editor

Add TM Ctrl+N Project
Analyze Ctrl+Space Quick Tools




Commands Shortcut View

Attach/Detach Toolbar Ctrl+D Editor

Bold Ctrl+B Editor

Clear Target Document Alt+Shift+Delete Editor

Clear Target Segment Ctrl+Alt+X Editor

Close Ctrl+W Editor

Close project from home window Ctrl+Shift+X Home

Commit All Segments to TM Ctrl+Shift+U Editor

Commit Current Segment Alt+Q Editor

Confirm/Unconfirm Segment Alt+Enter Editor

Confirm All Segments Ctrl+Shift+Enter Editor

Copy CtrlI+C Blacklist Editor, TM Editor, Glossary Editor, Editor

Copy All Tags (Segment) Alt+P Editor

Copy selected text to target Alt+F12 Editor

Copy Source F4 Editor

Copy Tag Ctrl+F4 Editor

Copy Term Ctrl+Alt+Down Editor

Copy TM Ctrl+Shift+C Project

Create Blacklist Alt+B Project

Create Glossary Alt+N Project

Create TM Ctrl+Shift+N Project

Current Segment Leverage Alt+Space Editor

Cut Ctrl+X Blacklist Editor, TM Editor, Glossary Editor, Editor

Export Blacklist Alt+K Project

Export Glossary Alt+E Project

Export Package Ctrl+E Home

Export Report as PDF format Alt+U Project

Export TM Ctrl+Shift+E Project

Go To Segment Ctrl+L Editor

Help Ctrl+Alt+H Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Import Blacklist Alt+J Project

Import Glossary Alt+l Project

Import TM Ctrl+Shift+ Project




Commands Shortcut View

Insert en dash F10 Editor

Insert non-breaking space Ctrl+Shift+Space Editor

Italic Ctri+ Editor

Key Assist Panel Ctrl+Shift+L Blacklist Editor, TM Editor, Glossary Editor, Quick

Tools, Editor, Project, Home

Last Modified Segment Shift+F5 Editor

Machine Translate Ctrl+Shift+F8 Editor

Merge Segments Ctrl+J Editor

Modify Alt+M Project

Modify Project Ctrl+Shift+M Home

Modify TM Ctrl+Shift+T Project

Move the cursor between the Shift+Tab Editor

source and the target

Next Segment (Committo TM)  Enter Editor

Next Segment (No Commit) Ctrl+Down Editor

Next Tag Ctrl+Alt+Right TM Editor

Next Update Alt+Down Blacklist Editor

Next View Alt+W Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Open Blacklist Alt+H Project

Open Glossary Alt+G Project

Open Project Ctrl+Shift+P Home

Open Reference Files Alt+2 Project

Open TM Ctrl+Shift+G Project

Paste Ctrl+V Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Preferences F9 Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Previous Tag Ctri+Alt+Left Editor

Previous Update Alt+Up Blacklist Editor

Pseudo Translate Ctrl+Shift+Y Quick Tools

Redo Ctrl+Y Blacklist Editor, TM Editor, Glossary Editor, Editor

Remove Glossary Alt+R Project

Remove Project CtrI+Alt+R Home

Remove Reference Files Alt+0 Project




Commands Shortcut View
Remove Report Alt+Z Project
Remove TM Ctrl+Shift+R Project
Save Ctrl+S Editor
Save File As Translated Ctrl+Alt+S Editor
Show White Space Characters  Ctrl+Shift+8 Editor
Simple Project Creator Ctrl+P Home
Source TM Lookup Ctrl+Shift+F Editor
Spell Check F6 Editor
Split Segment Alt+S Editor
Strikethrough Ctrl+K Editor
Subscript Ctrl+= Editor
Superscript Ctrl+Shift+= Editor
Term Info Alt+T Editor
Terminology Highlight Ctrl+F5 Editor
TM Concordance F7 Editor
Translate All Ctrl+Shift+A Editor
Translate File CtrI+O Project
Unconfirm All Segments Alt+Shift+Enter Editor
Underline Ctrl+U Editor
Undo Ctrl+Z Blacklist Editor, TM Editor, Glossary Editor, Editor
Verify Segment Ctri+Alt+V Editor

A This section only includes shortcuts with a default application-assigned keystroke sequence.

Commands Shortcut View

Add Blacklist ~C Project
Add Glossary ~0 Project

Add Note ~oON Editor

Add Project ETA Home

Add Project TMs $0B Quick Tools
Add Term T Editor




Commands Shortcut View
Add T™M #N Project
Analyze ¥$Space Editor
Attach/Detach Toolbar #D Editor
Bold ¥B Editor
Clear all tags (Segment) 8BV Editor
Clear Target Document R Editor
Clear Target Segment AMX Editor
Close W Editor
Close project from home window X Home
Close segment # Editor
Commit All Segments to TM B H Editor
Commit Current Segment ON# Editor
Confirm/Unconfirm Segment oe# Editor
Confirm All Segments EOH# Editor
Copy #C Blacklist Editor, TM Editor, Glossary Editor, Editor
Copy All Sources #¥~\Insert Editor
Copy All Tags (Document) ~OP Editor
Copy All Tags (Segment) A Editor
Copy selected text to target ~F12 Editor
Copy Source oS Editor
Copy Tag N Editor
Copy Term 80 Editor
Copy TM ®1C Project
Create Blacklist ~B Project
Create Glossary ~oN Project
Create TM BN Project
Current Segment Leverage Q Editor
Cut #X Blacklist Editor, TM Editor, Glossary Editor, Editor
Delete Note ~D Editor
Edit Note ~oTE Editor
Edit Term HE Editor
Export Blacklist K Project
Export Glossary ~E Project




Commands Shortcut View

Export Report as PDF format ~uU Project

Export TM H$OE Project

Find/Replace ¥*F Editor

Get Bilingual Table $P Editor

Go To Segment ®G Editor

Help #¥~H Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Import Blacklist ~J Project

Import Glossary ~ Project

Import TM £ Project

Insert a cent sign 8; Editor

Insert copyright symbol $C Editor

Insert ellipsis . Editor

Insert em dash - Editor

Insert en dash - Editor

Insert non-breaking hyphen B- Editor

Insert non-breaking space ¥ Space Editor

Insert Registered Trademark #\R Editor

symbol

Italic £ Editor

Key Assist Panel $oL Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Last Modified Segment TF5 Editor

Leverage Previous TU B Editor

Leverage the first TM Lookup 1 Editor

match

Leverage the second TM 22 Editor

Lookup match

Leverage the third TM Lookup  ~\23 Editor
match
Leverage the fourth TM Lookup ~4 Editor
match
Leverage the fifth TM Lookup o5 Editor
match
Leverage the sixth TM Lookup  ~\6 Editor

match




Commands Shortcut View

Leverage the seventh TM ~7 Editor

Lookup match

Leverage the eighth TM Lookup ~=8 Editor

match

Leverage the Next TU 8- Editor

Machine Translate ¥ITM Editor

Merge Segments ¢ Editor

Modify M Project

Modify TM BT Project

Move the cursor between the 7> Editor

source and the target

Next Segment (Committo TM) ! Editor

Next Segment (No Commit) 8 Editor

Next Tag B~ Editor

Next Term 9 Editor

Next View W Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Open Blacklist ~H Project

Open Glossary G Project

Open Project $oP Home

Open TM ®BG Project

Paste 8V Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Preferences F9 Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Previous Segment (No Commit) 81t Editor

Previous Segment (TM Commit) ~ct Editor

Previous Tag B\ Editor

Previous Term 8 Editor

Pseudo Translate BY Quick Tools

Redo ®Y Blacklist Editor, TM Editor, Glossary Editor, Editor

Remove Glossary ~R Project

Remove Reference Files ~20 Project

Remove Report Z Project

Remove TM #OR Project




Commands Shortcut View
Replace/Find ¥$H Editor
Run Transcheck "Q Editor
Save #8S Editor
Save As F12 Editor
Save File As Translated $\S Editor
Show White Space Characters 18 Editor
Simple Project Creator 8P Home
Source TM Lookup BOF Editor
Spell Check F7 Editor
Split Segment ~¢ Editor
Strikethrough #K Editor
Subscript 8= Editor
Superscript ®o= Editor
Term Info T Editor
Terminology Highlight ¥#F5 Editor
TM Concordance F8 Editor
Toggle uppercase/lowercase TF3 Editor
Translate All HONH Editor
Translate File #0 Project
Translate Until Fuzzy H~F Editor
Translate Until No Match E I Editor
Unconfirm All Segments T e# Editor
Underline U Editor
Undo *Z Blacklist Editor, TM Editor, Glossary Editor, Editor
Verify Segment oV Editor

A This section only includes shortcuts with a default application-assigned keystroke sequence.

Commands Shortcut View
Add Blacklist ~C Project
Add Glossary O Project




Commands Shortcut View

Add Note 0N Editor

Add Project $TA Home

Add Project TMs ®0B Quick Tools
Add Reference Files 1 Project

Add Term T Editor

Add T™M N Project
Analyze ¥$Space Quick Tools
Attach/Detach Toolbar #D Editor

Bold B Editor
Clear Target Document R Editor
Clear Target Segment AX Editor
Close project from home window X Home
Commit All Segments to TM BNH Editor
Confirm/Unconfirm Segment oe# Editor
Confirm All Segments HU<# Editor

Copy #¥C Blacklist Editor, TM Editor, Glossary Editor, Editor
Copy All Sources ~fInsert Editor

Copy All Tags (Segment) ~P Editor

Copy Source ~Insert Editor

Copy Tag N TM Editor
Copy Tag o Editor

Copy Term #$\0 Editor

Copy TM ®1C Project
Create Blacklist ~B Project
Create Glossary ~oN Project
Create TM BN Project
Current Segment Leverage Q Editor

Cut #X Blacklist Editor, TM Editor, Glossary Editor, Editor
Delete Note ~D Editor

Edit Note ~oTE Editor

Edit Term HE Editor
Export Blacklist K Project
Export Glossary ~E Project




Commands Shortcut View

Export Package H$E Home

Export Report as PDF format ~uU Project

Export TM BOE Project

Find/Replace *F Editor

Go To Segment ®G Editor

Help #¥~H Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Import Blacklist ~J Project

Import Glossary ~ Project

Import TM £ Project

Insert non-breaking space ¥ Space Editor

Italic £ Editor

Key Assist Panel #$oL Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Last Modified Segment TF5 Editor

Leverage Previous TU B Editor

Leverage the Next TU H—> Editor

Merge Segments ¥ Editor

Modify M Project

Modify Project ®BTM Home

Modify TM BT Project

Next Segment (No Commit) * Editor

Next Tag - Editor

Next Term 9 Editor

Next Update o Blacklist Editor

Next View W Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Open Blacklist ~H Project

Open Glossary G Project

Open Project ®oP Home

Open Reference Files 2 Project

Open TM ®BG Project

Paste 8V Blacklist Editor, TM Editor, Glossary Editor, Quick

Tools, Editor, Project, Home




Commands Shortcut View

Preferences F9 Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Previous Segment (TM Commit) ~* Editor

Previous Tag F Editor

Previous Term 8 Editor

Pseudo Translate ®UY Quick Tools

Redo 8BY Blacklist Editor, TM Editor, Glossary Editor, Editor

Remove Glossary ~R Project

Remove Project #\R Home

Remove Reference Files 0 Project

Remove Report \Z Project

Remove tag N

Remove TM BOR Project

Replace/Find ¥$H Editor

Save #8S Editor

Save As F12 Editor

Save File As Translated #\S Editor

Show White Space Characters 08 Editor

Simple Project Creator ¥*P Home

Spell Check F7 Editor

Split Segment % Editor

Strikethrough 8K Editor

Subscript 8= Editor

Superscript ®o= Editor

Term Info T Editor

Terminology Highlight BF5 Editor

TM Concordance #OF Editor

Translate File #0 Project

Translate Until Fuzzy F$~F Editor

Translate Until No Match E I Editor

Unconfirm All Segments o e# Editor

Underline U Editor

Undo ¥*Z Blacklist Editor, TM Editor, Glossary Editor, Editor




Commands Shortcut View

Verify Segment oV Editor

A This section only includes shortcuts with a default application-assigned keystroke sequence.

Commands Shortcut View

Add Blacklist ~C Project

Add Glossary O Project

Add Note ~oON Editor

Add Project BTA Home

Add Project TMs $0B Quick Tools
Add Term T Editor

Add Term BT Glossary Editor
Add TM 8N Project
Analyze ¥$Space Editor
Attach/Detach Toolbar #D Editor

Bold ¥#B Editor
Clear Target Document R Editor

Clear Target Segment AMX Editor
Close BOW Editor
Close project from home window W Home
Commit All Segments to TM ONE Editor
Confirm/Unconfirm Segment ~oe# Editor
Confirm All Segments BooH Editor

Copy #C Blacklist Editor, TM Editor, Glossary Editor, Editor
Copy All Sources ¥~\Insert Editor

Copy All Tags (Document) 0P Editor

Copy All Tags (Segment) ~P Editor

Copy selected text to target ~F12 Editor

Copy Source F4 Editor

Copy Tag N Editor

Copy Term 0 Editor




Commands Shortcut View

Copy TM #0C Project

Create Blacklist ~\B Project

Create Glossary ~oN Project

Create TM BTN Project

Current Segment Leverage ~Q Editor

Cut #»X Blacklist Editor, TM Editor, Glossary Editor, Editor

Delete Note ~tD Editor

Edit Note ~TE Editor

Edit Term HE Editor

Export Blacklist ~K Project

Export Glossary ~E Project

Export Report as PDF format ~uU Project

Export TM BOE Project

Find/Replace $F Editor

Go To Segment £ Editor

Help ¥~H Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Import Blacklist ~J Project

Import Glossary ~ Project

Import TM £ Project

Insert copyright symbol $C Editor

Insert ellipsis F11 Editor

Insert em dash - Editor

Insert en dash - Editor

Insert non-breaking hyphen 8F9 Editor

Insert non-breaking space ¥ Space Editor

Insert Registered Trademark #\R Editor

symbol

Italic Eq Editor

Key Assist Panel $oL Blacklist Editor, TM Editor, Glossary Editor, Quick

Tools, Editor, Project, Home

Last Modified Segment tF5 Editor

Leverage Previous TU B Editor




Commands Shortcut View

Leverage the first TM Lookup 1 Editor
match
Leverage the second TM 22 Editor

Lookup match

Leverage the third TM Lookup o3 Editor
match
Leverage the fourth TM Lookup ~4 Editor
match
Leverage the fifth TM Lookup o5 Editor
match
Leverage the sixth TM Lookup 6 Editor
match
Leverage the seventh TM 7 Editor

Lookup match

Leverage the eighth TM Lookup ~8 Editor
match

Leverage the Next TU H- Editor
Machine Translate H$0F8 Editor
Merge Segments ~J Editor
Modify ~M Project
Modify Project ®BTM Home
Modify TM BT Project
Move the cursor between the e Editor

source and the target

Next Segment (Committo TM) ~c! Editor

Next Segment (No Commit) * Editor

Next Tag H - Editor

Next Term 9 Editor

Next View W Blacklist Editor, TM Editor, Glossary Editor, Quick

Tools, Editor, Project, Home

Open Blacklist ~H Project

Open Glossary G Project

Open Project ®BOP Home

Open TM 801G Project

Paste #*V Blacklist Editor, TM Editor, Glossary Editor, Quick

Tools, Editor, Project, Home




Commands Shortcut View
Preferences F9 Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home
Previous Segment (No Commit) 81t Editor
Previous Segment (TM Commit) ~ct Editor
Previous Tag H Editor
Previous Term H\8 Editor
Pseudo Translate ®UY Quick Tools
Redo BY Blacklist Editor, TM Editor, Glossary Editor, Editor
Remove Glossary ~R Project
Remove Reference Files 0 Project
Remove Report \Z Project
Remove tag N Editor
Remove TM BOR Project
Replace/Find ¥$H Editor
Run Transcheck F12 Editor
Save #S Editor
Save File As Translated #\S Editor
Show White Space Characters 08 Editor
Simple Project Creator ¥*P Home
Source TM Lookup ®OF Editor
Spell Check F6 Editor
Split Segment oe# Editor
Strikethrough #K Editor
Subscript 8= Editor
Superscript ®o= Editor
Term Info ~T Editor
Terminology Highlight ¥$F5 Editor
TM Concordance F7 Editor
Toggle uppercase/lowercase OF3 Editor
Translate All BONH Editor
Translate File 80 Project
Translate Until Fuzzy H~F Editor
Translate Until No Match E I Editor




Commands Shortcut View
Unconfirm All Segments RN Editor
Underline U Editor
Undo 8Z Blacklist Editor, TM Editor, Glossary Editor, Editor
Verify Segment F$V Editor

A This section only includes shortcuts with a default application-assigned keystroke sequence.

Commands Shortcut View

Add Blacklist ~C Project

Add Glossary 0 Project

Add Project TMs #0B Quick Tools
Add Reference Files 1 Project

Add Term #F11 Editor

Add Term BT Glossary Editor
Add TM N Project
Analyze ¥Space Quick Tools
Attach/Detach Toolbar #D Editor

Bold ¥B Editor
Clear Target Document N Editor
Clear Target Segment AMX Editor
Close HW Editor
Close project from home window X Home
Commit All Segments to TM ®»oU Editor
Confirm/Unconfirm Segment oe# Editor
Confirm All Segments HO<# Editor

Copy #¥C Blacklist Editor, TM Editor, Glossary Editor, Editor
Copy All Tags (Segment) ~P Editor

Copy selected text to target ~F12 Editor

Copy Source F4 Editor

Copy Tag ¥$F4 Editor

Copy Term N Editor




Commands Shortcut View

Copy TM #0C Project

Create Blacklist ~\B Project

Create Glossary ~oN Project

Create TM BTN Project

Current Segment Leverage ~Q Editor

Cut #»X Blacklist Editor, TM Editor, Glossary Editor, Editor
Export Blacklist oK Project

Export Glossary ~E Project

Export Package BE Home

Export Report as PDF format ~oU Project

Export TM $OE Project

Go To Segment 8L Editor

Help $~\H Blacklist Editor, TM Editor, Glossary Editor, Quick

Tools, Editor, Project, Home

Import Blacklist ~J Project

Import Glossary ~ Project

Import TM F#0l Project

Insert en dash - Editor

Insert non-breaking space ¥ ¢ Space Editor

Italic | Editor

Key Assist Panel BOL Blacklist Editor, TM Editor, Glossary Editor, Quick

Tools, Editor, Project, Home

Last Modified Segment ©F5 Editor

Machine Translate ¥0F8 Editor

Merge Segments 8J Editor

Modify ~M Project

Modify Project HTM Home

Modify TM BT Project

Move the cursor between the T Editor

source and the target

Next Segment (Committo TM)  «# Editor
Next Segment (No Commit) 8 Editor
Next Tag E: N TM Editor

Next Update ~o! Blacklist Editor




Commands Shortcut View

Next View W Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Open Blacklist ~H Project

Open Glossary G Project

Open Project $oP Home

Open Reference Files 22 Project

Open TM ®BG Project

Paste 4V Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Preferences F9 Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Previous Tag E AN Editor

Previous Update ot Blacklist Editor

Pseudo Translate ®UY Quick Tools

Redo BY Blacklist Editor, TM Editor, Glossary Editor, Editor

Remove Glossary ~R Project

Remove Project #\R Home

Remove Reference Files ~20 Project

Remove Report Z Project

Remove TM #OR Project

Save ¥#S Editor

Save File As Translated S Editor

Show White Space Characters 108 Editor

Simple Project Creator ®P Home

Source TM Lookup ®OF Editor

Spell Check F6 Editor

Split Segment oS Editor

Strikethrough 8K Editor

Subscript 8= Editor

Superscript ®O= Editor

Term Info T Editor

Terminology Highlight 8F5 Editor

TM Concordance F7 Editor

Translate All HTA Editor




Commands Shortcut View

Translate File #0 Project

Unconfirm All Segments RN Editor

Underline U Editor

Undo ®Z Blacklist Editor, TM Editor, Glossary Editor, Editor
Verify Segment vV Editor

How do | obtain a Wordfast Pro License and install the application?

When you purchase a Wordfast license, you will receive an installer and a license certificate that
contains login credentials for our website. When you install Wordfast Pro for the first time, it runs in
Demo mode.

When you login to our website using the credentials on your license certificate, enter the provided
activation key in Help > License Management. This will change the Demo mode to a full version.
Refer to Licensure.

What does Wordfast Pro Demo mode mean?

When in Demo mode, you are limited to creating bilingual projects and storing up to 500 translation
units in your Translation Memory. To get a full version, you must upload a license. Refer to
Licensure.

What happens if | upload a corrupt file for translation when creating a project?

If one of the files is corrupt or invalid, you can still create a project with clean files. The corrupt or
invalid file will not upload and you receive a warning message.

How do | chain individual files?

Instead of opening files one-by-one to display in individual tabs, you can chain files to open in a
single tab as long as these files are in the same batch. You cannot chain files across batches.
Chaining files has the following main advantages:

e Open hundreds of files within seconds.

e Filter or search and replace in one pass as opposed to once per individual file.
Refer to Chain Files.

Why is the Analyze button inactive when | open a chained file for translation?

The Analyze action you can normally access in TXLF Editor view is inactive when you open a
chained file because the translation memory cannot provide the best results.

What are the different ways to analyze files?




The analysis process converts source files into TXLF, leverages the content against existing
translation memories, and generates a report listing matches, non-matches, word count, character
count, and segment count. You can analyze source files in the following ways:

e Analyze files within a project on the Project Files tab.

e Analyze any files outside of the project files on the Quick Tools tab.

¢ Analyze a file open for translation in TXLF Editor view by clicking the Analyze action on the

Translation tab.

Refer to Analysis

How do | use Skip 100% and 100%+ Segments when using TXLF Editor view?

To skip 100% and 100%+ segments when moving to a segment that requires linguistic changes, you
have two options:
o (Preferred) Set preferences to Skip 100% and 100%+ segments. This allows you to view the
100% and 100%+ segments for context while editing adjacent No Match and Fuzzy match or
MT pre-translations.
e Filter for All except 100% and Context match segments.

How do | share my translation or commit my translation to a TM in real time?

To share your translation as soon as you finish translating or editing a segment, you must commit it
to the TM. Committing a segment will turn the color highlight from pink to purple. You can commit a
segment to the TM as follows:

Move to the next segment using ALT + ‘L

e Click Translation > Commit.

¢ Press Alt+Q.
If a segment does not require any changes, for example, if the 99% match or the MT match is
linguistically correct, you can verify the segment. Verifying the segment will also commit it and turn
the color highlight to purple. You can verify a segment as follows:

Click the @ next to the segment.

¢ Click Translation > Verify.

e Press Ctrl+Alt+V.
Once the segment is committed to the TM, it becomes a private translation unit (TU) with a penalty
of 1%. As a 99% match, the segment follows 100% matches in the list. Your preliminary translations
go through additional steps such as editing and proofing. Private TUs change to public TUs once you
complete the final linguistic step in the translation workflow. You can automatically leverage a public
TU during analysis at 100% or 100%+.

How do | keep translations from updating the master TM?




To prevent a segment from updating the TM:

1. Open the file for translation and click on the segment that you do not want to write to the TM.

2. On the Translation tab, click Unconfirm/Confirm. The Status column displays %, and does
not update the TM.

3. To write the segment to the TM, select the segment and click Unconfirm/Confirm again. The
% is removed from the Status column, and the segment may then be updated to the TM.

4. On the Translation tab, click Unconfirm / Confirm All to unconfirm or confirm all segments in
the file.

How do | correctly apply inline formatting?

You can apply inline formatting to the target segment in two ways:

1. You can enter tag(s) from the source language segment for basic styles such as bold and italic
using the buttons on the Formatting tab. However, these formatting buttons could introduce
tags in the target that do not match the source. Unless the linguist identifies these mismatched
tags using Transcheck and corrects them, they will prevent affected TXLF files from converting
into monolingual files at the align stage.

2. To avoid the mismatched tags, after opening a file for translation, go to Preferences > Tags
and select Show Formatting as Tags.

Since this preference persists from one WFP session to another, you only have to set it once.
This preference enables you to reuse tags from the source using the Copy button under the
Translation tab. If the tag preference is set to Show Text Formatting (when supported), you
must apply formatting using the buttons in the Formatting tab, unless you toggled segment-
by-segment from Tag Formatting to Tag Non-Formatting.

Why is the Whole Words Only check box inactive in Find/Replace dialog?

In the Find and Replace dialog, the Whole Words Only check box is inactive if you added multiple
words or punctuation to the Find field.

What are Preferences and how do | access them?

You can customize all user interface options and features using General, Current Project, and User
Preferences groups.
To access preferences, choose one of the following:
e Use the Wordfast Pro tab drop-down menu.
e Use the Projects tab.
e Use the Project Files tab.
e Use the Quick Tools.
e Use the TXLF Editor view.
Refer to Configure Preferences.

How can | preview a file during translation?

In TXLF Editor, on the File tab, click Preview, then select Live Preview or Office Preview from
the drop-down menu. This opens a document with the target content for comparison to your source
content.
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